T
CISCO.

L]

z

£

g
e
=
g

™ .
i
B

Installation and Configuration Guide for
Cisco Unified Contact Center Management
Portal, Release 15.0(1)

For Unified Contact Center Enterprise

Last Updated: February, 2026
First Published: April, 2025

Americas Headquarters
Cisco Systems, Inc.
170 West Tasman Drive
San Jose, CA 95134-1706
USA
http://www.cisco.com
Tel: 408 526-4000

800 553-NETS (6387)
Fax: 408 527-0883


http://www.cisco.com

THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT NOTICE. ALL
STATEMENTS, INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT ARE PRESENTED WITHOUT
WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. USERS MUST TAKE FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS.

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION PACKET THAT
SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSE
OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A COPY.

The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of UCB's public
domain version of the UNIX operating system. All rights reserved. Copyright © 1981, Regents of the University of California.

NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF THESE SUPPLIERS ARE PROVIDED “AS IS" WITH
ALL FAULTS. CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT
LIMITATION, THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OR ARISING FROM A COURSE OF
DEALING, USAGE, OR TRADE PRACTICE.

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING,
WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS MANUAL, EVEN IF CISCO
OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual addresses and phone numbers. Any examples, command display
output, network topology diagrams, and other figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses or phone numbers in
illustrative content is unintentional and coincidental.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of Cisco trademarks, go to
https://www.cisco.com/go/trademarks. Third-party trademarks mentioned are the property of their respective owners. The use of the word partner does not imply a partnership
relationship between Cisco and any other company. (1110R)

Installation and Configuration Guide for Cisco Unified Contact Center Management Portal: For Unified Contact Center Enterprise. March 23, 2026

© 2012-2026 Cisco Systems, Inc. All rights reserved.



Contents

Preface ...
About This Guide . . . . ... e 13

Change HiStory . . .. ... o 13

Product Naming Conventions. . ... ....ouutntn ettt et 13

Related Documentation. . . .. ... ottt 14
Communications, Services, and Additional Information . ........................ 15

CiscoBug Search Tool . ... ... . 15

Field Alerts and Field NOtices . ........ ...t 15
Documentation Feedback .. ........ ... .. 16

Document CONVENtIONS. . . .. .. vut ittt et et e e ettt e 16
Chapter 1: Planning Your Installation................ooncrensescsessesessesssscsesssesessssessessssesssssssenss
About the Installation . ... ... ... e 18

Deployment Specifics. ... ..o v ot e 18

Infrastructure SOftware . . .. . ... .. i 18

Unified CCMP Components. . . ...ttt 18

Deployment Model . . .. ... e 19

Supporting 48K Deployment .. ........... . 20

Upgrading CCMP Hardware Specifications to Support 48K Deployment. . . ...... 20
Chapter 2: Installation ReqUuirements ...
About the Installation Prerequisites . ............... ... 23

General Requirements. . .. ... ot e 23

CCMP Windows Requirements . . ... ......c.c.uuiininiunine e 23

Additional Software Requirements. . .. ............ it 23

Database SeIVers. .. .. ...ttt 24

APPLCAtION SEIVEIS. .« vttt e 24

Java Runtime Environment Support. . ... 24

Contents

3



User Desktop Requirements . . . ... ..ottt 24

Architecture Diagram .. ... ... 25
Firewall Configurations . ... .. .......o.iuin it 27
About Firewall Configuration. .. ......... .. .. ... . . .. 27
Web Server Port Usage . . ... ..ottt 27
Unified CCMP Database Server Port Usage. . .......... .. ..., 28
Cisco Unified CCEPort Usage. ... ...t 29
Domain Controllers for Unified CCE Instances Port Usage.................... 29
Cisco Unified Communications Manager Port Usage ........................ 29
Cisco Unified CVP Port Usage. . ... i 30
Security Considerations . . .. ... .. ...ttt ettt 30
Mandatory Security Configuration . ........... .. .. ... .. . ... 30
Optional Security Configuration. ... .......... ..ottt 30
Browser Security Using HSTS . ... ... 31
Chapter 3: Pre-Installation Tasks...........coounmnmnninnsssssssss s
Configuring WIndows. . .. ... vttt e e e 33
Configuring Firewalls . . .. ... 33
Configuring Settings on All Unified CCMP Servers ......................... 33
Initialize and Format Secondary Disk on Database Server. . ................... 33
Configuring User ACCOUNLS .. ...ttt e 34
Configuring Unified CCMP Service Accounts. . .............c..oviiininon.. 34
Configuring Application ACCOUNES . . .. ..ot vttt e e e 34
Configuring SQL Agent USers . .........ouuuiieninn e, 34
Installing and Configuring SQL Server ........... . .. 35
Installing SQL Server on Dedicated Database Server ........................ 35
Installing SQL Server Management Studio (SSMS) Release 18.x............... 36
Configuring SQL Server Network Protocols ............... ... ... vi... 36
Configuring Windows Firewall for SQL Server. .. ......... ... ... ... ... ... 36
SQL Server Backup Guidelines . ............. ... 37
Configuring Optional Security Settings . ... .. ...ttt 37
Disabling Anonymous SESSIONS . . ..« v vttt et e 37
Disabling Cached Logins . .. ...t 38
Disabling DCOM . . .. ... e e 38
Enabling Mandatory SMB Signing for all Unified CCMP Servers .............. 38
Disabling SSL V2 .. . 39

4 Installation and Configuration Guide for Cisco Unified Contact Center Management Portal



Disabling Remote Access to Unified CCMP Servers......................... 39

Disabling HTTP/2 . . . . ..o e 39
Chapter 4: Installation ProcCess...........cconnnninninsnsssssssssss s ssssssssssssssenss Y|
Before you Start . .. ... 42
Installing Dual-Sided Systems . . ...... ...ttt 42
Recording Your Settings. . . ... ot 42
About the Unified CCMP Installer. .............. i 43
Verifying Signature File for ISO. ... ... ... .. . 43
Starting the Installer .. ......... .. . e 43
Installation PrerequiSites . . .. ... ..ottt e 44
Installing the Database COMPONENts. . . ... ..ottt ettt 44
Installing the Portal Database . ... ......... ... .. .. . 45
Installing the Application and Web Server. ......... ... .. . . .. 48
Installing the Identity Server. .. ... ... ... i 49
Load Balancing the Identity Server. .. ......... ... . ... 50
Installing the Second Side (Replicated Systems Only). ... ....................... 51
Chapter 5: Unified CCMP Configuration..............coererennercsensssessessssesessssessesessesessssessessssense 52

About Unified CCMP Configuration . ........... .. ... . . .. ... 53
Configuring the Unified CCMP Cluster. .. ......... . ... 53
About Cluster Configuration. .. ....... ...ttt 53
Starting ICE Cluster Configuration. ... ...t enaen.. 53
Configuring Unified CCMP Servers. .. ..., 54
About the Setup Unified CCMP Servers Wizard ........................ 54
Setting Up the Unified CCMP Servers .. .........cooiiiiiiinena .. 54
Resetting System Administrator Password . .......... ... ... ... ... ... .. 56
Configure Cisco Unified CCE Servers . .. ...ttt ennen.. 56
About the Configure Cisco Unified CCE Servers Wizard ................. 56

About Unified CCE Deployment Models . ............................. 56

About Unified CCMP Connection Requirements. ... .................... 56
Configuring Cisco Unified CCE Servers ............. ... ... ..c...... 56
Configuring Cisco Unified Communications Manager Servers . .. .............. 60
Configure Cisco Unified CVP Servers . .. ...t .. 61
About the Configure Cisco Unified CVP Servers Wizard ................. 61
Configuring Cisco Unified CVP Servers .......... ... ... ... ... ... . ... 61
Creating and Mapping Tenants. . .. ......... ..., 63

Contents 5



6

About Creating and Mapping Tenants ................. ... oo, 63

Creating Tenants . . ... ... . it e 63
Creating Folders . ... i e 63
Creating an Equipment Mapping. . .. ..., 64
Configuring Active Directory Federation Services (ADFS). .......... ... ... .. ... 65
About ADES ... 65
Configuring ADFS Per Identity Server. .. ........ ... i, 66
Adding the Unified CCMP Identity Server to ADFS . .................... 66
Configure ADFS with PowerShell scripts. . ............................ 66
Editing Claim Rules for Unified CCMP . .......... ... ... .. .. .. .. .... 67
Configuring ADFS asaOne-Time Setup . .. ....... ... ... ... .. ... ...... 67
Configuring ADES . ... o 68
Mapping Tenants to ADFS . ... ... . . 68
Configuring Windows Login . ...... ... . . 69
About Windows Login . ... 69
Setting Up Administrator ACCOUNE . . .. ...ttt ittt i 69
Configuring Windows Authentication . ........... ... ... .. .. .. . .. ...... 69
Managing Users with Windows . ............ .. . ... 71
Configuring EntraID Login . . .. ... ... . 71
About EntraID Login . . ... ..ot 71
Register the Application in Entra ID (Azure Portal). . ........... ... ... .. .... 71
Configuring Entra ID Authentication . . ........... ... ... ... .. ... ...... 72
Configure Entra ID on Tenant Folder. . ........... ... .. ... ... ... .. ... ... 73
Configuring Unified CCE Admin Workstations. . . .......... .. ... .. .. .. .. ..... 73
Configuring Unified CCE Provisioning . . .. ..o, 74
About Provisioning Configuration .. .............couitiiiniinnnnenan.. 74
Setting Up ConAPL . .. ... . e 74
Setting Up the CMS Server. .. ... ..o e 75
Checking CMS Server Set Up. ... ...t 75
Adding New Application Connection. . ...........co.vuintneneenenenn.. 75
Configuring Replication . . .. ... . 76
About Replication . . ....... ...t e 76
About the Replication Manager. . . ........... ... ... .. i 76

About the Snapshot Process ........... .. ... i 76

About Replication Publications. . .......... ... .. i 77
Configuring Replication . . ... ... . . 77
Replication and Security Requirements .. ............. . .. ..., 78
Monitoring the Replication Snapshot .. ....... ... ... ... .. . . . ... 79

Installation and Configuration Guide for Cisco Unified Contact Center Management Portal



Chapter 6: Post-Installation Process ... 81

Configuring SSL . . ... e 82
Obtaining a Digital Certificate .. ......... .. it 82
Exporting the Certificate in PFEX Format . ......... ... .. ... .. ... ... ... 83
Configuring SSL for the Web Application . .. .......... ... .. ... ... 84

Binding Server Ports to IPv6 Addresses. . ........ .. ... . . i 84

Configuring Antivirus OptionsS . . .. ...ttt e 85

Performance Tuning Checklists ... ....... ... . 85
Application/Web SEervers . ... .. ...ttt 85
Database Servers. . .. ... ... 86

Final Post-Installation ACHONS . .. .....o.ttn ittt 87
Installing Microsoft KB Patches. .. ...... .. ... .. .. . .. ... ... .. ... 87
Enabling Registry Auditing. . ... ... ... 87
Restarting the System . .. ... ... 87
Logginginto Unified CCMP .. ... ... .. .. . . . . . . .. 88
Verifying the Installation . ........... .. .. i 88
Configuring Distributed Transaction Coordinator (DTC) ..................... 88

Checking Database Credentials ... ........... ... .. 89

Chapter 7: Update JAVA to Latest VerSion ...........coocnercnenssesessssessessssesssssssessssessesssssssesseses 91

Updating Java to the Latest Versionfor CCMP 15 .......... .. .. ... .. .. .. ... 92
Pre-RequisSites . . . ..ottt e 92
Deployment Steps . . .« .o vt 92
ROIIbaCK StepS. . oo oottt 92

Chapter 8: Upgrade ProCess..........oieninisisessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssses 94

About the Upgrade Procedure. . ......... .. i 95

Upgrade OPtioNS . . .« . oottt e e e e e e e e e 95
More About Upgrading Dual-Sided Systems . .. .......... ... ... 95

Acquiring and Preparing New Windows 2022 Servers ..................couen... 96
Configuring New Windows Servers ... ..., 96
Creating USer ACCOUNLS . . . v vttt ettt ettt e et et e 97
Configuring Optional Security Settings .. ........ ..., 97
Installing and Configuring SQL Server .......... .. ... . ... 97

Upgrading Windows Server 2019 to Windows Server 2022 for Existing Deployments . 97

Contents 7



Upgrading SQL Server 2019 to SQL Server 2022 for Existing Deployment. . . ....... 98

Chapter 9: Total Qutage Upgrades ..........c.cocvecverencmmsessssesessssessssssessssssesssssssssssssssssssssssssssssssssans
About Total Outage Upgrades . .......... ... 100
Checklist for Total Outage Upgrades for Single-Sided and Dual-Sided Systems . . . . . 100

For Upgrades on New Servers .. ......... .. i, 100
For In-Place Upgrades. . .. ... o i 101
Preparing to Upgrade . ... ... . . 103
Updating Folder Names in Resource Manager. ............................ 103
Stopping the Unified CCMP Services. . .. ..., 103
Removing Database Replication. . ......... .. .. ... .. ... ... . .. ... 103
Pre-Upgrade Tasks Specific to New Server Upgrades . . ..................... 104
Acquiring and Preparing New Windows 2022 Servers. ... ............... 104
Backing up the Portal Database. . ........... .. ... .. . . . 104
Backing up the Identity Database ... ........... ... .. .. . ... 104
Restoring the Portal and Identity Databases .. ......................... 105
Configuring the SQL Agent User . ..., 105
Adding Network Service ACCOUNtS. . .. ..ottt 106
Pre-Upgrade Tasks specific to In-place Upgrades . ......................... 106
Virtual Machine Snapshot for CCMP servers: ......................... 106
Uninstalling CCMP components. . ............. ... iiiiiininaon... 107
Upgrade Operating System to Windows 2022 and SQL server to 2022. . . . .. 107
Upgrading and Configuring Unified CCMP Components . .. .................... 107
Installing the Database Components. . .........c.c.vunininiuninenennenen.. 107
Upgrading the Portal Database . .. ......... .. 109
Installing Database Components and Upgrading Portal Database (Side B) . . ... .. 109
Installing the Application/Web Server ......... ... .. .. . .. . . ... 110
Installing the Identity Server. .. .. ... ..ottt 110
Reconfiguring the Unified CCMP Servers . . ........... ... .. 110
Reconfiguring the Unified CCE Servers. ... ........ .. ..., 111
Reconfigure Unified CCE to Use the New Servers ......................... 113
Restoring Replication . .. ... ... e 113
Configuring Replication .. ....... ... it 114
Monitoring the Replication Snapshot . . .......... ... .. .. ... .. .. .. ... 115
Post-Upgrade Tasks . . ... ..ot e e 116
Restarting the Unified CCMP Services. . . ...t 116
Validating the Upgrade . . . ... ..o e 117

8 Installation and Configuration Guide for Cisco Unified Contact Center Management Portal



Chapter 10: Split-Side Upgrades ... sssssssses 119

About a Split-Sided Upgrade . . ... ... 120
Checklist for Split-Sided Upgrades (Side A) ........ .. .. .. . . ... 120
For Upgrades on New Servers . ....... ... 121
For In-Place Upgrades. . .. ... i 121
Preparing to Upgrade . . ... ... 122
Updating Folder Names in Resource Manager. ............. .. ... ... ..... 122
Stopping the Unified CCMP Services (For Side AandB).................... 122
Removing Database Replication. .. ........... ... .. i, 123
Updating Side B to Enable Provisioning and Importing. . . ................... 123
Starting the Unified CCMP Services (Side B) ......... ... ... ... ... .. ... 123
Pre-Upgrade Tasks Specific to New Server Upgrades . . ..................... 124
Acquiring and Preparing New Windows 2022 Servers. . ................. 124
Backing up the Portal Database (Side A) ........ ... .. .. . oL, 124
Backing up the Identity Database (Side A)........... ... .. .. ... .. ..... 124
Restoring the Portal and Identity Databases (Side A).................... 125
Configuring the SQL Agent User (Side A). ... .. 125
Adding Network Service Accounts (Side A) .......... ... .. .. ....... 126
Pre-Upgrade Tasks specific to In-place Upgrades . ........... .. ... .. ... .... 127
Virtual Machine Snapshot for CCMP servers (side A). .................. 127
Uninstalling CCMP components. .. ...........ouiiintininnenennan.. 127
Upgrade Operating System to Windows 2022 and SQL server to 2022. . . . .. 127
Upgrading and Configuring Unified CCMP Components (Side A). ............... 128
Installing the Database Components. . .........c.c.uuuinininnnenennenen . 128
Upgrading the Portal Database . .. ......... .. 128
Installing the Application/Web Server .. ........ ... ... ... ... 129
Installing the Identity Server. ... .. ... ... 129
Tasks specific to In-Place Upgrades . .. ....... ... .. 129
Reconfigure the Unified CCMP serverson Side A...................... 129
Reconfigure the Unified CCE Serverson Side A .. ..................... 129
Configure SSLon Side A . ... .. ... .. i 129
Restart the Servicesof Side A. ... .. .. .. .. i 129
Login to Unified CCMPon Side A . ... ... .. ..., 130
Validate the upgrade (Side A). .. ..o v i 130
Checklist for Split Side Upgrades (Side B) . ...... ... .. .. . ... o ... 130
For Upgrades on New Servers . ....... ...ttt 130
For In-Place Upgrades. . .. ... . i e 131
Preparing to Upgrade (Side B) . .. ... ..o 132

Contents 9



Pre-Upgrade Tasks Specific to New Server Upgrades . . ..................... 132

Backing up the Upgraded Side A Portal Database .. .................... 132
Backing up the Upgraded Side A Identity Database..................... 132
Restoring the Upgraded Side A Portal and Identity Databases (Side B) . . . .. 133
Configuring the SQL Agent User (Side B) . .. ......... ... .. .. .. ... .. 133
Adding Network Service Accounts (SideB)............. ... ... .. ... ... 133
Pre-Upgrade Tasks specific to In-place Upgrades . ................ ... ..... 134
Switch application users to Side A before starting Side B upgrade .. ....... 134
Backing up the Upgraded Side A Portal Database ...................... 134
Backing up the Upgraded Side A Identity Database..................... 134
Stopping the Unified CCMP Services. .. ..........cooiiiiinen. .. 134
Virtual Machine Snapshot for CCMP servers. ......................... 134
Uninstalling CCMP componentsof Side B. . .. ........................ 135
Upgrade Operating System to Windows 2022 and SQL server to 2022. . . . .. 135
Restoring the Upgraded Side A Portal and Identity Databases (Side B) . . . .. 135
Upgrading and Configuring Unified CCMP Components (Side B)................ 136
Installing the Database Components (Side B). . ......... ... .. ... .. ... ... 136
Installing the Application/Web Server (Side B) .. ......... .. ... . .. ... ... 136
Installing the Identity Server (Side B). .. ....... ... ... ... .. . . .. .. ... 136
Reconfiguring the Unified CCMP Servers .. ...............oo .. 136
Reconfiguring the Unified CCE Servers. ... ........ .. ... .. 138
Reconfigure Unified CCE to Use the New Servers ......................... 139
Stopping the Unified CCMP Services (For Side AandB).................... 140
Restoring Replication . .. ... ... . 140
Configuring Replication . . .......... . 140
Monitoring the Replication Snapshot . . ........ .. ... .. .. . . . . 141
Post-Upgrade Tasks .. ... ... 142
Restarting the Unified CCMP Services. . ... ..ot 143
Validating the Upgrade (Side Aand Side B) ........ ... ... ... ... ... ... 143
Stopping the Unified CCMP Services. . .. ...... ..ottt 144
Chapter 11: Update SAL SErver Port ... ssessssessesssssssesssssssesssssssessaseases 145

Introduction. . . ... .. .. 146
Updating SQL Server Port Using Connection Updater ......................... 146
PrerequiSites . ... ..ot e 146
Updating the Port in Connection Updater. .. ......... .. ... ... ... oou... 146
Updating SQL Server Port for CCMP Database. . .. ............ .. ..o, 147

10 Installation and Configuration Guide for Cisco Unified Contact Center Management Portal



Chapter 12: Uninstalling Unified CCMP ... sessssssssanes 148

Removing Database Replication. .. ........ ... .. i, 149
Uninstalling Identity Component . . ............. ... it iiiinennen .. 150
Uninstalling Application Server Component . . .. ..........c.ouvineneneenen .. 150
Uninstalling the Database Component . . ............... .o itiininennenen .. 150
Uninstalling the Common Component . . .................iuiiiiinennen... 151
Removing the Database Catalog. . .......... ... .. .. 151
Chapter 13: Troubleshooting Tasks............ccovnnnnnnnnn 153

About Installer Logs . . . .. ..o e 154
Changing the SQL Server Installation Language to US English .................. 154
Portal Login Error Messages. . . .. ..ottt e 155
Symptom: Error Message Appears Upon Logging into Portal Webpage . .. ... ... 155
CaUSE . . . 155
Recommended Actions .. ....... ...t 155
Replication Troubleshooting. . . .......... ... i 156
Symptom: Snapshot Fails During CCMP 15 Database Replication Setup. .. ..... 156
Recommended Actions . ......... ..ot 156

Contents 11



Preface

» About This Guide

» Change History

» Product Naming Conventions

» Related Documentation

» Communications, Services, and Additional Information
» Field Alerts and Field Notices

» Documentation Feedback

» Document Conventions



About This Guide

Installation and Configuration Guide for Cisco Unified Contact Center Management Portal explains the

installation and configuration process of Unified Contact Center Management Portal (Unified CCMP). Read
this document carefully before proceeding and ensure that it is available to anyone installing, configuring or
managing Unified Contact Center Management Portal.

Who Should Read This Document

This document should be read by anyone who needs to install, configure or manage Unified CCMP. It is
intended for network administrators who are familiar with contact center operations and management,
network services and routing operations and administration. An understanding of SQL Server database

administration is also helpful.

Change History

This table lists changes made to this guide. Most recent changes appear at the top.

Change See Date

Added two new chapters “Update SQL Server Port” on February 2026
page 145 & “Update JAVA to
Latest Version” on page 91

Added a note about tenant cre- “About Creating and Mapping February 2026

ation

Added new sections for replica-
tion security requirements and
troubleshooting.

Tenants” on page 63

“Replication and Security
Requirements” on page 78 &
“Replication Troubleshooting” on
page 156

November, 2025

Added a new section on config-
uring Entra ID login

“Configuring Entra ID Login” on
page 71

August, 2025

Updated description for “Default
Import Location”

“Creating an Equipment Map-
ping” on page 64

June, 2025

Product Naming Conventions

In this release, the product names defined in the table below have changed. The New Name (long version) is
reserved for the first instance of that product name and in all headings. The New Name (short version) is
used for subsequent instances of the product name.
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Note: This document uses the naming conventions provided in each GUI, which means that in some cases

the old product name is in use.

0ld Product Name

New Name (long version)

New Name (short version)

Cisco IPCC Enterprise Edition Cisco Unified Contact Center Unified CCE
Enterprise

Cisco IPCC Hosted Edition Cisco Unified Contact Center Unified CCH
Hosted

Cisco Intelligent Contact Cisco Unified Intelligent Contact | Unified ICM

Management (ICM) Enterprise Management (ICM) Enterprise

Edition

Cisco Intelligent Contact Cisco Unified Intelligent Contact

Management (ICM) Hosted Management (ICM) Hosted

Edition

Cisco CallManager/Cisco Unified | Cisco Unified Communications Unified CM

CallManager

Manager

Related Documentation

Documentation for Cisco Unified ICM/Contact Center Enterprise & Hosted, as well as related
documentation, is accessible from Cisco.com at: https://www.cisco.com/c/en/us/support/customer-
collaboration/unified-contact-center-management-portal/series.html#~tab-models

Related documentation includes the documentation sets for:

» Cisco Unified Contact Center Domain Manager

» Cisco Unified Customer Voice Portal (CVP)

» Cisco Unified IP IVR, Cisco Unified Intelligence Center

» Cisco Support Tools

Documentation for these Cisco Unified Contact Center products is accessible from:

»  https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-management-
portal/series.html#~tab-models.

Documentation for Cisco Unified Communications Manager is accessible from:

»  https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-management-
portal/series.html#~tab-models

Technical Support documentation and tools are accessible from:

»  https://www.cisco.com/en/US/support/index.html.

The Product Alert tool is accessible from (sign in required):

»  https://www.cisco.com/cgi-bin/Support/FieldNoticeTool/field-notice.

Installation and Configuration Guide for Cisco Unified Contact Center Management Portal


http://www.cisco.com/en/US/support/index.html
http://www.cisco.com/cgi-bin/Support/FieldNoticeTool/field-notice

For information on the Cisco software support methodology, refer to Software Release and Support
Methodology: ICM/IPCC, available from (sign in required):

> https://www.cisco.com/en/US/partner/products/sw/custcosw/ps1844/prod_bulletins_list.html.

For a detailed list of language localizations, refer to the Cisco Unified ICM/Contact Center Product and
System Localization Matrix, available from:

» https://www.cisco.com/en/US/products/sw/custcosw/ps1001/prod_technical_reference_list.html.

Communications, Services, and Additional
Information

» To receive timely, relevant information from Cisco, sign up at Cisco Profile Manager.
» To get the business impact you’re looking for with the technologies that matter, visit Cisco Services.
» To submit a service request, visit Cisco Support.

» To discover and browse secure, validated enterprise-class apps, products, solutions and services, visit
Cisco Marketplace.

» To obtain general networking, training, and certification titles, visit Cisco Press.

» To find warranty information for a specific product or product family, access Cisco Warranty Finder.

Cisco Bug Search Tool

Cisco Bug Search Tool (BST) is a web-based tool that acts as a gateway to the Cisco bug tracking system
that maintains a comprehensive list of defects and vulnerabilities in Cisco products and software. BST
provides you with detailed defect information about your products and software.

Field Alerts and Field Notices

Cisco products may be modified, or key processes may be determined to be important. These are announced
through use of the Cisco Field Alerts and Cisco Field Notices. You can register to receive Field Alerts and
Field Notices through the Product Alert Tool on Cisco.com. This tool enables you to create a profile to
receive announcements by selecting all products of interest.

Log into www.cisco.com and then access the tool at https://www.cisco.com/cisco/support/notifications.html
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https://www.cisco.com/c/en/us/services/overview.html
https://www.cisco.com/c/en/us/support/index.html
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https://connectthedots.cisco.com/connectdots/serviceWarrantyFinderRequest?fl=wf
https://www.cisco.com/c/en/us/support/web/tools/bst/bsthelp/index.html

Documentation Feedback

To provide comments about this document, send an email message to the following address:
contactcenterproducts_docfeedback @cisco.com

We appreciate your comments.

Document Conventions

This guide uses the following typographical conventions.

Convention Indicates

Italic Emphasis, or the title of a published document.

Bold An item in the user interface, such as a window, button, or tab.

Monospace A file name or command.

fm'fi A variable, which is a placeholder for user-specific text provided by the user.

Or, text that must be typed by the user.

Document conventions
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About the Installation

A successful installation of Unified CCMP requires some understanding of the platform components, the
environment in which they are deployed and how they are configured in a cluster of linked servers. File systems
and storage options are also discussed as well as user accounts and security considerations in an internet facing
environment.

Deployment Specifics

Unified CCMP Resource Management deployments are limited to standard and hosted Unified CCE
deployments, with the following restrictions:

Each configured Unified CCE instance must have its own:
» Unified ICM instance.
» Dedicated Admin Workstation Real Time Distributor Server.

» Dedicated Admin Workstation CMS Server.

Infrastructure Software

Unified CCMP requires:
»  Windows Server 2022 Edition: Standard or Datacenter
» SQL Server 2022 64-bit Edition: Standard or Enterprise.

Unified CCMP Components

18

A Unified CCMP installation comprises the following components.

» The Database Server, which holds information about resources (such as agents, skill groups and dialed
numbers). It consists of:

O  The Portal Database, which holds the data that has been provisioned through Unified CCMP or
imported from Unified CCE.

O The Identity (IdSvr3Config) Database holds the data security token which is used to authenticate
users via single sign-on.

O  The Data Import Server, which imports and synchronizes resources and changes to resources from
back-end contact center systems (for example, Unified CCE).

O The Provisioning Server, which applies resource changes made by Unified CCMP users to the back-
end contact center systems.

O  The Partitioning Server, which manages the creation and removal of Unified CCMP partition tables,
used to store contact center data.

Installation and Configuration Guide for Cisco Unified Contact Center Management Portal



» The App/Web Server which provides two components for interfacing with Unified CCMP:

O The Application Server delivers application services such as search, security and resilience to the
Unified CCMP Web Server.

O The Web Server provides the web front end that enables users to perform resource management and
administrative tasks.

» The Identity Server, which provides a two-factor identification system that allows implementation of single
sign-on, and access control. The lightweight authentication service includes Local, Windows, ADFS and
Entra ID authentication. Users can have mixed authentication modes, which define how a user can access the
system.

Deployment Model

In many environments, Unified CCMP is installed using a dual-sided deployment model to provide load
balancing, resiliency, and high availability. For deployments that require layered security, such as Internet-facing
environments, both sides are split across separate Database Servers and App/Web Servers are separated by a
demilitarized zone (DMZ).

For deployments supporting up to 48K agents, use the OV A file published for CCMP15 to create virtual
machines. To update an existing deployment to support 48K agents, refer to “Supporting 48K Deployment” on
page 20.

Because Unified CCMP scales up with equipment and scales out with servers, a variety of cost-effective
deployment models are possible. Refer to the Virtualization Wiki for Hardware and System Software
Specification:
https://www.cisco.com/c/dam/en/us/td/docs/voice_ip_comm/uc_system/virtualization/virtualization-cisco-
unified-contact-center-management-portal.html

The following deployment model assumes the possibility of a dual-sided server configuration that replicates data
between sites.

» Two Tier (Secure Deployment): Unified CCMP Application, Web, and Identity components are hosted on
one server. The Provisioning, Data Import and Database components are hosted on a second server.
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The following image describes the software installation layout for dual tier deployment. The web server and
application server components reside on a separate server. This configuration can optionally have a second side
in the same configuration for resilience.

Side & Side B {Optional)
WEE SERVER ™ WEE SERVER ™
Web Server | | Web Server |
Application Serer | | Application Serer |

Tdentity Server | Tdentity Server

—

|
A vy
DATAEASE SERVER T DATAEASE SERVER ™
Datshase | | Datdhase |
Diata Ivprt Frovisioning Diats Inmpert Frovisioring
Server Server Server Server
RN, o

Component layout for a dual-sided two-tier deployment

Supporting 48K Deployment

To meet the demands of high-capacity environments, Unified CCMP now supports deployments for up to 48K
Unified Contact Center Enterprise (UCCE) users.

Upgrading CCMP Hardware Specifications to Support 48K Deployment
Before upgrading the existing integrated UCCE to support 48K, ensure the following:
» The CCMP hardware specifications are properly upgraded.

» Perform all actions during a scheduled maintenance window.

To upgrade CCMP deployment type to support 48K UCCE:

1. Access the Virtual Machine on the ESXi/ESX host and click the Edit Virtual Machine Settings option in
the VM hardware settings.

2. Update the Database Server configuration by performing the following tasks:

a. Increase the CPU cores to 8 and set the CPU reservation to 15000 MHz.
b. Increase the memory to 32 GB and set the memory reservation to 20 GB.
c. Verify the following disk configurations:

e Disk 1 (C: Drive): 150GB

e Disk 2 (D: Drive): 200 GB

e Disk 3 (E: Drive): 25 GB

If the disk sizes do not meet these requirements, extend them accordingly.

3. Update the Application Server configuration by performing the following tasks:
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Increase the CPU cores to 8 and set the CPU reservation to 11000 MHz.
Increase the memory to 40 GB and set the memory reservation to 15 GB.

Verify the following disk configurations:
e Disk 1 (C: Drive): 150 GB
e Disk 2 (D: Drive): 100 GB

If the disk sizes do not meet these requirements, extend them accordingly.

4. Perform the following post-extension steps:

a.

Once the CCMP hardware specifications are updated, proceed to upgrade the existing integrated UCCE
to support 48K.

Reconfigure the UCCE after the upgrade.

Ensure that the application is deployed on the D: Drive and not on the drive where the operating
system is installed.

For more details on editing VM hardware settings, refer to the official VMware Hardware
Documentation.
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About the Installation Prerequisites

This chapter describes the installation prerequisites for Unified CCMP. The Unified CCMP Installer checks that
the prerequisites for each component are present and correctly configured before allowing you to install that
component. Where possible, prerequisite software is included with the Unified CCMP Installer, and is installed
and configured directly from the Installer. SQL Server is licensed separately, so is not included with the Unified
CCMP Installer.

General Requirements

This section describes the general requirements for your installation.

4

4

Do not install any Unified CCMP component on a domain controller.

Unified CCMP server names must consist of alphanumeric characters only, without underscores or hyphens
and can be up to a maximum of 15 characters. The name must conform to the NETBIOS guidelines
(https://support.microsoft.com/en-in/help/909264/naming-conventions-in-active-directory-for-computers-
domains-sites-and).

All app/web servers must be configured to support IPv4 addressing for internal component communication.
All other Unified CCMP servers must have an IPv4 address only.

Unified CCMP does not support SQL Server named instances. All SQL Server installations must use the
default instance name.

The SQL Server TempDB directory and TempDB log directory should not be located on the same disk as
the operating system.

CCMP Windows Requirements

4

All Unified CCMP servers require the Windows Server 2022 version of Windows.

Additional Software Requirements

This section lists the additional software required for each Unified CCMP server. Detailed instructions for
installing and configuring these items are provided at the appropriate point in the installation instructions.

The Unified CCMP servers that require SQL Server must meet the installation prerequisites defined in
https://learn.microsoft.com/en-us/sql/sql-server/install/hardware-and-software-requirements-for-installing-sql-
server-2022?view=sql-server-verl5.
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Database Servers

The Unified CCMP Database Server requires Microsoft SQL Server 2022 64-bit, Standard or Enterprise
Edition. The following components should be deployed:

» Database Engine

» SQL Server Management Studio

Application Servers

There are no additional software requirements for the App/Web Servers.

Java Runtime Environment Support

Cisco Unified CCE Resource Management functionality requires Java Runtime Environment support. Unified
CCMP supports:

» Open JDKI11. If a version prior to this update is installed, the application automatically installs this JDK
update.

Minor version JDK updates can be applied. Major version updates are not supported.

User Desktop Requirements

24

The Unified CCMP web application supports the following browsers:

» Google Chrome (Version 88.0.4324.190 (Official Build) (64-bit))

» Mozilla Firefox version 86.0 (64-bit)

» Microsoft Edge - Chromium version 88.0.705.74 (Official build) (64-bit)

&\ Important: The Unified CCMP web application may not work with virtual desktops or application

Y virtualization technologies (for example, Citrix XenDesktop, Citrix XenApp, VMware Horizon View).
You may use these technologies, but we cannot provide support in the event of a problem, unless
the issue can be replicated using one of the supported browser configurations.
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Architecture Diagram

This section provides details of the standard connections from Unified CCMP components to all remote

telephony equipment from Cisco.

UCCMP
ion Server
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Cisco Unified CCE Domain
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| Config Web
Service
I
I
Default
Sr. Purpose Local Remote Remote Default Remote
No. Local Server | Component | Server Component | Protocol Local Port | Ports
1 Media File CCMP Application Cisco Unified | Unified HTTPS 8111*
Upload/Down | Application Services CVP Ops Config (REST Web
load Server Console Service)
VXML
Application
Upload
2 Supervisor CCMP Application Cisco CCE Active TCP 389/ 3268,
domain Application Services Domain Directory (LDAP/GC) 636/ 3269
account Server Controller
provisioning
3 Provisioning | CCMP Provisioning | Cisco Unified | Unified HTTPS 443
Precision Database Service CCE Admin Config (REST Web
Queues, Server Workstation Service)
Agent
Attributes,
and so on
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Default
Sr. Purpose Local Remote Remote Default Remote
No. Local Server | Component | Server Component | Protocol Local Port | Ports
4 Provisioning | CCMP Provisioning | Cisco Unified | ConAPI TCP (Java Local Remote
Agents, Database Service CCE Admin Remoting) Registry - Registry -
Skillgroups, Server Workstation 2099* 2099*
and so on /2098* /2098*
Local Port- | Local
3333* Port-
/3334% 3333*
/3334
5 Provisioning | CCMP Provisioning | Cisco Unified | AXL HTTPS 443
IP Phones, Database Service CM (SOAP Web
Directory Server Service)
Numbers,
and so on
6 Importing CCMP Data Import | Cisco Unified | Unified HTTPS 443
Capacity Database Service CCE Admin Config (REST Web
Data Server Workstation Service)
7 Importing CCMP Data Import Cisco Unified Unified HTTPS 8111*
Media Files, | Database Service CVP Ops Config (REST Web
Media Server Console Service)
Servers, and
so on
8 Importing CCMP Data Import | Cisco Unified | AWDB TCP (MS 1433
Agents, Database Service CCE Admin SQL Server)
Skillgroups, Server Workstation
and so on
9 Importing IP | CCMP Data Import | Cisco Unified | AXL HTTPS 443
Phones, Database Service C™M (SOAP Web
Directory Server Service)
Numbers,
and so on

* Ports configurable via Integrated Configuration Environment (ICE) tool on CCMP
Database Server
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Firewall Configurations

About Firewall Configuration

Firewalls may be deployed between the various Unified CCMP servers (to create a DMZ) and possibly also
between the Unified CCMP database servers and the Unified CCE AWs. In such configurations, the appropriate
firewall ports must be opened to both-way traffic.

The Windows firewall must be configured to enable the various components of Unified CCMP to communicate
with one another in a distributed environment. Port restrictions should be limited to only the servers that require
the specified communication channels.

The incoming firewall requirements for the Unified CCMP software components are listed in the tables below.

These tables do not include standard Windows ports such as DNS and Kerberos, or the ports required to access
the Unified CCMP servers for support purposes (either Terminal Services or Remote Desktop).

Note: If required, configure the firewall ports before you install Unified CCMP.
<.<l )

Web Server Port Usage

Note: The ports listed in this table must be configured to accept traffic from IPv6 addresses.
<.<l )

Application Incoming

Protocol/Service Protocol Ports Used by Usage

HTTP TCP 80* End User Web application
HTTPS TCP 443* End User Web application
Web Service TCP 8083 Customer Applications Customer-specific
Subscriptions

Web Service Resource | TCP 8085 Customer Applications Customer-specific
Management

* These are the default ports. If you are using different ports, then the default
ports can be disabled.
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Unified CCMP Database Server Port Usage

Application Incoming

Protocol/Service Protocol Ports Used by Usage

SOL Server TCP 1433%** Other Database Servers, General
Application Servers

DTC TCP 2103 Other Database Servers Audit Archive

DTC TCP 2105 Other Database Servers Audit Archive

DTC (RPC) TCP 135 Other Database Servers Audit Archive

DTC (RPC) TCP 5000 - 5100* | Other Database Servers Audit Archive

NetBIOS File Share TCP 137-138 Other Database Servers, Replication, Unified CVP File
Application Servers Upload

NetBIOS File Share TCP 139 Other Database Servers, Replication, Unified CVP File
Application Servers Upload

ConAPI Local Registry | TCP 2099** Unified CCE Admin Provisioning
Workstation

ConAPI Local Registry | TCP 2098+ Unified CCE Admin Provisioning (Dual-sided
Workstation deployment only)

ConAPI Local Port TCP 3333** Unified CCE Admin Provisioning
Workstation

ConAPI Local Port TCP 3334+ Unified CCE Admin Provisioning (Dual-sided
Workstation deployments only)

* Dynamically assigned RPC port range used by MSDTC. Configured in registry as
HKEY_LOCAL_MACHINE\Software\Microsoft\Rpc\Internet after each change the machine
must be restarted.

*% Default value for Side A - configured in Cluster Configuration. Must be open on
both sides of a dual-sided deployments.

*%%* This is the default port. If you are using different port, then the default

port can be disabled.

+ Default value for Side B - configured in Cluster Configuration. Must be open on
both sides of a dual-sided deployments. Not required for single sided deployments.
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Cisco Unified CCE Port Usage

Application Incoming

Protocol/Service Protocol Ports Servers Requiring Access Usage

SQL Server TCP 1433** Database Servers, Application | Importing Dimension and Fact

Servers Data, Provisioning Activities

ConAPI Remote TCP 2099* Database Servers Provisioning

Registry

ConAPI Remote TCP 2098+ Database Servers Provisioning

Registry

CMS Node ubP 9000 Database Servers Ping Port for ConAPI services
Web Service API TCP 443** Database Servers Provisioning
* Default value for Side A - use configured in Cluster Configuration.

+ Default value for Side B - use configured

*% These are the default ports.

ports can be disabled.

in Cluster Configuration.

If you are using different ports, then the default

Domain Controllers for Unified CCE Instances Port Usage

Application

Protocol/Service Protocol Incoming Ports Servers Requiring Access | Usage

LDAP/GC TCP 389/ 3268, Database Servers and Supervisor domain account

636/ 3269 Application Servers provisioning
Cisco Unified Communications Manager Port Usage

Application

Protocol/Service Protocol Incoming Ports Servers Requiring Access | Usage

AXL Web Service TCP 443* Database Servers Importing and Provisioning

(HTTPS)

* This is the default port.

port can be disabled.

If you are using a different port, then the default
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Cisco Unified CVP Port Usage

Application

Protocol/Service Protocol Incoming Ports Servers Requiring Access | Usage
Operations Web TCP 443* Database Servers and Provisioning
Service API Application Servers

* This is the default port. If you are using a different port, then the default
port can be disabled.

Security Considerations

Mandatory Security Configuration

This section describes the steps you must take to secure your system. Detailed instructions are provided at the
appropriate point in the installation instructions. If you omit any of the steps in this section, some Unified CCMP
functionality may not work properly, or your installation may be vulnerable.

»  You must configure Secure Sockets Layer (HTTP) for the Unified CCMP web application. For more
information, see “Configuring SSL” on page 82.

Optional Security Configuration

This section describes the steps you may consider to secure your system. Detailed instructions are provided at the
appropriate point in the installation instructions.

To secure your system, you may consider the following steps:

» Disable anonymous sessions on all Unified CCMP servers (see “Disabling Anonymous Sessions” on
page 37). This prevents anonymous users from enumerating user names and shares, and from using this
information to guess passwords or perform social engineering attacks. For more information, consult the
Microsoft documentation https://docs.microsoft.com/en-us/windows/security/threat-protection/security-
policy-settings/network-access-do-not-allow-anonymous-enumeration-of-sam-accounts-and-shares

» Disable cached logins on all Unified CCMP servers (see “Disabling Cached Logins” on page 38). This
prevents attackers from accessing the cached login information and from using a brute force attack to
determine user passwords. If cached logins are disabled, windows domain users are unable to log in if the
connection to the domain controller is unavailable. For more information, consult the Microsoft
documentation https://docs.microsoft.com/en-us/windows/security/threat-protection/security-policy-
settings/interactive-logon-number-of-previous-logons-to-cache-in-case-domain-controller-is-not-available

» Disable DCOM on all Unified CCMP servers (see “Disabling DCOM” on page 38). This makes the server
less attractive to malware, which may be used to gain elevated privileges and compromise the system. For
more information, consult the Microsoft documentation https://docs.microsoft.com/en-
us/windows/win32/com/setting-machine-wide-security-using-dcomcnfg
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» Enable mandatory Server Message Block (SMB) signing (see “Enabling Mandatory SMB Signing for all
Unified CCMP Servers” on page 38). This prevents “man in the middle” attacks that modify SMB packets
in transit and ensures the integrity of file sharing and other network operations. For more information,
consult the Microsoft documentation https://docs.microsoft.com/en-us/windows/security/threat-
protection/security-policy-settings/smbv | -microsoft-network-client-digitally-sign-communications-always

@ Note: If you enable SMB signing, the server is unable to communicate with a Microsoft network client
¥/ unless that client agrees to perform SMB packet signing. So SMB signing needs to be enabled on every
client machine in the cluster, including all clients running the web application.

» Disable SSL v2 on all App/Web Servers (see “Disabling SSL V2” on page 39). This ensures that the latest
security encryption technology and the most recent security fixes are being used.

» Remove the aspnet_client folder, which is installed with .Net, typically in the C:\inetpub\wwwroot folder.
This folder appears by default on an IIS Server but is not used by Unified CCMP.

» Disable HTTP/2 as it can present security vulnerabilities if not managed properly. One such vulnerability is
the HTTP/2 CONTINUATION Attack, which can lead to Distributed Denial of Service (DDoS) incidents by
overwhelming server resources. For more information, see “Disabling HTTP/2” on page 39.

Browser Security Using HSTS

HTTP Strict Transport Security (HSTS) is a web security standard that enforces secure connections by
ensuring browsers always use HTTPS when communicating with websites. This feature is designed for web
applications accessed via a browser, helping to prevent insecure connections and mitigate man-in-the-middle
attacks. In the CCMP web application, HSTS is implemented to secure browser-based access.

For API access, CCMP uses designated ports on the application server for resource management, which are
configured to accept only HTTPS requests. Since HSTS headers do not provide additional security benefits for
API communication, they are excluded from API responses.
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Configuring Windows

Configuring Firewalls

4

If your installation requires it, configure the firewall ports as described in “Firewall Configurations” on
page 27.

Configuring Settings on All Unified CCMP Servers

1.

On each of the Unified CCMP servers in your installation:
O  Configure the server to use the US English character set.
o Configure Remote Desktop Services for remote configuration and support.

O In the Event Viewer, set the Application Log, Security Log and System Log to Overwrite events as
needed.

Using the Windows Time Service, ensure the date and time are synchronized across all Unified CCMP
servers. Unified CCMP is not able to synchronize application data correctly between servers otherwise, and
this may cause unexpected behavior.

Initialize and Format Secondary Disk on Database Server

After installing the operating system on CCMP servers, initialize and format the secondary disk on the database

server.

1. Go to the database server, open the command prompt and type diskmgmt.msc.

2. Right-click on Diskl, and click Online.

3. After the disk goes online, right-click the disk, and then select Initialize Disk.

4. In the Initialize Disk window, under the Use the following partition style for the selected disks option,
click the (MBR) Master Boot Record radio button and click OK.

5. After the disk is initialized, right-click the disk, and then click Convert to Dynamic Disk.

6. In the Convert to Dynamic Disk window, check the Disk 1 check box to select it, and then click OK.

7. Right click on the unallocated disk space and click New Simple Volume. The New Simple Volume Wizard
window appears.

8. Click Next and follow the on-screen instructions to create a simple volume on the disk.

9. Click Finish to complete the process of allocating memory to the hard drive.

10. Repeat steps 1-9 on Disk 2.
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Configuring User Accounts

Configuring Unified CCMP Service Accounts

» Unified CCMP Services are installed to run under Windows system accounts (such as Network Service) by
default.

Configuring Application Accounts

Unified CCMP requires the following domain accounts to communicate between components.

Configuring SQL Agent Users

» SQL Server uses this account to replicate data between SQL Server databases. By default, Unified CCMP
expects the account name to be sql_agent_user, but you can specify a different name when Unified CCMP
is installed.

The domain account for the sql_agent_user needs to have write permission to the SQL Server common files
folder COM. The default folder is <Znstall Drives:\ <Program Files>\Microsoft SQL Server\<sQL Version>\COM,
where:

» <Install Drive> is the drive letter of the drive SQL Server was installed on.
» <Program Files> is the folder that SQL Server was installed to.

» <SQL Version> is the version number for the SQL Server common folder.

8: Note: For single-sided installations, you can choose to allow Unified CCMP to create these accounts
k-/ automatically as local accounts. But if you choose this option, then add additional servers to your
deployment later, you need to reinstall the system.

To create the required accounts:

» Using Active Directory, create the domain account sql_agent_user (or a name of your choice) with the
following attributes:

o Password never expires

o User cannot change password
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Installing and Configuring SQL Server

Installing SAL Server on Dedicated Database Server

Follow these instructions to install SQL Server 2022 64-bit Standard or Enterprise Edition on the server or
servers that are hosting the database.

For a dual-sided deployment, perform these tasks on the Side A and Side B servers.

To install SQL server:

1.

2
3
4,
5
6

10.
11.
12.

13.

14.

15.

In the SQL Server Installation Center, select Installation.

Select New SQL Server stand-alone installation or add features to an existing installation.
Ensure that Microsoft updates are not selected, then click Next.

Enter the SQL Server product key and click Next.

Read the license terms. If you agree with the terms, select I accept the license terms and click Next.

The Global Rules window displays, validating the system for the SQL Server installation. Once validation
passes, click Next.

The installation of setup files starts, then the system setup is validated. Once validation is completed, click
Next.

In the Setup Role window, select Feature Installation.
In the Feature Selection window, select the following instance features:
o Database Engine Services
e SQL Server Replication
Update the installation directories to the required locations. Click Next.
The installation rules are then checked. If any problems are reported, correct them, then click Next.

The Instance Configuration window is displayed. Select Default Instance, with an Instance ID of
MSSQLSERVER. Update the Instance root directory to be installed on the required drive, then click Next.

In the Server Configuration window, on the Service Accounts tab, set the following service configuration:

O Locate the SQL Server Agent entry in the Service column, set the Account Name to NT
AUTHORITY\SYSTEM and the Startup Type to Automatic.

O Locate the SQL Server Database Engine entry in the Service column and set the Account Name to
NT Service\MSSQLSERVER.

In the Server Configuration window, on the Collation tab, ensure that the Database Engine Collation is
Latinl_General_CI_AS. If it is not, click Customize, and select a collation designator of Latinl_General,
ensure that Case-sensitive is cleared and Accent-sensitive is selected, then click OK. When the collation is
correct, click Next to proceed.

The Database Engine Configuration window is displayed. Set the following and click Next:

a. Select Mixed Mode authentication and enter a password for the sa user.
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b. In the Specify SQL Server Administrators panel click the Add Current User button. Also add any
other accounts that require administrator permissions to the database, for example, domain admins,
service accounts etc.

c. Select the Data Directories tab. Temp DB directory and Temp DB log directory should not be
located on the same drive as the Windows operating system. You may see a warning during Unified
CCMP installation if they are. Make any required changes to the data directory locations.

16. You may see the Feature Configuration Rules window while installation checks are performed. If so, wait
until the checks complete successfully.

17. Review the installation summary and click Install.

18. Once the installation is complete click Close.

Installing SQL Server Management Studio (SSMS) Release 18.x

» Install the SSMS v18.12.1 tool on the database server. For a dual sided deployment, perform these tasks on
the Side A and Side B servers. To download the latest version, click here.

Configuring SQL Server Network Protocols

On the server or servers that host the Unified CCMP Database, configure the SQL Server network protocols
listed in this section.

To configure SQL Server network protocols:
1. Launch SQL Server 2022 Configuration Manager to open the SQL Server Configuration Manager.

2. In the left-hand pane, expand SQL Server Network Configuration and click Protocols for
MSSQLSERVER.

3. In the right-hand pane right-click on Named Pipes, select Enable, and click OK to confirm.
4. In the right-hand pane, right-click on TCP/IP, select Enable, and click OK to confirm.

5. In the left-hand pane, click on SQL Server Services, then right-click on SQL Server (MSSQLSERVER)
and select Restart to restart the SQL Server process.

6. Close the SQL Server Configuration Manager window.

Configuring Windows Firewall for SQL Server

By default, the Windows firewall will not allow incoming traffic for SQL Server. If the Windows firewall is
enabled on the server or servers that will host the Unified CCMP Database, follow these steps to create a rule to
allow SQL Server traffic.

To configure Windows firewall:

1. In Server Manager, click Tools, select Windows Firewall with Advanced Security and click Inbound
Rules. A list of firewall rules is displayed.

2. In the Actions pane, click New Rule. The New Inbound Rule Wizard is displayed.
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Select Port as the rule type and click Next.

Select TCP as the protocol and enter 1433 as the specific local port. Click Next. The Action options are
displayed.

Choose Allow the connection. Click Next. The Profile options are displayed.
Select the profile options that are appropriate to your deployment and click Next.

Enter a name for the rule and click Finish to create the rule. The new rule appears in the list of inbound rules
as an enabled rule.

Close the Server Manager window.

SQL Server Backup Guidelines

4

»

Regularly backup the SQL Server databases and truncate transaction logs to prevent them from becoming
excessively large.

Schedule backups for quiet times of the day.

Configuring Optional Security Settings

Disabling Anonymous Sessions

This step is optional but must be done if you desire maximum security. See “Optional Security Configuration” on
page 30 for more information.

This security setting applies to all Unified CCMP servers. There are several ways to configure this security
setting. This section describes two possible ways.

To disable anonymous sessions:

1.

In the Group Policy Editor, browse to Computer Configuration > Windows Settings > Security Settings
> Local Policies > Security Options and enable the Network access: Do not allow anonymous
enumeration of SAM accounts and shares setting.

Alternatively, you can update the registry directly by following these steps:
a. In the Run command dialog box, enter regedit.

b. In the Registry Editor, browse to select the HKEY_LOCAL_ MACHINE > SYSTEM >
CurrentControlSet > Control > Lsa node.

c. In the right-hand pane, if the REG_DWORD value restrictanonymous is present, set it to 1,
otherwise, create it and set it to 1. Click OK.

d. Close the Registry Editor.
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Disabling Cached Logins

This step is optional but must be done if you desire maximum security. See “Optional Security Configuration”
on page 30 for more information.

This security setting applies to all Unified CCMP servers. There are several ways to configure this security
setting. This section describes two possible ways.

To disable cached logins:

1. Inthe Group Policy Editor, browse to Computer Configuration > Windows Settings > Security Settings
> Local Policies > Security Options and set the Interactive logon: Number of previous logons to cache
(in case domain controller is not available setting to 0.

2. Alternatively, you can update the registry directly by following these steps:
a. In the Run command dialog box, enter regedit.

b. In the Registry Editor, browse to select the HKEY_LOCAL_ MACHINE > Software > Microsoft >
Windows NT > CurrentVersion > Winlogon node.

c. In the right-hand pane, if the REG_SZ value CachedLogonsCount is present, set it to 0, otherwise,
create it and set it to 0. Click OK.

d. Close the Registry Editor.

Disabling DCOM

This step is optional but must be done if you desire maximum security. See “Optional Security Configuration”
on page 30 for more information.

This security setting applies to all Unified CCMP servers.

To disable DCOM:
1. Launch Component Services from the Administrative Tools group.
2. Expand Component Services, and then Computers. Right-click on My Computer and select Properties.

3. Select the Default Properties tab and clear Enable Distributed COM on this computer. Click OK, then
Yes when asked to confirm that you want to update the DCOM Settings.

4. Close the Component Services dialog box, then reboot the server.

Enabling Mandatory SMB Signing for all Unified CCMP Servers

This step is optional but must be done if you desire maximum security. See “Optional Security Configuration” on
page 30 for more information.

This security setting applies to all Unified CCMP servers.

To enable mandatory SMB signing:

1. In the Server Manager, click Tools and select Local Security Policy. Navigate to Local Policies >
Security Options.
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In the right-hand pane, click on Microsoft network client: Digitally sign communications (always). Select
Enabled and click OK.

Close the Local Security Policy dialog box.

On every client that needs to communicate with the Unified CCMP servers (including all clients running the
Web Ul), ensure that the following security options are set in the local security policy.

a. Launch Server Manager.
b. Click Tools select Local Security Policy.

c. Navigate to Local Policies > Security Options and ensure that the following security options are set:

e Microsoft network client: Digitally sign communications (always): Ensure this is Disabled (the
default value), unless other systems specifically require it to be enabled.

e Microsoft network client: Digitally sign communications (if server agrees): Ensure this is
Enabled (this is the default value).

Disabling SSL V2

This step is optional but must be done if you desire maximum security. See “Optional Security Configuration”
on page 30 for more information.

Perform these tasks on each application/web servers.

To disable SSL V2:

1.
2.

In the Run command dialog box, enter regedit.

In the Registry Editor, browse to HKEY_LOCAL_ MACHINE > SYSTEM > CurrentControlSet >
Control > SecurityProviders > SCHANNEL > Protocols > SSL 2.0 node.

If the registry key Server does not exist, right-click the SSL 2.0 node, select New > Key, and create it.
Under the registry key Server, create a DWORD value named Enabled and set the value data to 00000000.

Close the Registry Editor and reboot the server.

Disabling Remote Access to Unified CCMP Servers

Unified CCMP servers can be administered remotely using tools such as Remote Desktop Services. Unified
CCMP does not require remote access to work correctly, so for additional security you can disable remote access
and use console access to administer the Unified CCMP servers.

Disabling HTTP/2

HTTP/2 is not explicitly enabled or disabled during installation, nor is it required from a functionality
standpoint. However, HTTP/2 vulnerabilities, such as the CONTINUATION Attack, can expose servers to
Distributed Denial of Service (DDoS) risks. This attack exploits fragmented header frames to exhaust server
resources, potentially disrupting services for legitimate users.
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Users can safeguard their servers against DDoS vulnerabilities related to the protocol by disabling HTTP/2 in
IIS.

To disable HTTP/2:

1. Open IIS Manager.

Navigate to Default Web Site under Sites in the left-hand pane.
In the right-hand pane under Edit Sites, click Bindings.

Select https types and click Edit.

Check the box for Disable HTTP/2.

Click OK.

N o kv

If multiple https types are configured, repeat steps 4, 5 and 6 for each.
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Installation Process

» Before you Start

» About the Unified CCMP Installer

» Installing the Database Components

» Installing the Portal Database

» Installing the Application and Web Server
» Installing the Identity Server

» Installing the Second Side (Replicated Systems Only)



Before you Start

@ Note: The installation instructions assume that you are installing the product software on the C: drive. If
you are installing the software on another drive, then where the instructions reference a specific drive,
replace the reference to the C: drive with the drive you are using.

Installing Dual-Sided Systems

For dual-sided systems, perform a complete installation on the Side A servers, and then a complete installation
on the Side B servers. Make sure to install the components in the order described here.

Recording Your Settings

During the installation procedure, there are occasions where you need to record what settings you chose for later
reference. You should record the following information and store it in a secure location, for future reference.

System Setting Value

Database Catalog Name

sgl_agent_user

Password portal_user

Password

Cryptographic Passphrase

Administrator Password

Java.RMI.Hostname

Unified CCE

Application Name
Application Key

RMI Registry Port

LocalPort
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About the Unified CCMP Installer

Verifying Signature File for ISO

To verify signature file for ISO:

1.

Download and install openssl from https://slproweb.com/products/Win320OpenSSL.html
Any type of installer (either EXE or MSI) with any bit (32 or 64) can be downloaded from the link.

Install the download openssl using the instructions provided on the website. Have the openssl path added to
the system path environment variable so that openssl command can be launched from any path.

Place the ISO image, ISO image signature file, and the public key.der in the same folder.
o UCCMP.12.6.7293.2847.iso.signature

o UCCMP.12.6.7293.2847.iso

o UCCEReleaseCodeSign_pubkey.der

Launch the command prompt by right-clicking and choosing Run as administrator.

Execute the cli command in the command prompt to verify the authenticity and integrity of the CCO
downloaded ISO.

Syntax: Openssl dgst -sha512 -keyform der -verify <Wléo/<g/.der> -signature <750
Wﬂﬁ&bfo.rfﬁkmtw&> <ISO Image>

For example: Openssl dgst -sha512 -keyform der -verify
UCCEReleaseCodeSign_pubkey.der -signature UCCMP.12.6.7293.2847.7iso.signature
UCCMP.12.6.7293.2847.19s0

Upon successful verification, output is Verified OK and on failure Verification failed.

Starting the Installer

The Unified CCMP ISO contains the Unified CCMP Installer. To start the Installer, mount the ISO.

4

If auto-run is enabled, a window opens automatically showing a list of Unified CCMP components that can
be installed.

If auto-run is disabled and you do not see the Installation Components screen, double-click autorun.bat
to launch the Unified CCMP installer manually.

If UAC has not been disabled, launch the installation manually by right- clicking autorun.bat and
selecting Run as administrator option.

Note: Some anti-virus software may state that the autorun.hta script file is malicious. Please ignore this
@- message.
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Installation Prerequisites

When you click on a component to install it, the installer displays a list of prerequisites for that component and
checks that each prerequisite is present. As each check completes, you see a green tick (check successful) or a
red cross (check failed).

Where possible, the Unified CCMP includes redistributable packages for prerequisites, so if a prerequisite check
fails, you can click on the link in the Unified CCMP installer to install the missing prerequisite. Once all the
prerequisite software is installed, you can click on the component again, then click Rerun to rerun the tests.

When all the prerequisites display a green tick, you can click Install to install the chosen component.

Installing the Database Components

Perform the following steps on the Side A Database server.

To install the database components:

1.  Mount the Unified CCMP iso and start the Unified CCMP Installer (for more information about the Unified
CCMP Installer, see “About the Unified CCMP Installer” on page 43).

2. Select Database Server and wait until the prerequisite checks have completed. If any checks fail, fix the
issues as necessary.

3. In the License Agreement window, you must accept the terms of the license agreement before proceeding.
When you have read and agreed to the terms, click Next.

4. In the Cryptography Configuration window, provide the following and click Next:

O Passphrase: Create a cryptographic passphrase of between 6 and 35 characters. This passphrase is used

for encrypting and decrypting system passwords and must be the same for all servers in the Unified
CCMP installation.

O  Confirm Passphrase: You cannot continue until the contents of this field are identical to the passphrase
entered above.

o\ Important: The cryptographic passphrase is a vital piece of information and is needed when

% installing later components and when adding or replacing servers in the future. Be sure to record
and retain it.
If you are upgrading from a previous version of Unified CCMP, or adding a new server to an
existing cluster, you must use the same cryptographic passphrase as was originally used. If you
continue the installation with a new passphrase you will be unable to access your existing data.
If the cryptographic passphrase is forgotten or lost, it is not possible to recover this and you
cannot access your existing data.

5. In the Configure Database window, provide the following and click Next:
O SQL Server: This field is grayed out and the value is set to localhost.

O Port: Provide database server SQL non-default Port. By default the value is set as 1433. This field has
been introduced in CCMP 15 ES202603.

o Catalog Name: Enter the name of the database catalog for Unified CCMP. By default, this is Portal.
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O Connect Using: Select the login credentials you want to use:
e Windows authentication credentials of application

e SQL Server authentication using the login ID and password below: This option should only be
selected if you are using a database catalog on a different domain. For this option you must enter
your SQL Server Login Name and Password in the fields provided.

In the Destination Folder window, if you want to change the location where the database components are
stored, click Change and select the new location. The Unified CCMP components need to be installed in the
same directory location on each of the servers. Click Next.

Click Install to install the database components. During this process, the J2SE prerequisite is automatically
installed if it is not already present. If this happens, follow the screen prompts to complete the J2SE
installation. If you see a Security Alert dialog box during the installation, saying Revocation Information
for the security certificate for this site is not available, click Yes to continue.

To install or upgrade your database immediately after installing the database components, select the Launch
Database Management Utility check box at the end of the installation before clicking Finish.

Note: If the Launch Database Management Utility check box is not checked, you can access Database
¥/ Management Utility through the Database Installer.

Click Finish.

Installing the Portal Database

%A Note: The installation of the Portal Database fails unless the SQL Server installation has been configured
¥/ to use US English. If this is not the case, instructions for changing the installation language are given in
“Changing the SQL Server Installation Language to US English” on page 154.

To install the portal database:

1.

If you selected the Launch Database Management Utility check box after installing the database
components (page 45), the database setup wizard starts automatically. Otherwise launch the Unified CCMP
Database Installer.

Click Next to begin the installation.

In the Select an Action to Perform window, choose Install a new database. You can maintain this
database at a later date by running the installer again and selecting the appropriate option.

In the SQL Server Connection Details window, provide the following and click Next:

O  Server Name: Enter the name of the machine that is to be the Database Server. This should normally be
left as the default (localhost). Logon for the SQL Server service needs full control over the folder (or
the individual files in the folder) that contains the database files. The folder that you put the SQL
database files into cannot be compressed.

O Port: Provide database server SQL non-default Port. By default the value is set as 1433. This field has
been introduced in CCMP 15 ES202603.
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O Database Name: Enter or select the name of the database catalog that is used for Unified CCMP. You
use the default name of Portal. This should match the database catalog name specified when you
installed the database components. If not, you see a warning message.

O  Connect Using: Select the login credentials you want to use:
e The Windows account information I use to logon to my computer

e The SQL Server login information assigned by the system administrator: Only select this
option if you are using a database catalog on a different domain. For this option you must enter
your SQL Server Login Name and Password in the fields provided.

O  Click Test Connection. This makes sure the connection to the SQL Server is established. If the
connection can be established, the message Connection succeeded but database does not exist is
displayed.

5. In the Optimize System Databases window, you can change the configuration of the Unified CCMP
database file groups and files to improve performance, if required. All file groups automatically split in to
multiple files on the drive based on the number of logical processors on system divided by 4. You can
reconfigure your database files manually after completing the installation.

For optimum performance, TempDB should not be installed on the same disk as the operating system.

O To split a file group, choose the Split option, click the dropdown arrow to filter the list of file groups
by database, select the file group or file groups you want to split, then click Go. The selected file group
or file groups split into the optimal number of files for your server configuration (one file for every two
logical CPUs).

O To move a file, choose the Move option, click the dropdown arrow to filter the list of files by database,
select the file or files you want to move, click Location to select the new location, then click Go. The
selected file or files are moved to the new location.

When you have made the changes you require, click Next.

6. In the Setup Replication window, if this database installation is not Side B of a replicated system, just click
Next. If this database installation is Side B of a replicated system, select Replicated Configuration and set
up the replication folder share as follows before clicking Next:

O Share Name: The name of the share for the ReplData folder. By default this is ReplData.

O Folder Path: The path of the ReplData folder. This is configured in SQL Server, and is by default
C:\Program Files\Microsoft SQL Server\MSSQL\repldata.

7. In the Configure the Location of Data Files window, if you are not using a custom installation of SQL
Server, accept the defaults and click Next. If you are using a custom installation of SQL Server, configure
the data files as follows before clicking Next:

O Select the check box or boxes beside the file group or file groups you want to change.
o  To change the Location, browse to the new location.

O To change the Max Size, specify the amount of space that should be allocated for the chosen file group
or file groups. The default value is based on Unified CCMP’s analysis of your system.

Note: You may not wish to have the default static max size value that is automatically set for the Max

¥/ Size field based on the analysis of your system. While setting “Unrestricted size is not recommended,
auto-growth can be enabled to minimize the risk of Unified CCMP’s SQL database into a state where you
are not able to make changes.
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To specify a different Initial Size, first clear Set Initial Size to Max Size.
To change default initial size limit of 15mb, select the Set Initial Size checkbox and set the new size.

You can also choose an unlimited file size by selecting Unrestricted Size, but this does not guarantee
optimal performance.

Auto growth value is always set. This value is Use to grow the size of filegroup.
Click Update to save your changes to the selected file group or file groups.

Click Default (in the top right corner of the window) to restore the settings for all file groups to their
default.

Note: After the size of the database has been set, the system calculates the size of the TempDB and
¥/ TempDBLog. The file sizes should be adjusted in accordance with the values in SSMS.
If the database is bigger than the size allocated to the PortalLog file, a warning is displayed. You can
choose to ignore it, or to go back and specify a different size.
The folder path may not be the folder path where SQL Server is installed. The database installer places
the database files on different drives, based on an algorithm that uses the space available on each of the
server drives.

The Configure Local Administrator Details window sets the identity details for the default administrator
account:

O]

o

Name: The type of user account that is used. This is set to Administrator and cannot be changed.

Password: Enter a password for the administrator, conforming to your individual system’s complexity
requirements.

Confirm Password: You cannot continue until the contents of this field are identical to the password
entered above.

The Configure SQL Server Agent Service Identity window sets up a user account that is used by SQL
Server for replication. Provide and verify the following before clicking Next:

o

Q

Account Type: The type of user account that is used. For a distributed installation, this must be
Domain.

User Name: The name of the SQL agent user account. This defaults to sql_agent_user. You can use a
different name by entering the name in the field instead of the given default value. You can select the
Automatically create the user account if missing check box to allow the installer to create a local
account given in this field. If you have specified a domain user, you need to prefix the user name with
the domain name, followed by a backslash. For example, if the SQL agent user belongs to the
ACMEDOM domain then enter ACMEDOMN\sql_agent_user. To configure the account, perform the
steps as described in “Configuring Application Accounts” on page 34.

Automatically create the user account if missing: For a single-sided system that contains a single all-
in-one server, you can optionally select this check box and create the required user automatically. But if
you select this option and need to add additional servers in future, you need to reinstall the system.

Password: If you are using an existing SQL agent user account, enter the password for that account.
Otherwise, if you have a single-sided system and are creating the account automatically, create a
password for the new user, conforming to the complexity requirements for your system.

Confirm Password: You cannot continue until the contents of this field are identical to the password
entered above.
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10.

11.

12.

In the Configure the Location of the Identity Data Files window, select the location of the identity data
files.

a. To change the location, click Location.

b. Select the location of each file group.

c. Click OK to save your changes.

d. Click Next when you have selected the location for each file group.

In the Ready to install the Database window, click Next to begin installation. Installation takes several
minutes

8: Note: If the installation reports an error saying that the SQL Server language must be US English, you
*—/ need to fix this before you can install the Portal Database. For instructions, “Changing the SQL Server
Installation Language to US English” on page 154. Then repeat the installation of the Portal Database.

Click Close to close the installer.

Installing the Application and Web Server

Install the new Application/Web Server components.

To install the application and web server:

1.

Mount the Unified CCMP iso and start the Unified CCMP Installer (for more information about the Unified
CCMP Installer, see “About the Unified CCMP Installer” on page 43).

Select App/Web Server, and wait until the prerequisite checks have completed. If any checks fail, fix the
issues as necessary.

When all checks have passed, click Install to begin the App/Web Server installation. The Management
Portal: Application Server Components window displays. Click Next to go through the installer.

If the Management Portal: Application Server Components Dialog is shown, click Next to install the
additional required components.

If the Microsoft .NET 4.7.2 Framework prerequisite is missing; it is installed at this point. Click Install to
install the component and follow the on-screen instructions. When the .NET 4.7.2 Framework is complete,
restart the server to continue the installation of the Application/Web Server.

In the License Agreement window, you must accept the terms of the license agreement before proceeding.
When you have read and agreed to the terms, click Next.

In the Cryptography Configuration window, provide the following details and click Next:

O Passphrase: Enter the cryptographic passphrase you used for the installation of the Database Server
component.
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O Confirm Passphrase: You cannot continue until the contents of this field are identical to the passphrase
entered above.

o\ Important: You must use the same cryptographic passphrase for all servers in the Unified CCMP

> installation. If you do not know the cryptographic passphrase, stop the installation immediately
and contact your vendor support. If you continue the installation with a new passphrase the
installation does not work.

8. In the Destination Folder window, you can click Change to change the location where the App/Web Server
components are installed. Click Next to continue.
9. In the Configure Database window, provide the following details and click Next:

O  SQL Server: Enter the host name or IP Address of the server hosting the Unified CCMP database. For
a dual-sided deployment enter the name of the Side A Database server when installing the Side A
components and enter the name of the Side B Database Server when installing the Side B components.

O Catalog Name: Enter or select the database catalog name you specified when installing the Database
Server component. If you used the default value, this is Portal.

O Port: Provide database server SQL non-default Port. By default the value is set as 1433. This field has
been introduced in CCMP 15 ES202603.

O  Connect Using: Select the login credentials you want to use:
e Windows authentication credential of application

e SQL Server authentication using the login ID and password below: This option should only be
selected if you are using a database catalog on a different domain. For this option you must enter a
SQL Server Login Name and Password in the fields provided.

7\ Important: You must check that you have provided valid database credentials. There is no
' database validation check present when installing application server components.

10. In the Ready to Install the program window, click Install.

11. When the installation has completed, click Finish. When installation is complete, a dialog box for restarting
the machine appears. Click Yes to restart the server now, or No to restart later.

Installing the Identity Server

Install the new Identity Server components. Ensure that you have successfully installed the Application/Web
Server before attempting to install the Identity Server.

To install the identity server:

1. Mount the Unified CCMP iso and start the Unified CCMP Installer (for more information about the Unified
CCMP Installer, see “About the Unified CCMP Installer” on page 43).

2. Select Identity Server and wait until the prerequisite checks have completed. If any checks fail, fix the
issues as necessary.

3. When all checks have passed, click Install to begin the Identity Server installation.
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4. In the Welcome to the Management Portal: Identity Server setup wizard window, click Next.

5. In the End-User License Agreement window, you must accept the terms of the license agreement before
proceeding. When you have read and agreed to the terms, click Next.

6. In the Configure Cryptography Configuration window, provide the following details and click Next:

O Passphrase: Enter the cryptographic passphrase you used for the installation of the Database Server
component.

O Confirm Passphrase: You cannot continue until the contents of this field are identical to the passphrase
entered above.

%\ Important: You must use the same cryptographic passphrase for all servers in the Unified CCMP

Y installation. If you do not know the cryptographic passphrase, stop the installation immediately
and contact your vendor support. If you continue the installation with a new passphrase the
installation does not work.

7. In the Destination Folder window, click Change... to browse to the destination folder you want to install
into.

8. In the Ready to install Management Portal: Identity Server window, click Install to begin installation.
Installation takes several minutes.

9.  When the installation has completed, click Finish.

Load Balancing the Identity Server

These extra steps are required if the solution is going to use a load balancer to serve multiple identity or web
servers.

Important things to note:

»  Without these steps, logins may fail if requests are sent to the Identity Server using a different database from
the first part of the login flow - replication cannot happen that quickly.

» If you are using a load balancer then the URL must be used in the Unified CCMP setup ICE wizard - the
web server machine names should not be used. This means a load balancer needs to be setup before
configuring Unified CCMP.

» When load balancing, only sticky connections are supported. User sessions can only use one web server.
This involves two steps:
»  Share the same signing certificate (page 50)

» Ensure identity server affinity (page 51)

To share the same signing certificate:

1. On Side A, export the signing certificate (including the private key) that is being used. By default, the
signing certificate is called idsrv3. If a custom certificate is being used, the web.config file enables you to
configure the name using a subject name or a thumbprint under setting svr.signingCertificate. The
svr.signingCertificate setting can be either:

o CN=somename
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o somethumbprint

o\ Important; If you are using a custom certificate, please ensure that only one certificate with the
% same subject name exists on the machine. You can use a thumbprint rather than a subject name
to avoid duplicates.

o\ Important: Note that the Id Server signing certificate is different from the Application Server
Y certificate.

On Side B, import the signing certificated certificate. You need to update the identity server web.config
(D:\Program Files\Management Portal\Identity Server\Identity.Server\web.config) if a custom
certificate is used. You need to give NetworkService Read permissions to the private key. To do this:

O Click Certificate, and then All Tasks.

O  Select Manage Private Keys.

To ensure identity server affinity:

To ensure that the web application uses the same server as the incoming client request, the load balancer URL
must resolve on the web server to itself.

1.

Edit the web server host file C:\Windows\system32\drivers\etc\hosts to resolve the load balancer
hostname to the loopback ip address 127.0.0.1 www.loadbalancer.com.

Import the SSL certificate and private key (PFX file format) used on the load balancer.

Add the SSL certificate to the Local Machine personal store. This must be done even if the load balancer is
doing SSL-Offloading.

Within IIS Manager, change the Bindings so that port 443 is using the newly imported load balancer SSL
certificate.

Restart IIS.

These steps now apply the web application to use the loadbalancer URL for its own internal requests during
logins. This means the web application correctly uses the Identity Server running on the same physical
machine.

Installing the Second Side (Replicated Systems Only)

For replicated systems this installation needs to be repeated for Side B. You should complete Side A installation
of all components before installing Side B.

Installation Process 51



Unified CCMP
Configuration

About Unified CCMP Configuration

Configuring the Unified CCMP Cluster

Configuring Active Directory Federation Services (ADFS)
Configuring Windows Login

Configuring Entra ID Login

Configuring Unified CCE Admin Workstations
Configuring Unified CCE Provisioning

Configuring Replication



About Unified CCMP Configuration

This chapter describes how to configure the server cluster and perform data replication.
This section describes the following steps:

» Configuring the Unified CCMP cluster

» Configuring ADFS

» Configuring Unified CCE Admin Workstations

» Configuring Unified CCE for provisioning

» Configuring replication

Configuring the Unified CCMP Cluster

About Cluster Configuration

Use the Cluster Configuration tool in the Unified CCMP Integrated Configuration Environment (ICE) to:

» Configure the servers in the Unified CCMP cluster (the Unified CCMP servers, Unified CCEs and Unified
Communications Managers).

» Set up the equipment mappings between remote tenants and Unified CCMP resources.

Follow the instructions below to configure your system when you first install it. For more information about
using the ICE tools to modify your system configuration at a later date, see the Integrated Configuration
Environment (ICE) for Cisco Unified Contact Center Management Portal.

Starting ICE Cluster Configuration

For a dual-sided deployment, perform these tasks on the Side A and Side B servers.

To start ICE on the database server:

1. Launch Integrated Configuration Environment (installed as part of Unified CCMP). In the Database
Connection dialog box, set:

O  Server Name: Enter the name of the primary database server.

o Port: Provide database server SQL non-default Port. By default the value is set as 1433. This field has
been introduced in CCMP 15 ES202603.

O Database Name: Enter the name of the Unified CCMP database that was installed when setting up the
Database Component. If you accepted the default value, this is Portal.

O Authentication: Select Windows Authentication.

2. Click OK. The ICE Cluster Configuration tool starts by default.
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3.

In the ICE Cluster Configuration tool, select the Setup tab in the left-hand pane. This displays a series of
wizards to set up the servers.

Configuring Unified CCMP Servers

About the Setup Unified CCMP Servers Wizard

The Setup Unified CCMP Servers wizard configures the servers on which Unified CCMP components are
installed. The wizard guides you through the steps to configure all Unified CCMP components based on your
chosen deployment model.

Setting Up the Unified CCMP Servers

The exact windows displayed by the wizard may depend on the options you choose as you complete each step.

To set up the Unified CCMP servers:

1.

In the ICE Cluster Configuration tool, select the Setup tab and click Setup Unified CCMP Servers to
start the wizard. Click Next to go through each window in turn.

On the Select Deployment Type page, choose Two Tier deployment type. Note that the All in one server
installation is not supported.

On the Configure Redundancy page, select whether you would like to configure a single-sided or a dual-
sided system. Click Next.

If you are performing a two-tier deployment then you are asked to enter the number of web servers for each
side. Enter the value as 1 on each side of your deployment. Click Next.

On the Configure Core Servers pages, enter the Server Name, Server Address and provide the database
server SQL non-default Port number for each of the Unified CCMP servers. Please note that the Port field
has been introduced in CCMP 15 ES202603.

On the Configure Application Servers page, provide the following details:
o Primary Server:
e Server Name: This is the non-domain qualified machine name.

e Server Address: This defaults to Server Name. This can be changed to an IP Address or a domain
qualified name of the server.

e FQDN Web URL: The Fully Qualified Domain Name used to access this web application server.
The FQDN depends on the method of access to the application website, based on whether it is with
or without load balancer. With load balancer, the FQDN is the load balancer FQDN and must be
specified in all Configure Application Server pages. Without load balancer, the FQDN is used to
access each website separately.

7 Note: The FODN must match the SSL certificate.
<.<l )

O Secondary Server: If you chose a dual-sided setup, provide the corresponding details for the Side B
server.
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10.

11.

12.

13.

Click Next and enter the relevant server information for each Unified CCMP server until you reach one of
the following pages: Primary Database Administrator Login, Secondary Database Administrator
Login, or Configure Relational Database Connection.

%A Note: The Primary and Secondary Database Administrator Login pages are only shown if the database
@ user you specified when you started ICE does not have sufficient permissions to create new SQL Server
users and grant permissions to them. If the current database user has sufficient permissions on a server

then you do not see the Database Administrator Login page for that server.

If the Primary Database Administrator Login page is shown, provide details of a SQL Server user
account on the primary database server that has sufficient permissions to create new SQL Server users and
grant permissions to them. This account is used to set up the users and permissions required by Unified
CCMP to connect the Unified CCMP services to the portal database. This account is only used during
system setup.

O Authentication: Select the authentication mode for this user.
e Windows Authentication: Select this option to use the currently logged in Windows domain user.

e SQL Authentication: Select this option to use a specific SQL Server user. Either accept the default
sa user (created when the Unified CCMP database was installed, and which does have sufficient
permissions) or enter another SQL Server user, then specify the password.

O  Click Next.
If you have specified a dual-sided installation, and the Secondary Database Administrator Login page is

shown, follow the instructions in Step 8 to provide details of a database user account with sufficient
privileges on the secondary database server.

On the Configure Database Connection page, enter the connection details to be used by each Unified
CCMP server to connect to the Unified CCMP portal database:

O Catalog: This is the name of the Unified CCMP database. The default is Portal.
O Authentication: Select the authentication mode to use to connect to the Unified CCMP database.

e Windows Authentication: If this mode is selected, each Unified CCMP service connects to the
portal database using the Windows account under which the service is running (by default, all
Unified CCMP services run under the Network Service account).

e SQL Authentication: Only select this option if you are using a Database Server on a different
domain. For this option you must enter the SQL Server user name and password in the fields
provided.

O Click Next. If you selected SQL Authentication and the specified account does not yet exist, you are
prompted to create it.

The Deployment Summary page summarizes the choices you have made. Check the deployment details,
and if you are satisfied, click Next.

A confirmation message is displayed to indicate that the wizard has completed successfully. Click Exit to
close the wizard.

To save and action your changes, either click the Save icon in the tool bar or select File > Save from the
menu.
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Resetting System Administrator Password

You can use ICE to reset the system administrator password.

To reset the password:
1. In the ICE Cluster Configuration tool, select the Setup tab and click Reset The Administrator Password.
2. Enter the New password and Confirm Password and click Next.

3. A confirmation message is displayed to indicate that the password was set successfully. Click Exit to close
the wizard.

Configure Cisco Unified CCE Servers

About the Configure Cisco Unified CCE Servers Wizard

The Configure Cisco Unified CCE Servers wizard configures Cisco Unified CCE instances. This wizard guides
you through the steps to:

» Add a new Cisco Unified CCE instance to the deployment
» Update an existing Cisco Unified CCE instance in the deployment
» Remove an existing Cisco Unified CCE instance from the deployment.

After making any changes to Unified CCE, you need to reconfigure Unified CCE using the Configure Cisco
Unified CCE Servers Wizard.

About Unified CCE Deployment Models

Unified CCE offers a number of different deployment models depending on customers’ requirements. Unified
CCMP supports the following Unified CCE deployment:

» Administration Server and Real-time Data Server (AW)

» Administration Server Real-time and Historical Data Server (AW-HDS)

About Unified CCMP Connection Requirements
Unified CCMP requires a connection to:
» Unified CCE active AWDB for data import
» Unified CCE AW for Unified CCMP Provisioning Server requests.

Configuring Cisco Unified CCE Servers

This wizard configures the Unified CCE servers using an SQL Connection. You need to know the connection
credentials to complete the configuration.

You need to know the login details for a user with appropriate access to the Unified CCE used for provisioning.
On the domain controller, this user must be in the domain security group <Server>_<UCCE-
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Instance>_Config, where <Server> is the name of the server running Unified CCE and <UCCE-
Instance> is the name of the Unified CCE Instance on this server.

To configure the Cisco Unified CCE servers:

1.

In the ICE Cluster Configuration tool, select the Setup tab and click Configure Cisco Unified CCE
Servers to start the wizard. Click Next to go through each page in turn.

On the Select Task page, select the action. The options are:
O Add a new instance
O Modify an existing instance

O Remove an existing instance

Note: The Modify and Remove options are only enabled when at least one Cisco Unified CCE has
@'ﬁ already been configured.

On the Specify Resource Name page, specify the name for the instance being configured.

On the Configure Redundancy page, select whether you want to configure a single-sided or a dual-sided
Unified CCE.

On the Configure AW Server page, enter the following:
O Primary Server:

e Server Name: This is the non-domain qualified machine name where the Admin Workstation and
ConAPI components are deployed.

e Server Address: This defaults to Server Name. This may be changed to an IP Address or a
domain qualified name of the server.

e Port: Provide database server SQL non-default Port. By default the value is set as 1433. This field
has been introduced in CCMP 15 ES202603.

O Secondary Server: If you chose a dual-sided Unified CCE, provide the corresponding server details for
the Side B server.

On the Configure Connection Details page, enter the authentication details to connect to the Admin
Workstation database.

o  Windows Authentication: This is the default authentication mode.

O  SQL Authentication: If this mode is chosen then specify the SQL Server user name and the
corresponding password to connect to the databases.

On the Select Unified CCE Instance page, select the AW instance to be used in the deployment. Click
Next.

On the Select Required Components page, select all the required components in the deployment.
O Admin Workstation: This option is disabled and selected by default.

O Provisioning Components (ConAPI/Unified Config): Select this component if you require resource
management.

On the Configure Primary Unified Config Web Service page, (only shown if the Unified CCE instance is
running Unified CCE version 10.5 or later and only shown if you selected the Provisioning Components
(ConAPI/Unified Config) option above), enter the following details:

o URL: This is the auto-generated URL of the primary unified config web service on the Unified CCE.
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10.

11.

12.

13.

14.

15.

16.

17.

O User Name: This is a user name with appropriate access to the Unified CCE that the web service is
running on. This user must be in the domain security group <Server>_<UCCE-Instance>_Config,
where <Server> is the name of the server running Unified CCE and <UCCE-Instance> is the name of
the Unified CCE Instance on this server. Enter the user name as <user>@<domain>, where <user> is
the Unified CCE user name, and <domain> is the name of the domain.

o Password: This is the password for the user.

0 Command Timeout (seconds): Set the command timeout for the server. It is set to 120 seconds by
default.

@ Note: If the user permissions are changed then you need to start “Apache Tomcat” service on UCCE.
o

On the Configure Primary ConAPI RMI Ports page, (only shown if you selected the Provisioning
Components (ConAPI/Unified Config) option above) enter the following ConAPI details:

e Local Registry Port: This is the port on the Unified CCE for the Unified CCMP Provisioning
service to connect to. This is usually 2099.

e Remote Registry Port: This is the port on the Unified CCMP Database Server for the Unified
CCE to connect to. This is usually 2099.

e Local Port: This is selected as the designated port for live provisioning traffic between the Unified
CCE and Unified CCMP servers. It must be uniquely assigned for each Unified CCE and any
firewalls between Unified CCE (or specific server, for example, AW) and Unified CCMP server
must be configured to allow both-way traffic on this port.

@ Note: If dual-sided UCCE is being configured, you need to provide these details for the Secondary (Side
¥/ B) server in the next page.

On the Configure ConAPI Application Instance page (only shown if you selected the Provisioning
Components (ConAPI/Unified Config) option above), enter the following details:

O Application Name: The name of the application to be used for provisioning Unified CCE from Unified
CCMP. Specify the name of the application you configured in “Setting Up ConAPI” on page 74.

O Application Key: Use the password for the application you specified above.

On the Multi Media Support page, select Yes to provide support for non-voice interactions. The default
value is No.

On the Purge On Delete page, select Yes if you want to purge items from Unified CCE automatically when
they are deleted from Unified CCMP. The default is Yes.

On the Configure Active Directory Global Catalog Connections page, provide the details of active
directory global catalog and configure the security settings to connect.
On the Configure Linked Unified CM Servers page, select the Unified Communications Manager servers

that the Unified CCE being configured is capable of routing calls to.

The Summary page summarizes the details of the Unified CCE being configured and the settings you have
chosen. Check the details, and if you are satisfied, click Next.

A confirmation message is displayed to indicate that the wizard has completed successfully. Click Exit to
close the wizard.
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18. To save and action your changes, either click the Save icon in the tool bar or select File > Save from the
menu.

Important notes about configuring Unified CCE servers:

If dual-sided setup is being configured, you need to provide these details for the Secondary (Side B) server in the
next page.

The CMS server on each side of the Unified CCE instance requires there be a node for each side of the Unified
CCMP system. That is:

» Side A of Unified CCE needs two nodes for Unified CCMP, Side A and Side B with the same
Administration & Data Server RMI registry port and Application RMI registry port for both nodes.

» Side B of Unified CCE needs two nodes for Unified CCMP, Side A and Side B with the same
Administration & Data Server RMI registry port and Application RMI registry port for both nodes but must
be different to the Side A Unified CCE configured ports.

For example:

Servers:

» Unified CCMP Side A: UCCMPDBA

» Unified CCMP Side B: UCCMPDBB

» Unified CCE Instance Side A: ICMSIDEA

» Unified CCE Instance Side B: ICMSIDEB

On ICMSIDEA the following CMS nodes are created:

1. Administration & Data Server Link: UCCMPDBAServer
Administration & Data Server RMI Registry Port: 2099
Application Link: UCCMPDBAClient

Application RMI registry port: 2099
Application host name: UCCMPDBA

o O 0O O

2. Administration & Data Server Link: UCCMPDBBServer
O Administration & Data Server RMI Registry Port: 2099
O  Application Link: UCCMPDBBClient
O Application RMI registry port: 2099
O  Application host name: UCCMPDBB
On ICMSIDE_B the following CMS nodes are created:
1. Administration & Data Server Link: UCCMPDBAServer
O Administration & Data Server RMI Registry Port: 2098
O  Application Link: UCCMPDBAClient
O Application RMI registry port: 2098
O  Application host name: UCCMPDBA
2. Administration & Data Server Link: UCCMPDBBServer
O Administration & Data Server RMI Registry Port: 2098
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O Application Link: UCCMPDBBClient
O Application RMI registry port: 2098
O  Application host name: UCCMPDBB

Configuring Cisco Unified Communications Manager Servers

The Configure Cisco Unified Communications Manager Servers wizard configures Cisco Unified
Communications Manager instances. This wizard guides you through the steps to:

4

4

4

Add a new Cisco Unified Communications Manager instance to the deployment
Update an existing Cisco Unified Communications Manager instance in the deployment

Remove an existing Cisco Unified Communications Manager instance from the deployment.

To configure the Cisco Unified Communications Manager servers:

1.

In the ICE Cluster Configuration tool, select the Setup tab and click Configure Cisco Unified CM
Servers to start the wizard. Click Next to go through each page in turn.

On the Select Task page, select the action. The options are:
O Add a new instance
O Modify an existing instance

O Remove an existing instance

Note: The Modify and Remove options are only enabled when at least one Cisco Unified
¥/ Communications Manager has already been configured.

On the Specify Resource Name page, specify a name for the instance being configured.

On the Configure Unified Communications Manager Servers page, enter the following:
O Primary Server:

e Sever Name: This is the non-domain qualified machine name where the Cisco Unified
Communications Manager components are deployed.

e Server Address: This defaults to Server Name. This can be changed to an IP Address or a domain
qualified name of the server.

@ Note: When configuring a Unified Communications Manager Cluster ensure that only the publisher of
%/ the cluster is configured.

O  Secondary Server: This option is always disabled.

On the Select Version page, select the version of Unified Communications Manager being configured from
the dropdown list.

On the Connection Details page, enter the following details:

O URL: This is used to access the Unified Communications Manager AXL interface. The default is the
default URL for the Unified Communications Manager version that has been selected.
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O User Name: This is the name of the Unified Communications Manager Administrator user. This is the
user name that the Unified CCMP components use when connecting to the Unified Communications
Manager AXL web service.

O Password: This is the password of the Unified Communications Manager administrator.

0 Command Timeout (seconds): Set the command timeout for the server. It is set to 120 seconds by
default.

7. On the Configure Linked Unified CCE Servers page, select the configured Cisco Unified CCE servers that
can route calls to the Unified Communications Manager being configured.

Note: The Configure Linked Unified CCE Servers page only appears if at least one Unified CCE server

¥/ has been configured. You can also link the Unified Communications Manager server to Unified CCEs from
the Cisco Unified CCE Configuration Wizard, or modify the Unified Communications Manager configuration
later to link to the Unified CCE servers.

8. The Summary page summarizes the details of the Unified Communications Manager being configured and
the settings you have chosen. Check the details, and if you are satisfied, click Next.

9. A confirmation message is displayed to indicate that the wizard has completed successfully. Click Exit to
close the wizard.

10. To save and action your changes, either click the Save icon in the tool bar or select File > Save from the
menu.

Configure Cisco Unified CVP Servers

This task is optional. It is only required if you are planning to use Media File Management.

About the Configure Cisco Unified CVP Servers Wizard

The Configure Cisco Unified CVP Servers wizard configures Cisco Unified CVP server clusters. A Cisco
Unified CVP server cluster consists of a Unified CVP Operations Console, and, optionally, one or more call
Servers.

This wizard guides you through the steps to:
» Add a new Cisco Unified CVP cluster instance to the deployment
» Update an existing Cisco Unified CVP cluster instance in the deployment

» Remove an existing Cisco Unified CVP cluster instance from the deployment

Configuring Cisco Unified CVP Servers

To configure a Cisco Unified CVP server cluster:

1. In the ICE Cluster Configuration tool, select the Setup tab and click Configure Cisco Unified CVP
Servers to start the wizard. Click Next to go through each page in turn.

2. On the Select Task page, select the action. The options are:
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O Add a new instance
O Modify an existing instance

O Remove an existing instance

The Modify and Remove options are only enabled when at least one Cisco Unified CVP cluster instance has
already been configured.

3. On the Specify Unified CVP Operations Console Resource Name page, specify a name for the Unified
CVP operations console.

4.  On the Select Version page, specify the version of Unified CVP that is running on the CVP cluster you are
configuring.

5. On the Configure Unified CVP Operations Console page, enter the following:
o Primary Server:

e Sever Name: This is the non-domain qualified machine name where the Cisco Unified CVP
Operations Console is deployed.

e Server Address: This defaults to Server Name. You can change this to an IP Address or a domain
qualified name of the server.

O  Secondary Server: This option is always disabled.

6. On the Configure Primary Unified Config Web Service page (only shown when the selected Unified CVP
version is 10.0 or later), enter the following details:

o URL: This is the auto-generated URL of the primary unified config web service on the Unified CVP
cluster.

e User Name: This is a user name with appropriate access to the Unified CVP that the web service
is running on.

e Password: This is the password for the user.

e Command Timeout (seconds): Set the command timeout for the server. It is set to 120 seconds by
default.

7.  On the Select Number of Call Servers page, specify the number of CVP call servers in the CVP cluster.

@ Note: All CVP call servers must be on the same Unified CCE as the Unified CVP operations console.
[

8. If you specified at least one call server:
a. On the Specify Unified CVP Call Server 1 Resource Name page, enter a name for the call server.

b. On the Configure Unified CVP Call Server 1 page, enter the following:
e Primary Server:

o Sever Name: This is the non-domain qualified machine name of the Cisco Unified CVP call
server.

o Server Address: This defaults to Server Name. You can change this to an IP Address or a
domain qualified name of the server.

e Secondary Server: This option is always disabled.

9. [If you specified more than one call server, repeat Step 8 to provide the details for each of the remaining call
servers.
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10. On the Configure Unified CCE Server page, select the Unified CCE server that is linked to the Unified
CVP Instance being configured. This is an optional step.

11. The Summary page summarizes the details of the Unified CVP cluster being configured and the settings
you have chosen. Check the details, and if you are satisfied, click Next.

12. A confirmation message is displayed to indicate that the wizard has completed successfully. Click Exit to
close the wizard.

13. To save and action your changes, either click the Save button in the toolbar or select File > Save from the
menu.

Creating and Mapping Tenants

About Creating and Mapping Tenants

The Equipment Mapping tab of the ICE Cluster Configuration tool enables you to create new tenants and folders
and map them to the contact center equipment you have just configured. Use this tool to:

» Create the Unified CCMP folder structure for your deployment.

» Specify the rules for importing resources into your Unified CCMP folder structure from the contact center
equipment (for example, Unified CCE, Unified Communications Manager).

Creating Tenants

7 Note: Once a tenant is created, it cannot be deleted.
<.<l )

To create a Unified CCMP tenant:

1. In the ICE Cluster Configuration tool, select the Equipment Mapping tab. In the center pane, right-click
the root node and select Add Tenant.

2. In the Name field enter the name of the tenant, and optionally, in the Description field, enter a description.

3. Select File > Save to save your changes. If you exit the tool without saving your changes you are prompted
to save your changes when you exit the tool.

Creating Folders

To create a Unified CCMP folder:

1. In the ICE Cluster Configuration tool, select the Equipment Mapping tab. In the center pane, right-click
on the folder tree at the location where you want to add the folder and select Add Folder.

2. In the Name field enter the name of the folder, and optionally, in the Description field, enter a description.

3. Select File > Save to save your changes. If you exit the tool without saving your changes you are prompted
to save your changes when you exit the tool.
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Creating an Equipment Mapping

To create a mapping between a tenant or folder and the contact center:

1. In the ICE Cluster Configuration tool, select the Equipment Mapping tab. In the folder tree, select the
tenant or folder where you want to place the resources you import from the contact center equipment.

2. In the adjoining pane select the check box next to each item of contact center equipment you want to
associate with the selected folder or tenant.

3. Highlight each selected item in turn, and in the right-hand pane, select one of the following:

O  Default Import Location: All resources from the highlighted contact center equipment are imported
into the selected tenant in Unified CCMP. You may see a warning if you select this option. If the
selection was intentional, you can ignore the warning.

O  Customer Resource Mapping: Allows more control over the import process. You can specify the
items on the highlighted contact center equipment to be placed in the selected folder or tenant in
Unified CCMP.

4. If you select the Customer Resource Mapping option, complete the following information:

a. Click Add to add a new customer resource mapping that defines the resource types and the specific
resources of that type to be mapped to the selected import location.

b. In the Customer Resource Mapping dialog box, select the resource type from the Type dropdown list.
e  Peripheral
e Routing Client
e Media Routing Domain

e Remote Tenant
Select the specific item of that type that you want to map from the Resource dropdown list.

c. If you select the Remote Tenant option, you can optionally specify one of the following to use for the
tenant mapping:

e Active directory settings: Enables you to associate a specific active directory with a tenant or
folder.

e Small contact center settings: Enables you to configure a tenant or folder as a small contact
center, create a department, and define department-level mappings.

d. If you want to specify active directory settings, select the Active Directory Configuration tab, and
select Configure Active Directory Settings. Specify the Global Catalog Domain or Server and the
authentication modes required, then click Next. Browse to the Active Directory folder you want to use,
select it, and click Update.

Note: The Active Directory settings for the remote tenant are updated immediately and are retained
@'ﬁ even if you later exit ICE without saving your changes.
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e. If you want to configure a small contact center, select the Small Contact Center Settings tab and
select Enable Small Contact Center. Enter the name of the department you want to create and click
Create Department. The department is created and provisioned, and any resources from the remote
tenant that are associated with this department are imported into the selected folder or tenant.

Note: The specified department is provisioned and created immediately, and is retained even if you later
@ exit ICE without saving your changes. You cannot subsequently edit this department in ICE.
Once a folder has been mapped as a small contact center folder, no other item mappings are allowed for
this folder or any subfolders.

f.  When you have defined the customer resource mapping, click OK. Repeat these steps to add additional
customer resource mappings if required.

If you want to use the customer resource mapping option, you cannot be able to configure this until you
have imported the customer resources you want to use to define the mappings.

In this case, for the first import, do not select the Default Import Location option, as once you have
selected this, the items from the remote equipment are imported to that location and cannot be re-
imported. Instead, for the first import, do not specify any import location, so everything is imported into
the /Unallocated folder. Once the customer resources have been imported, you can specify the customer
resource mapping you require, and the items in the /Unallocated folder are moved to the required
locations.

Note: If Customer Resource Mapping is selected then any resources on the contact center equipment
¥/ that are not associated with the selected mapping are placed in the source equipment subfolder under
the Unallocated folder.

5. When you have finished defining the equipment mappings, click File > Save to save your changes. If you
exit the tool without saving your changes you are prompted to save your changes.

Configuring Active Directory Federation Services
(ADFS)

About ADFS

By default, Unified CCMP users need to log in to Unified CCMP every time they connect. Unified CCMP can
optionally be configured to use ADFS, which links each Unified CCMP user account to their ADFS user account
and enables users to connect to Unified CCMP without logging in.

This section provides information on how to configure the ADFS application. To use ADFS to login to Unified
CCMP, it is necessary to map it to the Identity Server within Unified CCMP.
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Configuring ADFS Per Identity Server

Adding the Unified CCMP Identity Server to ADFS

To manually add the Unified CCMP identity server to ADFS:

1.  Open ADFS Management.

Open Trust Relationships and Relying Party Trusts.

Select Add Relying Party Trust... The Add Relying Party Trust Wizard opens. Click Start.

Select Enter data about the relying party manually, then click Next.

Enter an appropriate display name, for example Unified CCMP Identity Server, then click Next.
Select ADFS profile, then click Next.

Click Next, as Unified CCMP does not support optional token encryption certificates.

® N R RN

Select Enable support for the WS-Federation Passive protocol, and enter the full URL to the identity
server ADFSendpoint. The endpoint must be in the correct format. Endpoint should be:
https://fqdn/identity/adfs/logout

7 Note: The URL must use an SSL certificate that ADFS trusts, and must be in the correct format. For
@1 example, https://fqdn/Identity/adfs.

9. Under Relying party trust identifier, enter the full URL to the identity server. The URL must be in the
correct format. For example, https://fqdn/Identity. Click Add, then Next.

10. Select I do not want to configure multi-factor authentication settings for this relying party trust at this
time, and click Next.

11. Select Permit all user to access this relying trust party, and click Next.

12. Review the settings. You can go back and change any settings, or if you are happy with the current settings,
click Next to add the relying party trust to the ADFS configuration database.

13. Select Open the Edit Claim Rules dialog for this relying party trust when the wizard closes if you want
to edit claim rules immediately.

14. Click Close to exit the wizard.

Configure ADFS with PowerShell scripts

There are PowerShell scripts available for configuring ADFS. You can access the scripts from the Unified
CCMP ISO, by opening the SSO folder, and then the PShellScripts folder.

You can run the following scripts:

» AddIdentityServerToAdfs.ps1 to configure ADFS per identity server

» AddTenantToldentityServer.psl to map tenants to ADFS

» AddDNToActiveDirectoryAcceptanceClaims.psl1 to configure ADFS as a one time setup.

For more information, open the Read.me file available in the PShellScripts folder.
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Once you have configured ADFS, you must restart the Unified CCMP server for the changes to come into effect.

Editing Claim Rules for Unified CCMP

To edit the claim rules for Unified CCMP:

1. Open Trust Relationships and Relying Party Trusts.

Select the Unified CCMP trust, and click Edit Claim Rules... to open the Edit Claim Rules dialog.

2
3. Select the Issuance Transform Rules tab.
4

For each of the below Claim Rules, click Add Rule, select Send LDAP Attributes as Claims and

complete the Add Transform Claim Wizard.

7 Note: You should use a System Identification Number (SID) as NamelD, as it is necessary for the

¥/ NamelD to be unique to each user.

Claim Rule Name Mandatory Store LDAP Attribute Outgoing Claim Type
AD: SID as NamelD Yes Active Directory objectSid (type directly) Name ID

AD: UPN as Name Yes Active Directory User-Principal-Name Name

AD: GivenName No Active Directory Given-Name Given-Name

AD: Surname No Active Directory Surname Surname

AD: Email No Active Directory E-Mail-Addresses E-Mail-Addresses

5. Once the claims have been setup, click Finish to close the dialog.

6. Alternatively, if you wish to support automatic user provisioning:

a. Click Add Rule to add a new claim.

b. Select Send Group Membership as a Claim as the claim rule template, and click Next.

c. Enter the following additional claim rules.

Claim Rule Name User's Group

Outgoing Claim Type

Outgoing Claim Value

AD: Role = Supervisor

AD: Role = Advanced

<windows group> Role

<windows group> Role

Supervisor

Advanced

7. Once the additional claims have been setup, click OK to close the dialog.

Configuring ADFS as a One-Time Setup

A one time setup configuration of ADFS is only required if you want to support automatic user provisioning. As
a one time step (not per identity server), you need to add a custom rule to allow Unified CCMP to map tenants

to ADFS.
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Configuring ADFS

To configure ADFS as a one-time setup:
1. Open ADFS Management.

2. Select Trust Relationships > Claims Provider Trusts.

et

Select Active Directory and Edit Claim Rules. The Edit Claim Rules for Active Directory dialog box
opens.

Click Add Rule....
Select the Send LDAP Attributes as Claims claim rule template. Click Next.
Type in Pass-thru DN as the Claim Rule name.

Select Active Directory as the Attribute Store.

® N s

Map the following:

O LDAP Attribute: distinguishedname

O  Ongoing Claim Type: http://temp.org/claims/DistinguishedName
Select or type to add more.

9. Click Finish to save the claim rule for Active Directory.

Once you have set up ADFS to support automatic provisioning, you can map tenants to ADFS.

7\ Important: Once you have configured ADFS, you must restart the Unified CCMP server for the
»? changes to come into effect.

Mapping Tenants to ADFS

It is only required to map tenants to ADFS if you want to support automatic user provisioning.

To map tenants to ADFS:
1. Select the Unified CCMP trust, and click Edit Claim Rules... to open the Edit Claim Rules dialog.
2. Select the Issuance Transform Rules tab.
3. To add claims, click Add. The Add Transform Claim Rule Wizard opens.
4. Select Send Claims Using a Custom Rule as the claim rule template, and click Next.
5. Enter the claim rule name in the format: AD: Tenant(<TenantPath>)
6. Enter Custom rule text in the format, with the values you want to use:
c:L[Type == "http://temp.org/claims/DistinguishedName", Value =" "A.x()$"]

=> issue(Type = "http://egain.net/claims/identity/tenant", Value = "/");
7. Click Apply.

8. Click Finish to close the dialog.
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Configuring Windows Login

About Windows Login

By default, Unified CCMP users need to log in to Unified CCMP every time they connect. Unified CCMP can
optionally be configured to use Windows, which links each Unified CCMP user account to their Windows user
account and enables users to connect to Unified CCMP without logging in.

Setting Up Administrator Account

To set up an administrator account:

1.

2
3.
4

® N

Login to Unified CCMP as administrator.
Click the Hamburger icon and click on Security and then select User.
Click New.

Enter the following details to create a user account to be the new administrator account:

O The login name must correspond to an existing Windows Active Directory user, and must be formatted
as <domain-name>\<username>, where <username> is the Windows username and <domain-
name> is the NetBIOS domain name. The login name must exactly match the details in the
corresponding Active Directory entry.

O Deselect the Local Login Enabled checkbox.

Click on the newly created user and open the Groups tab.
Click Add to Group.

Select the checkbox for the Administrators group.

Close and save.

Configuring Windows Authentication

To configure Windows authentication on the database server:

1.

Launch Integrated Configuration Environment (installed as part of Unified CCMP). In the Database
Connection dialog box, set:

O  Server Name: Enter the name of the primary database server.

O Database Name: Enter the name of the Unified CCMP database that was installed when setting up the
Database Component. If you accepted the default value, this is Portal.

O Authentication: Select any authentication configured on the database.

Click OK. The ICE Cluster Configuration tool starts by default.

In the Tools dropdown, select System Properties. The System Properties tool is displayed. In Enabled
Login Types, make sure that the Windows option is selected. It is required to setup the Windows
authentication mode.
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4. Click Save to save the configuration change, then Exit.

5. On the App/Web Server, go to the location where Unified CCMP was installed (usually C:\Program
Files\Management Portal, right-click the Web folder and select Properties.

6. Select the Security tab, and ensure that all domain users have Read and Read & Execute permissions on
this folder.

7. Click Advanced and ensure that all the domain users have the parent folder path in the Inherited from
column.

If this is not set, or it is set to NONE, then click Change Permissions, select the user, and click the Replace
all child objects permissions entries with inheritable permission entries from the object check box to
grant explicit permission, and click OK.

8. Click Yes on the confirm window message.
9. Click OK to close the properties dialog.

10. From a command window, execute the iisreset command.

Note: The next step is only required if you have multiple additional web URLs configured to access your
*—/ Unified CCMP system.

11. Log in to the domain controller as a user with administrator access to the domain. Enter the following
command on the command line, where <custom-address> is the custom address in the additional web
URL and <Unified CCMP-webserver-name> is the name of your Unified CCMP App/Web Server. If
you have a load-balanced system, <Unified CCMP-webservername> must be the name of the load-
balanced node, not the name of any of the individual servers.

setspn -a http/<custom-address> <Unified CCMP-webserver-name>

For example, if your web URL for the Unified CCMP web application is https://mycompany/portal
and the name of your Unified CCMP App/Web Server is Unified CCMPWeb1, you would enter

setspn -a http/mycompany Unified CCMPWebfqgdn
12. Reboot the Unified CCMP App/Web Server or servers.

You have now configured Windows and users are able to access Unified CCMP directly from their domain
account without needing to login again.

13. Depending on the way that Active Directory is configured in your installation, you may also need to change
additional properties in the Login Authentication Configuration group in ICE System Properties. The
default settings are sufficient for most installations, but in some cases, you may need to change one or both
of Active Directory Binding Options and Active Directory Context Type properties too.

For more information about the Active Directory Binding Options and Active Directory Context Type
properties, see the Administration Guide for Cisco Unified Contact Center Management Portal. For
information about the values to choose for your Active Directory configuration, consult your Windows
system administrator.

70 Installation and Configuration Guide for Cisco Unified Contact Center Management Portal



Managing Users with Windows

Login names for new users should be in the <domain-name>\<username> format, for example,
user1@testdomain.local.

8: Note: Unified CCMP Users located on an external domain from the Unified CCMP hosting domain require
®—/ a trust relationship to be configured between the hosting and external domain.

For more information about creating Unified CCMP user accounts, see the User Guide for Cisco Unified Contact
Center Management Portal.

Configuring Entra ID Login

About Entra ID Login

By default, Unified CCMP users must log in to Unified CCMP every time they connect. Unified CCMP can
optionally be configured to use Microsoft Entra ID, which links each Unified CCMP user account to its
corresponding Entra ID account and enables users to connect to Unified CCMP without logging in.

Register the Application in Entra ID (Azure Portal)

To register the app in Entra ID:
1. Log in to the Azure portal with a Global Administrator account.
2. Navigate to Microsoft Entra ID > App registrations > New Registration.
3. Enter the following details:
O Name: Application name for Entra ID.
O Supported account types: Accounts in any organizational directory (Multitenant).
O Redirect URI (Web): https: //<:)/:tem_wé>/ Identity/aad. This URL is case sensitive.
4. After registration, note the following values from the Overview page:
o Application (client) ID
o Directory (tenant) ID
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5. Browse to Manage > Manifest, and locate "appRoles": L[], and replace it with the required roles
(Advanced , Supervisors), using the following code:

"appRoles": [
{
"allowadMemberTypes™: [
"User™
]1
"description”: "Advanced Users",
"displayName"”: "Advanced Users”,

"id": "c28el145e-5450-436C-a874-b%42bbd4cfel”,
"isEnabled": true,

"origin": "Application”,
"wvalue™: "aAdvanced"”
T
{
"allowedMemberTypes”: [
"User™
1
"description”: "Supervisor Users”,
"displayName”: "Supervisors”,
"id": "1b4f816e-5eaf-48b9-8613-7923838595ad",
"isEnabled": true,
"origin": "Application”,
"value™: “Supervisor”
}

6. Save changes.
7. Navigate to Manage > Authentication (Preview).

8. In the Settings tab, under Web and SPA settings, select the checkbox next to the ID tokens (used for
implicit and hybrid flows) option.

9. Click Save.

Configuring Entra ID Authentication

To configure Entra ID authentication on the database server:

1. Launch Integrated Configuration Environment (ICE), installed with Unified CCMP. In the Database
Connection dialog box, configure the following:

O Server Name: Enter the primary database server name.
O Database Name: Enter the Unified CCMP database name (default: Portal).

O  Authentication: Select the configured database authentication type.
2. Click OK. The ICE Cluster Configuration tool starts automatically.

3. From the Tools dropdown, select System Properties.
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In Enabled Login Types, ensure that the Entra ID is selected as it is required to set up the Entra ID
authenticarion mode.

In Entra ID Client Id, paste the Application (client) ID noted earlier.
Set Ext Auto Create User to true if you want to enable automatic user provisioning.

Click Save to apply changes.

Configure Entra ID on Tenant Folder

To configure Entra ID on tenant folder:

1.

2
3
4.
5

From the Tools dropdown, open Cluster Configuration and select Equipment Mapping in the sidebar.
Select the Tenant you want to configure, right-click, and choose Properties.

In External Tenant Id, enter the Directory (tenant) ID noted earlier.

Alternatively, log in to the Azure portal and copy the value.

Restart Application Services and reset IIS for the changes to take effect.

Configuring Unified CCE Admin Workstations

Note: If Windows Authentication is used, then the service account needs appropriate permissions. If
®—/ SQL Server Authentication is used, then SQL Server account needs appropriate permissions.

If SQL Server Authentication is not in use for Admin Workstation (AW) SQL connections, then the following
configuration is required.

To configure Unified CCE Admin workstations:

1.

2
3
4,
5

Login to the AW as a user with local administrative privileges.

Launch SQL Server Management Studio. Connect to the server.

Open up the Security folder and right-click Logins.

Select New Login from the dropdown list. The Login — New window displays.

Add SQL logins for the Network Service accounts of each server hosting Unified CCMP (Database Servers
and App/Web Servers), by filling in the fields as follows:

O  General page:

e Login Name: Enter the machine name in the form <DOMAIN>\<MACHINENAME>$, for example
ACMEDOM\ACMESERVERAS. This configures access for the NETWORK SERVICE account from
the Unified CCMP server.

e Authentication: Select Windows Authentication unless connecting to a server on a different
domain.
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o  User Mapping page:
e Users mapped to this login: Select AWDB and HDSDB.
e Database role membership for: For AWDB and HDSDB, select Public and db_datareader.

6. Click OK.

Configuring Unified CCE Provisioning

About Provisioning Configuration

Cisco Unified Contact Center Enterprise (Unified CCE) components must be correctly configured before Unified
CCMP can connect to them for Provisioning.

For each Unified CCE instance that Unified CCMP Resource Management connects to, certain essential criteria
must be met:

» Unified CCMP Resource Management uses Cisco ConAPI for the Provisioning connections: this interface
requires that all connections are made to a Primary Distributor AW. If the AW is dual-sided, both sides must
be Primary Distributors.

» Multiple Unified CCE instances can be supported, but each requires a distinct primary Distributor AW to
connect to. ConAPI only supports connection to one Application Instance on each physical server. You must
therefore have a separate physical AW distributor for each instance.

Note: Please contact your vendor support if you have any queries about this configuration.
{ o >

» If your deployment includes resource management, you must set up the ConAPI application instance and the
CMS server on your Unified Communications Manager and Unified CCE instances.

Setting Up ConAPI

You must run the Configuration Manager on the Unified CCE Admin Workstation (AW) to set up ConAPL

To set up the ConAPI application instance:

1. Open the Configuration Manager. This can normally be done from Start > Program Files > Cisco Unified
CCE Tools > Administration Tools > Configuration Manager.

7 Note: If you are connecting to the Unified CCE server using Remote Desktop, you will need to set the
¥/ /admin switch in order to run Unified Communications Manager.

2. Under Tools > List Tools, double-click the Application Instance List option.

3. Click Retrieve to display the list of configured application instances. You can use an application instance
from this list for Unified CCMP or create a new one. To create a new application instance, click Add, and
enter the following details:
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O Name: A unique name to be used for the application instance.

O  Application Key: A password to be used by Unified CCMP to connect. This may be between 1 and 32
characters.

O  Confirm Application Key: Ensure that no typographical errors were made while choosing the
application key.

O Application Type: Select Cisco Voice.

O  Permission Level: Give the application full read and write permissions.

O Description: Provide application instance description. This is optional field.
Record these details for use during the configuration of the cluster.

Click Save and then click Close.

Setting Up the CMS Server

Checking CMS Server Set Up

Ensure that the CMS Servers are set up correctly on each Unified CCE.

To check CMS server setup:

1.

Firstly, check that the CMS Node option was selected when the Admin Workstation was configured. You
can determine if this was the case by looking for a cmsnode and a cms_jserver process running on the
Unified CCE.

If these processes are not present, set the CMS Node option on the Unified CCE. See the Cisco Unified
Contact Center Enterprise Installation and Upgrade Guide for details on how to do this.

Adding New Application Connection

You must define a new application connection on each configured Unified CCE instance for each Database
Server (this connection is used by the Data Import Server component). This ensures that in a dual-sided
system, the alternate side can also connect to the Unified CCE in a failover scenario.

To add new application connection:

1.
2.

On the Unified CCE being configured, launch CMS Control. This opens the CMS control console.

Click Add to launch the Application connection details window and fill in the fields as follows:

O  Administration & Data Server Link: The name of the Unified CCMP Database Server, in capital
letters, with Server appended. For example, if your Database Server is PRODUCTDB, enter
PRODUCTDBServer.

O  Administration & Data Server RMI registry port: Refer to the firewall port table for the relevant
port numbers.

O  Application link: The name of the Unified CCMP Database Server, in capital letters, with Client
appended. For example, if your Database Server is PRODUCTDB, enter PRODUCTDBCLlient.

Unified CCMP Configuration 75



O  Application RMI registry port: The port on the Unified CCMP Database Server for the Unified CCE
AW to connect to. Each Unified CCE AW must connect to a different port on the Database Server. You
should record this information for future use.

O Application host name: The name of the Unified CCMP Database Server, in capital letters, for
example, PRODUCTDB.

3. (Click OK, and OK again to cycle the CMSJServer, save your changes and close the CMS Control console.
For the list of ports, refer to “Unified CCMP Database Server Port Usage” on page 28

Configuring Replication

About Replication

About the Replication Manager

In a dual-sided deployment, use the ICE Replication Manager to configure and monitor database replication
between publisher and subscriber databases. The publisher is usually on Side A, but it may occasionally be
necessary to configure Side B as the publisher.

The Replication manager has two modes, setup and monitor. Setup is used to configure or disable replication
and monitor is used to monitor the status of a configured replication.

When your system is first installed you should:
» Configure replication as described in “Configuring Replication” on page 77.
» Monitor replication as described in “Monitoring the Replication Snapshot” on page 79.

For more information about using the ICE Replication Manager to manage replication at a later date, see the
Integrated Configuration Environment (ICE) Guide for Cisco Unified Contact Center Management Portal.

About the Snapshot Process

When replication is configured, the existing data from the publisher database is pushed to the subscriber
database. This is referred to as the snapshot process.

The snapshot process takes a variable time depending on the amount of data contained in the publisher database.
For new deployments where the import from Unified CCE or Unified Communications Manager has not yet
been performed, this is likely to be a few minutes. On large deployments where Unified CCE or Unified
Communications Manager resources have already been imported to the publisher database this could take a lot
longer.

@ Note: The subscriber database cannot be used until the snapshot process has completed.
o

76 Installation and Configuration Guide for Cisco Unified Contact Center Management Portal



About Replication Publications

When replication is configured the following publications are set up (assuming you have used the default
database name of Portal):

4

»

»

4

[Portal]: BasePubWin

[Portal]: BaseSubWin

[Portal]: NonQueued

Identity Database — “[IdSvr3Config] : IDMerge”

Each of these publications contains a series of tables which are replicated between the publisher and subscriber
as part of the snapshot process. [Portal]: BaseSubWin is the largest publication and takes the longest for the
snapshot process to complete. Each of the publications migrates through the following steps during the snapshot

process:

»

4

4

4

4

Pre preparation

Sch schema

Data copy

Dri referential integrity

Post Snapshot Commands

You can monitor the progress of the snapshot process using the Monitor tab which is automatically shown after
the replication configuration has completed.

Configuring Replication

Note: The user running Replication Manager must have administrator permissions in both Windows and
¥/ SQL Server, for both the publisher and subscriber Database Servers.

Before configuring replication you should have already configured Unified CCMP in dual-sided mode using the
Cluster Configuration tool as described in “Configuring Replication” on page 76.

To configure replication on the Database Server that will be the publisher:

1.

Launch Integrated Configuration Environment (installed as part of Unified CCMP). In the Database
Connection dialog box, set:

O Server Name: Enter the name of the primary database server.

O Database Name: Enter the name of the Unified CCMP database that was installed when setting up the
Database Component. If you accepted the default value, this is Portal.

O Authentication: Select Windows Authentication.
Click OK. The ICE Cluster Configuration tool starts by default.

From the Tool dropdown list, select Replication Manager. The Replication Manager opens in the Setup
tab. The Setup tab has the following sections:

o Unified CCMP Database Server Properties contains the publisher and subscriber Unified CCMP
database details.
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O Distributor Properties contains the SQL Server Replication distributor properties.

The default values shown in the Setup tab are derived from the values initially configured in the Cluster
Configuration tool and are suitable in most cases.

If required, modify the Unified CCMP Database Server Properties.

O Server Name (publisher and subscriber): This is the value specified in ICE Cluster Configuration and
cannot be changed in Replication Manager.

O Catalog Name (publisher and subscriber): This is the value specified in ICE Cluster Configuration. It
may be changed, but if so, a valid database with the new name must already exist on the corresponding
server.

To replicate the Identity Server Database, select the Identity Database Replication Enabled checkbox.
This option is selected by default.

If required, modify the Distributor properties.

O Server Name: The name of the subscriber server hosting the Unified CCMP database. This is the value
specified in ICE Cluster Configuration and cannot be changed in Replication Manager.

O Catalog Name: The name to be assigned to the distribution database. The value should be
distribution_portal.

O Data Folder: The folder path on the distributor server where the data file for the distribution database
is created.

Note: If you are setting up replication after performing an upgrade, be particularly careful with the Data
*—/ Folder path, as it may be different from the value used in previous versions of Unified CCMP. Make sure
you use the path that was specified when the database was set up.

O Log Folder: The folder path on the distributor server where the transaction log file for the distribution
database is created.

O Distribution Share: The distribution share folder where replication snapshot files are generated.

O Override Distributor Admin Password: Select to override the auto-generated replication password to
establish connectivity. The auto-generated password is 14 characters long, and contains alpha-numeric
characters (both upper and lower case) and a special character. If this does not meet the complexity
requirements of the server then select this option and specify a password of your choice.

When you have set the required replication properties, click Configure to configure replication.

You may be prompted to save pending changes to the database before continuing. If so, click Yes to save
pending changes and continue.

It may take several minutes to configure replication. Once replication has been configured, the Replication
Manager automatically switches to the Monitor tab, which enables you to monitor the progress of the
replication snapshot.

Replication and Security Requirements

78

When running Unified CCMP with a replicated database, you must configure the permissions for the NT file
share on the Distributor database server. If the setup lacks the required permissions, the Distribution database
will be unable to commit transactions to the Portal database.
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To fulfill replication and security requirements:

1.

2
3
4,
5
6

=~

10.

11.

12.

13.

14.

Note the username which is used to run the SQL Server Agent service as well as the SQL Server Service.
On the Subscriber server, open Computer Management.

Navigate to the System Tools > Shared Folders.

Locate and select the Repldata shared folder.

In the Actions section, expand the More Actions option under Repldata section and select Properties.

In the Share Permissions, ensure that the SQL Agent service account and the SQL Server service account
have full control of the share

In the Security tab click the Advanced button.

Ensure that the SQL Agent and SQL Server service accounts have full control over this directory and all
subdirectories and files.

Click OK to close all opened screens.
Now, open SQL Management Studio and login as an SA level user.
Navigate to the SQL Agent and expand the available options to select Job Activity Monitor.

Right-click each job that has failed and choose Properties. Ensure that the job owner is a user that still
exists in the system. Please note that even though it is an SQL agent account, you must validate this by
looking at the successful jobs.

Locate the Distribution Cleanup job, right-click and select Start Job at Step.., Under certain circumstances,
this step may take a great deal of time to complete.

Once the job is completed, the database is back in sync.

You can also shrink the distribution_portal database data and log files to a reasonable size—typically around
25 GB for the data file and 5 GB for the log file.

Monitoring the Replication Snapshot

8: Note: The subscriber Database Server is not available for use until the replication snapshot has
*/ completed and all the data has been copied from the publisher database to the subscriber database.

To monitor the progress of the replication snapshot:

1.

In the ICE Replication Manager, select the Monitor tab. The Monitor tab has the following panes:

O  Publications: Lists the publisher servers and the publications on each publisher that need to be shared
with the subscribers.

O Subscriptions and Agents: Shows the subscriptions to a publication and the replication agents
associated with a publication. This pane has two tabs, Subscriptions and Agents.

O Subscriptions: Shows the subscriptions to the selected publication. You can right-click on a
subscription to start or stop the subscription.

O  Agents: Shows the replication agents associated with the selected publication. You can right-click on a
replication agent to start or stop the agent.

O  Sessions: Shows all sessions for the selected publication and replication agent in the last 24 hours.
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O Actions: Shows the activity for the selected session.

In the top left-hand pane, select the first Unified CCMP database publication from the list of publications. If
you have used the default database name, this starts with [Portal].

Wait for the replication snapshot for this publication to complete.

To check the replication status for a Unified CCMP database publication, in the bottom right-hand pane of
the Monitor tab, inspect the messages in the Action Message list. Once the replication snapshot is complete
and replication is operational for a publication, you see the following two messages:

"Delivered snapshot from "

"No replicated transactions are available".

After this, the second message is replaced with messages showing new replicated transactions as they are
sent through the system, for example:

"4 transaction(s) with 14 command(s) were delivered".
Repeat the steps above for each of the remaining Unified CCMP database publications.
When replication is complete for all portal database publications, close the ICE tool.

The subscriber database can now be used to service requests. For more information about the Replication
Manager see the Integrated Configuration Environment (ICE) for Cisco Unified Contact Center
Management Portal.
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Post-Installation
Process

Configuring SSL

Binding Server Ports to IPv6 Addresses
Configuring Antivirus Options
Performance Tuning Checklists

Final Post-Installation Actions

Checking Database Credentials



This chapter describes the remaining actions that must be taken to secure, configure and tune your installation.
This chapter describes the following actions:

»  Configure SSL for the Unified CCMP web application and Web Services (required)
» Configuring Single Sign-on (optional)

» Configuring anti-virus options

» Tuning your system for optimal performance

» Performing the first log in and verifying the system

Configuring SSL

Follow the instructions in this section to configure SSL for the Unified CCMP web application. To configure
SSL for Unified CCMP you need to:

» Obtain a digital certificate if you do not already have a suitable one. For more information, see “Obtaining a
Digital Certificate” on page 82.

» Export the certificate in PFX format. For more information, see “Exporting the Certificate in PFX Format”
on page 83

» Configure SSL for the Unified CCMP web application. For more information, see “Configuring SSL for the
Web Application” on page 84.

%A Note: These steps are mandatory and some features of the web application do not work properly unless
@ you do this.
These steps are also required if you are upgrading, even if you have already configured SSL for a
previous version.

Obtaining a Digital Certificate
If required, a digital certificate may be obtained in either of the following ways:
» Purchased from an external certificate authority, for public use.

» Generated internally, for secure use within the issuing organization.

@ Note: You should use a digital certificate with a key length of at least 2048 bits. Some recent browsers
%/ may reject certificates with shorter key lengths.

If you do not already have a suitable certificate, you can request or generate one.

To request an external certificate:
1. Open Internet Information Services (IIS) Manager and select the web server in the folder hierarchy.
2. Select the Features View tab, and in the IIS group, click Server Certificates.

3. In the Actions pane, select Create Certificate Request to display the Request Certificate dialog box.
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In the Common Name field, enter the application domain name. Take care to enter it exactly as specified
here. The certificate does not work otherwise. The Common Name is derived as follows:

O For deployments where the web servers will be accessed using load balancer, enter the fully qualified
domain name of the load balancer. For example, if the load balancer URL is
https://domain.intranet.local, enter domain.intranet.local.

o For deployments where the web servers are accessed directly with no load-balancing, enter the fully
qualified domain name of the server being configured. For example, webserver1.mydomain.com.

Complete the other fields as appropriate, and click Next.

In the Cryptographic Service Provider Properties dialog box leave the default Cryptographic Service
Provider. Select a bit length of at least 2048. Click Next.

Specify a file name for the certificate, and then click Finish.

When you receive the certificate from the certificate authority, repeat step 1. and step 2. above to show the
Server Certificates and Action panes, and in the Action pane, select Complete Certificate Request.

Enter the file name of the certificate, and a Friendly Name of your choice and click OK.

To generate an internal certificate:

1.
2.
3.

Open Internet Information Services (IIS) Manager and select the web server in the folder hierarchy.
Select the Features View tab, and in the IIS group, click Server Certificates.

In the Actions pane, select Create Domain Certificate to display the Distinguished Name Properties
dialog box.

In the Common Name field, enter the application domain name. Take care to enter it exactly as specified
here. The certificate does not work otherwise. The Common Name is derived as follows:

O For deployments where the web servers are accessed using load balancer, enter the fully qualified
domain name of the load balancer. For example, if the load balancer URL is
https://domain.intranet.local, then enter domain.intranet.local.

O For deployments where the web servers will be accessed directly with no load-balancing, enter the fully
qualified domain name of the server being configured. For example, webserver1.mydomain.com.

Complete the other fields as appropriate, and click Next.

In the Online Certification Authority dialog box specify the Online Authority and a name. Click Finish.

Exporting the Certificate in PFX Format

To export the certificate in PFX format:

1.
2.
3.

In IIS Manager, select the Features View tab, and in the IIS group, click Server Certificates.
Select the certificate in the Actions pane and click Export.
In the Export Certificate dialog box, do the following:

a. Either type a file name in the Export to box or click Browse and specify the file in which to store the
exported certificate.
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https://Unified CCMP.intranet.local, enterUnified CCMP.intranet.local
https://Unified CCMP.intranet.local, enterUnified CCMP.intranet.local
https://Unified CCMP.intranet.local, enterUnified CCMP.intranet.local

b. If you want to protect the exported certificate with a password, enter a password in the Password box,
and repeat the same password in the Confirm password box.

c. Click OK. The certificate is exported as a PFX file.

Configuring SSL for the Web Application

To configure SSL for the web application:

1.

In a web browser, navigate to http:// <web-address>/ SSLConTig, where <web-address> is the web address
of your Unified CCMP deployment. For example, if your web address is A¢tp://domain.intranet.local, enter
http://domain.intranet.local/SSLConfig.

In the authentication dialog box, enter the user name and password of a Windows domain user with
administrator rights on the domain.

Note that to upload the certificate using SSLConfig tool, administrator privilege on the webserver box
(either local administrator or domain user account who has administrator access) is required.

On the SSL Certificate Configuration page, click the Browse or Choose File button and browse to the PFX
file you created in the previous section.

If the PFX file is password-protected, enter the password in Password. If not, leave Password blank.

Click Upload to start the SSL configuration. When the SSL configuration is complete, the following
message is shown: SSL Configuration Complete.

Binding Server Ports to IPv6 Addresses

This is an optional task and needs to be performed only if IPv6 network is available. The server ports that are

used for http and https communications must be bound to IPv6 addresses only.

To bind ports on the App/Web server:

1.

2
3.
4

In IIS Manager, expand the Sites node and select Default;Web Site.
Under Actions, select Bindings.
Select http and click Edit. In the IP Address field enter [: : 11. Click OK.

Select https and click Edit. In the IP Address field select the IPv6 address assigned to the App/Web server.
In the HTTPS certificate field, select the HTTPS certificate that has the fully qualified domain name
installed on the server.

Click OK, then Close.

At the command prompt, enter iisreset.
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Configuring Antivirus Options

If you have antivirus software on the Unified CCMP servers, you should exclude the following directories from
the antivirus checks:

» The folders containing the database files (*.1df, *.mdf and *.ndf) on the Database Server. To locate these
files, do the following:

a. Start SQL Management Studio and expand the Databases node.

b. Select Properties for each of the databases in turn. If you selected the default database name at
installation, the database is Portal.

c. In the Database Properties dialog box, select the Files page to see the folder and file names of the
database files.

» The Importer folder on the Database Server. If you selected the default installation location, this is
C:\Program Files\Management Portal\Data Import Server\IMPORTER.

» The Web folder and all subfolders on the App/Web Server. The default installation location is: C:\Program
Files\Management Portal\Web.

Performance Tuning Checklists

The following performance tuning steps ensure optimal performance of Unified CCMP.

Application/Web Servers

Description Done

Create a new page file, on a non-system drive, specifying the option to allow Windows to
manage the page file size.

Defragment the page file and registry hives using https://technet.microsoft.com/en-
us/library/2007.09.utilityspotlight.aspx (link checked in April 2021)

Set Windows audit policy settings to disable success audits for audit logon events. See:
http://technet.microsoft.com/en-us/library/cc758201(v=ws.10).aspx for more information (link
checked in April 2021).

Post-Installation Process 85



Database Servers

Description Done

Create a new page file, on a non-system drive, specifying the option to allow Windows to
manage the page file size.

Defragment page file and registry hives using
https://technet.microsoft.com/en-us/library/2007.09.utilityspotlight.aspx

Ensure the Portal database is set to Simple Recovery Mode on all systems.

For deployments with more than 8,000 agents you should also do the following steps on all database servers.

Description Done

Restrict SQL Server memory usage as follows:

1. In SQL Server Management Studio, right-click the database server, select Properties and go to the
Memory page.

2. Set Minimum server memory to 4096 MB (4 GB) and Maximum server memory to 11264 MB (11 GB).
3. Click Save to apply the setting then close SSMS.
4. Restart the SQL Server Services.

Increase the Data Importer SQL command timeout as follows:

1. In Windows Explorer locate the Data Importer configuration file. If you have used the default
installation location, thisis at C: \Program Files\ManagementPortal\Data Import
Server\DataPipelineService.exe.config.

2. Open this file in Notepad or another text editor.

3. Search for name="SqlCommandTimeout" and in the <value> tag that follows, change the time from
00:00:30 to 00:01:30.

4. Save the file.
5. Stop and restart the Unified CCMP: Data Importer windows service.

After the initial import has completed following a new installation or upgrade, update the
database statistics to improve query performance.

1. In SQL Server Management Studio, click New Query and enter the following (replace Portal with the
name of your database if necessary):

USE Portal;
G0
EXEC sp_updatestats;
G0
2. Close SSMS.
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Final Post-Installation Actions

Installing Microsoft KB Patches

4

Before starting the Unified CCMP services, any necessary Microsoft KB patches must be installed. Ensure
the Unified CCMP services are stopped and set to “disabled” before applying any Microsoft KB patches.
Once all patches have been applied, re-enable the Unified CCMP services before restarting the system.

Enabling Registry Auditing

You can enable registry auditing to keep track of the changes made to the registry on the servers. This is an
optional task.

To enable registry auditing:

1.

Y *® N 0 kW

In elevated mode, run the following command from Command Prompt:
auditpol /set /subcategory:"Registry" /success:enable

Note: If the Operating System has a different language pack, the name Registry might differ. For instance,
on a German Windows Operating System, the name is Registrierung. To see the name of the subcategory,
you can run the following command:

auditpol /list /subcategory:*

Open Registry Editor and navigate to the key which we want to audit:
HKEY_LOCAL_MACHINE\SOFTWARE\Exony

Right-click the key and choose Permissions...

Click Advanced and switch to the Auditing tab.

Add a user or group (using 'Select a principal' if not already there)
Select Type as All

Select Applies to as This key and subkeys.

Check Full Control under Basic permissions (or Advanced permission).

Click OK.

10. Apply settings.

Restarting the System

4

Reboot the servers after installation has finished, making sure that the Unified CCMP services start
automatically on boot.
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Logging in to Unified CCMP

To login to Unified CCMP:

1.

Launch the Unified CCMP application using the URL: https://{fully qualified name of
serverl}/portal.

To login to a new system, use the user name administrator and the password set during the database
installation. If you are logging into an upgraded system, the administrator password is the same as before.

Verifying the Installation

Once the system is installed and configured, you should run through the following checks to ensure that data is
imported and the system running normally.

To verify the installation:

1.

Log in to the Unified CCMP web application using the pre-configured administrator user and confirm that
the Unified CCMP home page successfully displays.

In the ICE Service Manager tool, verify that all the installed Unified CCMP Services are running.
Use the following SQL statement to confirm that resource data is being imported to the database:

Select count(x)

from [dbol.LTB_DIM_AGENT]

This query should return a value of at least 3.

Configuring Distributed Transaction Coordinator (DTC)

To configure DTC:

1.
2.

Click Start > All Program > Administrative Tools > Component Services.

In the Component Services management tool, expand Component Services > Computers > My Computer
> Distributed Transaction Coordinator.

Right-click Local DTC and from the menu select Properties.
In the Local DTC Properties window, go to the Security tab and set the following:
a. In the Security Settings section, select the Network DTC Access option.

b. Within the Network DTC Access section, ensure that the following options are enabled for Transaction
Manager Communication:

e Allow Inbound
e Allow Outbound
e No Authentication Required.

Check the Enable XA Transaction checkbox.

Check the Allow remote administration checkbox.
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7. Click OK and accept the prompt to restart the MSDTC Service.

8. Close the Component Service window.

Checking Database Credentials

» Once the application server is installed and configured, you should check that you have provided a valid
database credential.

There is no database validation check present when installing application server components.
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Update JAVA to
Latest Version

» Updating Java to the Latest Version for CCMP 15



Updating Java to the Latest Version for CCMP 15

This section provides the steps to update Java to the latest available version in order to mitigate vulnerabilities in
CCMP 15.

Pre-Requisites

»

Stop the CCMP Provisioning Service on the Database Server.

Deployment Steps

To update java:

1.

2
3
4,
5
6

10.

Download the latest available JDK update for OpenJDK 11 from https://adoptium.net/?variant=openjdk11.
Install the downloaded JDK on the Database Server.

Open the Registry Editor by running the regedit command.

Navigate to the following registry path: #K£y _L0CAL_MACHINEASOFTWARE\Egain\Common\Java.
Under the above path, create a new key and name it with the latest Java version number. Example: 71.0.12

Select the newly created version key and create the following two new String Values under it:
O JavaHome
O Runtimelib

Set the value of JavaHome to the installation path of the updated Java version. Example: c:\Program
Files\Management Portal\Common Components\java\

Set the value of RuntimeLib to the path of the jvm.dll file of the installed Java version. Example:
C:\Program Files\Management Portal\Common Components\java\bin\server\jvm.dll

Start the CCMP Provisioning Service.

Verify the provisioning server Java logs to ensure that the provisioning service has picked up the latest JDK
version.

Rollback Steps

To initiate rollback:

1.

2
3.
4

Stop the CCMP Provisioning Service on the Database Server.
Open the Registry Editor using the regedit command.

Navigate to the following registry path: HKEY LOCAL MACHINE\SOFTWARE\Egain\Common\Java

Delete the JavaHome and RuntimeLib string values created under the latest Java version key.
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5. Delete the registry key corresponding to the latest Java version.

6. Start the CCMP Provisioning Service.
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About the Upgrade Procedure

Upgrade Options

Acquiring and Preparing New Windows 2022 Servers

Upgrading Windows Server 2019 to Windows Server 2022 for Existing Deployments

Upgrading SQL Server 2019 to SQL Server 2022 for Existing Deployment



About the Upgrade Procedure

The following table lists the Unified CCMP versions you can upgrade from and the OS and SQL version changes
that need to be considered while upgrading from previous versions.

Important things to note:

» Version 15.0 requires Windows Server 2022 and SQL Server 2022. Earlier versions used Windows Server
2019 and SQL Server 2019.

» Upgrade from 12.5 and onwards to 15.0 can be done in-place or on new servers.

0S (Windows) version

Upgrade from changes SQL version changes
» 12.5,12.6 » Windows Server 2019 » SQL 2019
to changes to changes to

» Windows Server 2022

» 15.0 » SQL 2022

Upgrade Options

There are two upgrade options available - total outage upgrade and split-sided upgrade.

o\ Important: For both of these upgrade options, you can either upgrade using in-place servers or
'Y using new servers.

» Single-sided systems always use the total outage upgrade (page 99) option - where all systems are brought
down and upgraded at the same time.

» For dual-sided systems you can do:

O A total outage upgrade (page 99), when both A and B sides are turned off and upgraded at the same
time.

O A split-sided upgrade (page 119), when you turn off side A only and Side B is always available while
upgrading the application to the latest version on the new servers.

More About Upgrading Dual-Sided Systems

Unified CCMP employs a distributed architecture for dual-sided systems. Resilience is achieved by the use of a
second side of the system containing the same components as the primary side. SQL Server replication is used to
replicate data from Side A to Side B and Side B to Side A.

Failover information for the individual Unified CCMP components is stored in the databases on Side A and B.
This information is also replicated using SQL Server replication. This means that both sides have knowledge of
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the primary and secondary server configuration made through the Unified CCMP Integrated Configuration
Management tool, even when replication has been removed.

CCMP Database Server A | | CCMP Database Server B
SQL Replication
Provisioning Server “ Provisioning Server
Portal
Data Import Server Data Import Server
Secondary
S . |
Primary Primary!
CCMP Web/Application Server A CCMP wara,'f-\pplication Server B
Application Server Application Server
Web Server Web Server

When a replicated system is upgraded one side at a time, it is possible for the individual components of Unified
CCMP to fail-over to the other non-upgraded side. This results in data inconsistencies as some data is entered to
Side A and some to Side B with no replication running to synchronize the two sides.

There are two ways to upgrade dual-sided systems:

» If it is acceptable for the system to be completely unavailable whilst the upgrade is performed, then use the
Total Outage Upgrade method. This is the quicker upgrade method.

» If high-availability is required, then use the Split-Sided Upgrade method. This method maximizes the system
up time during the upgrade but adds additional complexity.

Acquiring and Preparing New Windows 2022 Servers

@ Important: Perform these tasks only if you are upgrading using new servers.

» Acquire new servers with Windows Server 2022. You must have these servers ready before you begin the
upgrade process.

» These tasks need to be performed on the new Windows 2022 servers and do not require any downtime.
Perform these tasks on both Side A and Side B servers.

Configuring New Windows Servers

»  On the new Side A and Side B servers running Windows Server 2022, perform the Windows pre-installation
tasks. See the “Configuring Windows” on page 33 section for details.
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Creating User Accounts

» On the new Side A and Side B servers running Windows Server 2022, create the SQL Agent User account
as described in “Configuring User Accounts” on page 34.

Configuring Optional Security Settings

» On the new Side A and Side B servers running Windows Server 2022, configure the security settings as
described in “Configuring Optional Security Settings” on page 37.

Installing and Configuring SQL Server

» Install and configure SQL Server as described in “Installing and Configuring SQL Server” on page 35.
Perform this task on the new Side A and Side B servers.

Upgrading Windows Server 2019 to Windows Server
2022 for Existing Deployments

Before upgrading to 15.0, you must upgrade Windows Server 2019 to Windows Server 2022 on all the CCMP
servers.

@ Important: These tasks are applicable only for in-place upgrades.

8: Note: Perform these tasks on both Side A and Side B servers.
B

Downtime requirements: This upgrade requires a downtime as services are stopped on all servers when the
operating system is being upgraded. While planning for downtime, take into account the time required to take
VM backups and the time required to upgrade the operating system on all servers.

To upgrade Windows Server 2019 to Windows Server 2022 for existing deployments:

7 Note: Before upgrading the operating system from Windows 2019 to 2022, ensure that the Virtual
@'ﬁ machine snapshot is taken and the CCMP application components are uninstalled.

1. Update Windows Server 2019 to Windows Server 2022. Refer Microsoft documentation to known more
about upgrade procedure at: https://learn.microsoft.com/en-us/windows-server/get-started/perform-in-place-
upgrade.
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Upgrading SQL Server 2019 to SQL Server 2022 for
Existing Deployment

@ Important: These tasks are applicable only for in-place upgrades.

Before upgrading to 15.0, you must upgrade SQL Server 2019 to SQL Server 2022 on Database Server of both
Side A and Side B.

Downtime requirements: This upgrade requires a downtime as services are stopped on all servers when the
SQL server is being upgraded. While planning for downtime, take into account the time required to upgrade the
SQL Server on database servers.

To upgrade SQL Server 2019 to SQL Server 2022 for existing deployments:

1. Update SQL Server 2019 to SQL Server 2022 on database servers. Refer Microsoft documentation to known
more about upgrade procedure at: https://docs.microsoft.com/en-us/sql/database-engine/install-
windows/upgrade-sql-server-using-the-installation-wizard-setup ?view=sql-server-ver15

2. Install SQL Server Management Studio (SSMS) 18.x.
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Preparing to Upgrade

Upgrading and Configuring Unified CCMP Components

Restoring Replication

Post-Upgrade Tasks



This chapter describes the steps involved to upgrade a single-sided and dual-sided deployment, where all servers
are taken down and upgraded at once.

5\ Important: Ensure that you have up-to-date backups of all Unified CCMP databases before you
2 begin the upgrade. Instructions for doing this are included here.

Note: Before starting the upgrade please ensure you have the original cryptographic passphrase from
*/ the original Unified CCMP installation as you will need it during the upgrade.

About Total Outage Upgrades

In a total outage upgrade all the servers are brought down and upgraded at the same time. Single-sided systems
always use the total outage upgrade option. For dual sided systems, you can use a total outage upgrade option,
where you bring down both side A and side B at the same time and upgrade both sides in one go. Optionally, you
can use the split-sided upgrade option (page 119) for dual-sided systems.

Checklist for Total Qutage Upgrades for Single-Sided
and Dual-Sided Systems

For Upgrades on New Servers

Step Complete

“Acquiring and Preparing New Windows 2022 Servers” on page 96

(Task to be performed outside the downtime)

“Preparing to Upgrade” on page 103

Updating Folder Names in Resource Manager

Stopping the Unified CCMP services

Remove database replication

(Only when upgrading dual-sided systems)

Backing up the Unified CCMP Portal Database

Backing up the Unified CCMP Identity Database

Restore the Portal and Identity databases

Configure the SQL Agent User

Adding Network Service Accounts
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Step Complete

“Upgrading and Configuring Unified CCMP Components” on page 107

Install the Database Components

Upgrade the portal database

Install Database Components and Upgrade portal database (Side B)

Install the App/Web server

Install the identity server

Install the App/Web server and identity server (Side B)

Reconfigure the Unified CCMP servers

“Reconfigure Unified CCE to Use the New Servers” on page 113

“Restoring Replication” on page 113

Configure Replication

(Only when upgrading dual-sided systems)

Monitor the replication snapshot

(Only when upgrading dual-sided systems)

“Post-Upgrade Tasks” on page 116

Bind Server Ports to IPv6 Addresses

Configure SSL

Restart the System

Log in to Unified CCMP

Verify the installation

Restart the Unified CCMP Services

Validate the upgrade

For In-Place Upgrades

Step Complete

“Preparing to Upgrade” on page 103

Updating Folder Names in Resource Manager

Stop the Unified CCMP services
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Step Complete

Remove database replication

(Only when upgrading dual-sided systems)

Virtual Machine snapshot for CCMP Servers.

Uninstall CCMP Components

Upgrade OS and SQL Server Version of Side A and B

“Upgrading and Configuring Unified CCMP Components” on page 107

Install the Database Components

Upgrade the portal database

Install Database Components and Upgrade portal database (Side B)

Install the App/Web server

Install the identity server

Install the App/Web server and identity server (Side B)

Reconfigure the Unified CCMP servers

Reconfigure the Unified CCE Servers

“Restoring Replication” on page 113

Configure Replication

(Only when upgrading dual-sided systems)

Monitor the replication snapshot

(Only when upgrading dual-sided systems)

“Post-Upgrade Tasks” on page 116

Bind Server Ports to IPv6 Addresses

Configure SSL

Restart the System

Log in to Unified CCMP

Verify the installation

Restart the Unified CCMP Services

Validate the upgrade
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Preparing to Upgrade

Updating Folder Names in Resource Manager

» In Resource Manager, the following characters are not allowed in folder names: Space, Dot (.), tilde (~),
hyphen (-), underscore (_), curly bracket {}, circle bracket (), hash (#), single quote (*). You must update the
folder names before upgrading.

Stopping the Unified CCMP Services

Before starting the upgrade, perform the following steps on the Side A database servers to stop all Unified
CCMP services running on both sides.

To stop the Unified CCMP Database Server services:

1. Launch the Integrated Configuration Environment (ICE) tool.

2. In the Database Connection window, provide the database connection details and click OK.
3. From the Tool dropdown, select Service Manager.

4. Select all the Unified CCMP Services and click Stop Selected.

5

A dialog box appears to state that all the services are stopped. Click Close.

Removing Database Replication

Before you can upgrade a dual-sided system, database replication must be removed.

To remove database replication:

1. Ensure you are logged in to the Side A Database Server as a domain level user with administrative rights
over both Database Servers.

2. Launch Integrated Configuration Environment (installed as part of Unified CCMP). In the Database
Connection dialog box, set:

O  Server Name: Enter the name of the primary database server.

O Port: Provide database server SQL non-default Port. By default the value is set as 1433. This field has
been introduced in CCMP 15 ES202603.

O Database Name: Enter the name of the Unified CCMP database that was installed when setting up the
Database Component. If you accepted the default value, this is Portal.

O Authentication: Select Windows Authentication.
3. Click OK. The ICE Cluster Configuration tool starts by default.
4. From the Tool dropdown list select Replication Manager.

5. Click the Setup tab to see the replication setup details.
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Click Disable to remove replication from the Unified CCMP database. When prompted, click Yes to proceed
with replication removal.

Replication removal may take several minutes. Wait for the Replication Removed message to display in the
Output window and then exit ICE.

Pre-Upgrade Tasks Specific to New Server Upgrades

Acquiring and Preparing New Windows 2022 Servers

Perform steps as mentioned in “Acquiring and Preparing New Windows 2022 Servers” on page 96

Backing up the Portal Database

Back up the Portal database and copy the backup to a safe location where it can be accessed once the latest
version of Unified CCMP has been installed on the new servers.

Perform the following steps on the Side A Database Server and then repeat the steps on the Side B Database
Server.

To back up the Portal database:

1.

2
3.
4

Launch SQL Server Management.
Navigate to the Portal database.
Right-click Portal and select Tasks > Backup. Save the. bak file to a suitable location.

Close SQL Server Management Studio.

Backing up the Identity Database

Back up the Identity database and copy the backup to a safe location where it can be accessed once the latest
version of Unified CCMP has been installed on the new servers.

Perform the following steps on the Side A Database Server and then repeat the steps on the Side B Database
Server.

To back up the identity database:

1.

2
3.
4

Launch SQL Server Management.
Navigate to the Identity database.
Right-click IdSvr3Config and select Tasks > Backup. Save the.bak file to a suitable location.

Close SQL Server Management Studio.
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Restoring the Portal and Identity Databases

Restore the Side A portal and Identity database from the Side A backup you made earlier.

To restore the databases:

On the Side A New Database Server:

1.
2.
3.

7.

Launch SQL Server Management Studio.
Right-click the Databases folder and click Restore Database.

In the Restore Database window choose From Device, click Add and add the location of the database back

up file you want to restore from. You may need to copy the backup file to a local file in order to access it.
Click OK.

Select the check-box next to the backup set you just added.
From the To Database drop-down list, select the Portal database as the restore destination.

Select Options and choose Overwrite the existing database. This will restore the database to the same
location as the previous database. If you would like to choose a different location, update the Restore As
path for each file to your preferred data file location.

Click OK to start the restore.

Repeat the process on the Side B Database Server to restore the Side B portal and identity databases backup to
the Side B Database Server.

Configuring the SQL Agent User

For a dual-sided system, the SQL Agent User must be reconfigured. Perform the following steps on the Side A
Database Server and then repeat the steps on the Side B Database Server.

To configure the SQL agent user:

1.
2.
3.

Launch SQL Server Management Studio and expand the Security folder. A list of subfolders is displayed.
Right-click the Logins folder and select New Login.

Ensure the Windows authentication option is selected and enter the SQL Agent User domain and login
name in the following format: <DOMAIN>\<LOGIN>. This should be the user name that you specified for the
SQL agent user account when you originally installed the portal database. For example, if your user is called
sql_agent_user and belongs to the CISCO domain, enter CISCO\sql_agent_user.

In the Select a page pane on the left-hand side, click User Mapping.

In the Users mapped to this login section, select the Portal database. The User column will auto-populate
with the domain user name for the SQL Agent User.

In the Database Role Membership section, select the db_owner role.

Click OK to apply the changes.
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Adding Network Service Accounts

You must add the NETWORK SERVICE account for all web servers to the database logins with appropriate
access permissions. Before this can be done, the existing accounts must be deleted from the Portal database
logins.

Perform this task on Side A and Side B servers.

To add network service accounts:

1. Launch SQL Server Management Studio and in the Object Explorer, expand the Portal database. A list of
folders is displayed.

2. Expand the Portal > Security > Users folder. A list of database logins is displayed.

3. For each occurrence of the NETWORK SERVICE account for a remote web server in the deployment, right-
click it and select Delete.

Do not delete the entry for the NETWORK SERVICE account for the local machine (NT
AUTHORITY\WWNETWORK SERVICE).

The NETWORK SERVICE logins for remote web server machines in the deployment are of the form
<DOMAINS\<WEBSERVER MACHINE NAME>$. For example, if your web server is called WEBSERVERA
and belongs to the UCCMPDOM domain, the NETWORK SERVICE login would be UCCMP\WEBSERVERAS.

4. 1In the Object Explorer, expand the top-level Security folder. A list of folders is displayed.
5. Right-click the Logins folder and select New Login.

6. Ensure that the Windows authentication option is selected and enter the NTAUTHORITY\NETWORK
SERVICE account for the Side A web server in the following format: <DOMAIN>\<WEBSERVER MACHINE
NAME>S$.

7. In the Select a page pane on the left-hand side, click User Mapping.

8. In the Users mapped to this login section, select the Portal database.

9. Ensure that the User column correctly contains the Network Service account for the web server.
10. In the Database Role Membership section, select the portalapp role.

11. Click OK.

12. For deployments with multiple web servers, repeat step 5. to step 11. for each additional web server.

Pre-Upgrade Tasks specific to In-place Upgrades

Virtual Machine Snapshot for CCMP servers:

To revert to the previous versions that existed before you did in-place upgrade of installations to Release 15.0(1),
perform one of the following tasks:

1. Take a Virtual Machine Snapshot in the powered off state before the upgrade.

2. Clone the Virtual Machine before the upgrade.
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Delete these snapshots or clones after the upgrades are successfully completed. Such deletions will prevent
performance issues.

Uninstalling CCMP components

Perform the following steps only if you are doing in-place upgrade,

Uninstalling Identity Component

» Perform steps on existing server as mentioned in “Uninstalling Identity Component” on page 150

Uninstalling Application Server Component.

» Perform steps on existing server as mentioned in “Uninstalling Application Server Component” on page 150

Uninstalling Database Server Component.

» Perform steps on existing server as mentioned in “Uninstalling the Database Component” on page 150

Uninstalling Common Server Component.

» Perform steps on existing server as mentioned in “Uninstalling the Common Component” on page 151

Upgrade Operating System to Windows 2022 and SQL server to 2022

» Perform steps on existing server as mentioned in “Upgrading Windows Server 2019 to Windows Server
2022 for Existing Deployments” on page 97

» Perform steps on existing server as mentioned in “Upgrading SQL Server 2019 to SQL Server 2022 for
Existing Deployment” on page 98

Upgrading and Configuring Unified CCMP
Components

8: Note: Perform the following steps on existing servers in case of in-place upgrade or on the new servers
*—/ if you are using new servers for upgrade.

Installing the Database Components

Perform the following steps on the Side A Database Server.

To install the database components:

1.  Mount the Unified CCMP iso and start the Unified CCMP Installer (for more information about the Unified
CCMP Installer, see “About the Unified CCMP Installer” on page 43).
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2. Select Database Server, and wait until the prerequisite checks have completed. If any checks fail, fix the
issues as necessary. Choose the specific port number.

3. When all checks have passed, click Install. At this point, the Informix client is installed first if necessary. If
you see the Informix client installation screen, click Install.

4.  When the Informix client has been installed, the installation of the database components starts, and the Setup
window displays.

5. Click Next to go through each window in turn.

6. In the License Agreement window, you must accept the terms of the license agreement before proceeding.
When you have read and agreed to the terms, click Next.

7. In the Cryptography Configuration window, provide the following:

O Passphrase: Enter the cryptographic passphrase you created during the installation of the Database
Server component when you first installed Unified CCMP. Note that you cannot access your existing
data if you continue the installation with a new passphrase.

o  Confirm Passphrase: You cannot continue until the contents of this field are identical to the passphrase
entered above.
8. In the Configure Database window, provide the following and click Next:
o SQL Server: This field is grayed out and the value is set to Localhost.

o Port: Provide database server SQL non-default Port. By default the value is set as 1433. This field has
been introduced in CCMP 15 ES202603.

O Catalog Name: Enter the name of the database catalog for Unified CCMP. By default this is Portal.
O  Connect Using: Select one of the following login credentials you want to use:
e Windows authentication credentials of application

e SQL Server authentication using the login ID and password below. This option should only be
selected if you are using a database catalog on a different domain. For this option you must enter
your SQL Server Login Name and Password in the fields provided.

9. In the Destination Folder window, if you want to change the location where the database components are
stored, click Change and select the new location. The Unified CCMP components need to be installed in the
same directory location on each of the servers.

10. In Ready to Install the Program window click Install to install the database components. During this
process, the J2SE prerequisite will be automatically installed if it is not already present. If this happens,
follow the screen prompts to complete the J2SE installation. If you see a Security Alert dialog box during
the installation, saying Revocation Information for the security certificate for this site is not available,
click Yes to continue.

11. To install or upgrade your database immediately after installing the database components, select the Launch
Database Management Utility check box.

Note: If the Launch Database Management Utility check box is not checked, you can access Database
¥/ Management Utility through the Database Installer.

12. Click Finish.
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Upgrading the Portal Database
Perform the following steps on the Side A Database Server.

Note that the Identity Database is automatically upgraded along with the Portal Database.

To upgrade the portal database:

1. If you selected the Launch Database Management Utility check box when you installed the database
components, the Database Installer starts automatically after the installation. Otherwise, launch Unified
CCMP Database Installer. The Database Installer is a wizard which guides you through the steps to upgrade
the database.

2. Click Next to begin the upgrade process.
3. Inthe Select An action to Perform window choose Upgrade an existing database. Click Next to continue.

4. In the SQL Server Connection Details window, provide the following and click Next:

O  Server Name: Select the Microsoft SQL Server where the Unified CCMP database is located. In this
case this is the machine running the application, and so it must be left as the default (local).

o Port: Provide database server SQL non-default Port. By default the value is set as 1433. This field has
been introduced in CCMP 15 ES202603.

O Database Name: Enter or select the name of the database catalog that was originally used for the
Unified CCMP database.

o  Connect Using: Select the login credentials you want to use:
e The Windows account information I use to logon to my computer

e The SQL Server login information assigned by the system administrator. Only select this
option if you are using a database catalog on a different domain. For this option you must enter
your Login Name and Password in the fields provided.

O  Test Connection: Click to make sure the connection to the Microsoft SQL Server is established. If you
see the message: Connection succeeded but database does not exist, then you must
rectify this problem before continuing. Check that the database catalog name and security credentials
are correct.

When the database connection details have been tested and the connection is successful, click Next. A
warning message may appear notifying about unpartitioned old audit data. Click Yes to clear the data
now, or click No to continue the database upgrade as normal.

5. In the Ready to upgrade the database window, click Next to perform the upgrade. The upgrade may take
several minutes.

6.  When the Portal database upgrade is complete, click Close to close the Database Installer.

Installing Database Components and Upgrading Portal Database (Side B)

Perform the following steps on the new Side B Database Server.

To install database components and upgrade the portal database on Side B:
1. Install the database components as described in “Installing the Database Components” on page 107.

2. Upgrade the Portal database as described in “Upgrading the Portal Database” on page 109.
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Installing the Application/Web Server
Perform this task on the Side A App/Web Server and then repeat the steps on the Side B App/Web Server.

» Follow all steps in the section “Installing the Application and Web Server” on page 48.

Installing the ldentity Server
Perform this task on the Side A App/Web Server and then repeat the steps on the Side B App/Web Server.

» Follow all steps in the section “Installing the Identity Server” on page 49.

Reconfiguring the Unified CCMP Servers

If the Unified CCMP server names have changed, the Unified CCMP cluster configuration must be updated to
reference the new server names.

This only needs to be done on the Side A Database Server. These steps do not need to be repeated on the Side B
Database Server as the necessary changes are applied when replication is reinstated.

To update the cluster configuration on the Side A Database Server:

1. Launch Integrated Configuration Environment (installed as part of Unified CCMP). In the Database
Connection dialog box, set:

O  Server Name: Enter the name of the primary database server.

O Port: Provide database server SQL non-default Port. By default the value is set as 1433. This field has
been introduced in CCMP 15 ES202603.

O Database Name: Enter the name of the Unified CCMP database that was installed when setting up the
Database Component. If you accepted the default value, this is Portal.

O  Authentication: Select Windows Authentication.

2. Click OK. The ICE Cluster Configuration tool starts by default.

7n Note: If the Unified CCMP server names have changed, several errors may be reported when ICE starts
%/ for the first time after an upgrade. The steps in this section will fix the errors.

3. Select the Setup tab and click Setup UCCMP Servers to start the wizard. Click Next to go through each
window in turn.

4. On the Select Deployment Type page, choose Two Tier deployment type. Note that the All in one server
installation is not supported.

5. On the Configure Redundancy page, select whether you would like to configure a single-sided or a dual-
sided system. Click Next.

6. On the various Configure Servers pages, change the existing server name for each of the Unified CCMP
servers to the new server name. The number of pages and servers to specify will depend on your deployment
type. On each page, enter the following, then click Next:

O Primary Server:

e Server Name: This is the non-domain qualified machine name.
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10.
11.

12.

e Server Address: This defaults to Server Name. This can be changed to an IP Address or a domain
qualified name of the server.

e Port: Provide database server SQL non-default Port. By default the value is set as 1433. This field
has been introduced in CCMP 15 ES202603.

e FQDN Web URL: The Fully Qualified Domain Name used to access this web application server.
The FQDN will depend on the method of access to the application website, based on whether it is
with or without load balancer. With load balancer, the FQDN will be the load balancer FQDN and
must be specified in all Configure Application Server pages. Without load balancer, this will be
the FQDN used to access each website separately.

O  Secondary Server: If you chose a dual-sided setup, provide the corresponding details for the Side B
server.

Click Next and enter the relevant server information for each Unified CCMP server until you reach one of
the following pages: Primary Database Administrator Login, Secondary Database Administrator
Login or Configure Relational Database Connection.

Click Next to go through the remaining windows in turn, without changing anything.

When you see the confirmation message indicating that the wizard has completed successfully, click Exit to
close the wizard.

To save your changes, either click the Save icon in the toolbar or select File > Save from the menu.

In ICE, select the Servers tab. The list of servers will show both the old servers and the new servers. Right-
click each of the old servers and select Remove Server.

To save and action your changes, either click the Save icon in the toolbar or select File > Save from the
menu. Exit ICE.

Reconfiguring the Unified CCE Servers

Note: This step is only required if you have upgraded Unified CCE at the same time as upgrading Unified
®—/ CCMP. This step is not required if you have not upgraded Unified CCE.

If you have upgraded Unified CCE at the same time as upgrading Unified CCMP, the Unified CCMP cluster
must be updated to ensure that Unified CCMP can communicate with Unified CCE. It may also be necessary to
configure the Unified CCE Config Web Service, which wasn't present in some earlier versions of Unified CCE.

This only needs to be done on Side A. Side B is updated when replication is reinstated.

To reconfigure the Unified CCE servers:

1.

Launch Integrated Configuration Environment (installed as part of Unified CCMP). In the Database
Connection dialog box, set:

O  Server Name: Enter the name of the primary database server.

O Port: Provide database server SQL non-default Port. By default the value is set as 1433. This field has
been introduced in CCMP 15 ES202603.

O Database Name: Enter the name of the Unified CCMP database that was installed when setting up the
Database Component. If you accepted the default value, this is Portal.

O Authentication: Select Windows Authentication.
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10.

11.

12.

13.

Click OK. The ICE Cluster Configuration tool starts by default.
Select the Setup tab and click Configure Cisco Unified CCE Servers to start the wizard.

On the Select Task page, select Modify an existing instance. Select the Unified CCE instance that has been
updated, and click Next to go through each page in turn.

If you see the Configure Primary Unified Config Web Service page, enter or confirm the following details
URL. This is the auto-generated URL of the primary Unified Config Web Service on the Unified CCE.

O User Name: This is a user name with appropriate access to the Unified CCE that the web service is
running on. This user must be in the domain security group <Server>_<UCCE-Instance>_Config,
where <Server> is the name of the server running Unified CCE and <UCCE-Instance> is the name
of the Unified CCE Instance on this server.

o Password: This is the password for the user.
If you see the Configure Primary ConAPI RMI Ports page, enter or confirm the following ConAPI
details:

O Local Registry Port: This is the port on the Unified CCE for the Unified CCMP Provisioning service
to connect to. This is usually 2099.

O Remote Registry Port: This is the port on the Unified CCMP Database Server for the Unified CCE to
connect to. This is usually 2099.

O Local Port: This is selected as the designated port for live provisioning traffic between the Unified
CCE and Unified CCMP servers. It must be uniquely assigned for each Unified CCE and any firewalls
between the Unified CCE and Unified CCMP server must be configured to allow both-way traffic on
this port.

If you see the Configure ConAPI Application Instance page, enter the following details:

O Application Name: The name of the application to be used for provisioning Unified CCE from Unified
CCMP. Specify the name of the application you configured in “Setting Up ConAPI” on page 74.

O Application Key: Use the password for the application you specified above.

On the Multi Media Support page, select Yes to provide support for non-voice interactions. The default
value is No.

On the Purge On Delete page, if you want to purge items from Unified CCE automatically when they are
deleted from Unified CCMP, select Yes. The default is Yes.

On the Configure Active Directory Global Catalog Connections page, provide the details of active
directory global catalog and configure the security settings to connect.

@ Note: A two way trust relationship is required between Unified CCE and CCMP.
B

The Summary dialog box summarizes the details of the Unified CCE being configured and the settings you
have chosen. Check the details, and if you are satisfied, click Next.

A confirmation message is displayed to indicate that the wizard has completed successfully. Click Exit to
close the wizard.

For each remaining Unified CCE Server that has been upgraded, click Configure Cisco Unified CCE
Servers, and repeat the steps above.
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14. To save and action your changes, either click the Save icon in the toolbar or select File > Save from the
menu.

Reconfigure Unified CCE to Use the New Servers

Note: This step is only required if you have reinstalled Unified CCMP on new servers with different
@'\’* names. This step is not required if you have upgraded your existing servers, or have replaced your
existing servers with new servers with the same names.

If you have reinstalled Unified CCMP on new servers with different names, Unified CCE must be updated to
reference the new Unified CCMP servers.

To reconfigure Unified CCE to use new servers:

Do this task on each Unified CCE instance in your Side A deployment.

1. Launch CMS Control. This opens the CMS control console.

2. On the Application tab, select the Unified CCMP database server and click Edit.

3. Inthe Application connection details tab, change the existing server name to the new server name. There are
three places where this needs to be done:

O Administration & Data Server Link: The name of the new Unified CCMP Database Server, in upper
case, with Server appended. For example, if your Database Server is PRODUCTDB, enter
PRODUCTDBServer.

O Application link: The name of the new Unified CCMP Database Server, in upper case, with Client
appended. For example, if your Database Server is PRODUCTDB, enter PRODUCTDBCLlient.

O Application host name: The name of the new Unified CCMP Database Server, in capital letters, for
example, PRODUCTDB.

4. Click OK, then OK again to save the changes and exit the CMS Control console.

Repeat these steps on each Unified CCE instance in your Side B deployment.

Restoring Replication

Note: Before you start restoring replication, ensure that all the Unified CCMP services are in stopped
@’* state.
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Configuring Replication

Replication between the databases is set up and monitored using the Replication Manager application which is
available in the Unified CCMP Integrated Configuration Environment (ICE) tool.

Note: The user running Replication Manager must have administrator permissions in both Windows and
¥/ SQL Server, for both the publisher and the subscriber Database Servers.
Usually, the publisher is the Side A Database Server, but it may be necessary to configure the Side B
Database Server as the publisher.

To configure replication on the publisher Database Server:

1. Launch Integrated Configuration Environment (installed as part of Unified CCMP). In the Database
Connection dialog box, set:

O  Server Name: Enter the name of the primary database server.

O Port: Provide database server SQL non-default Port. By default the value is set as 1433. This field has
been introduced in CCMP 15 ES202603.

O Database Name: Enter the name of the Unified CCMP database that was installed when setting up the
Database Component. If you accepted the default value, this is Portal.

O Authentication: Select Windows Authentication.
2. Click OK. The ICE Cluster Configuration tool starts by default.

3. From the Tool dropdown list, select Replication Manager. The Replication Manager opens in the Setup tab.
The Setup tab has the following sections:

O  Unified CCMP Database Server Properties: Contains the publisher and subscriber Unified CCMP
database details.

O Distributor Properties: Contains the SQL Server Replication distributor properties.

The default values shown in the Setup tab are derived from the values initially configured in the Cluster
Configuration tool and are suitable in most cases.

4. If required, modify the Unified CCMP Database Server Properties.

O  Server Name (publisher and subscriber): This is the value specified in ICE Cluster Configuration and
cannot be changed in Replication Manager.

O Catalog Name (publisher and subscriber): This is the value specified in ICE Cluster Configuration. It
may be changed, but if so, a valid database with the new name must already exist on the corresponding
server.

5. To replicate the Identity Server Database, select the Identity Database Replication Enabled checkbox.
This option is selected by default.

6. If required, modify the distributor properties.

O Server Name: The name of the subscriber server hosting the Unified CCMP database. This is the value
specified in ICE Cluster Configuration and cannot be changed in Replication Manager.

O Catalog Name: The name to be assigned to the distribution database. The name is commonly
distribution_portal.
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O Data Folder: The folder path on the distributor server where the data file for the distribution database
will be created.

Note: If you are setting up replication after performing an upgrade, be particularly careful with the Data
*—/ Folder path, as it may be different from the value used in previous versions of Unified CCMP. Make sure
you use the path that was specified when the database was set up. This does not apply for in-place

upgrades.

O Log Folder: The folder path on the distributor server where the transaction log file for the distribution
database will be created.

O Distribution Share: The distribution share folder where replication snapshot files will be generated.

O Override Distributor Admin Password: Select to override the auto-generated replication password
which is used to establish connectivity. The auto-generated password is 14 characters long, and contains
alpha-numeric characters (both upper and lower case) and a special character. If this does not meet the
complexity requirements of the server then select this option and specify a password of your choice.

When you have set the required replication properties, click Configure to configure replication.

You may be prompted to save pending changes to the database before continuing. If so, click Yes to save
pending changes and continue.

It may take several minutes to configure replication. Once replication has been configured, the Replication
Manager automatically switches to the Monitor tab, which enables you to monitor the progress of the
replication snapshot.

Monitoring the Replication Snapshot

@ Note: The subscriber Database Server is not available for use until the replication snapshot has
¥/ completed and all the data has been copied from the publisher to the subscriber.

The time taken for the replication snapshot to complete depends on the volume of data in the publisher database
and the bandwidth between the servers. For a large database, this may take several hours.

To monitor the progress of the replication snapshot:

1.

In the ICE Replication Manager, select the Monitor tab. The Monitor tab has the following panes:

O Publications lists the publisher servers and the publications on each publisher that need to be shared
with the subscribers.

O  Subscriptions and Agents shows the subscriptions to a publication and the replication agents
associated with a publication. This pane has two tabs, Subscriptions and Agents.

e Subscriptions shows the subscriptions to the selected publication. You can right-click on a
subscription to start or stop the subscription.

e Agents shows the replication agents associated with the selected publication. You can right-click on
a replication agent to start or stop the agent.

O  Sessions shows all sessions for the selected publication and replication agent in the last 24 hours.

O Actions shows the activity for the selected session.
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2. In the top left-hand pane, select the first Unified CCMP database publication from the list of publications. If
you have used the default database name, this starts with [Portal].

3. Wait for the replication snapshot for this publication to complete.

To check the replication status for a Unified CCMP database publication, in the bottom right hand pane of
the Monitor tab, inspect the messages in the Action Message list. Once the replication snapshot is complete
and replication is operational for a publication, you will see the following two messages:

“Delivered snapshot from . . . "
“No replicated transactions are available”.

After this, the second message is replaced with messages showing new replicated transactions as they are
sent through the system, for example:

“4 transaction(s) with 14 command(s) were delivered”.
4. Repeat the two steps above for each of the remaining Unified CCMP database publications.
5. When replication is complete for all portal database publications, close the ICE tool.

The subscriber database can now be used to service requests. For more information about the Replication
Manager see the Integrated Configuration Environment (ICE) for Cisco Unified Contact Center Management
Portal.

Post-Upgrade Tasks

After you have upgraded Unified CCMP, complete the following post-installation steps:
» Configure HTTPS as described in “Configuring SSL” on page 82.
» Bind server ports to IPv6 addresses as described in “Binding Server Ports to IPv6 Addresses” on page 84

» Complete the final post-installation actions described in “Final Post-Installation Actions” on page 87.

8: Note: If your installation uses single sign-on, the configuration is restored when the database is
¥/ restored, so you do not need to reconfigure single sign-on as described in “Configuring Windows Login”
on page 69.

Restarting the Unified CCMP Services

Following an upgrade it is a good practice to restart all Unified CCMP services.

Repeat the following steps on each upgraded Unified CCMP Database Server and each and upgraded Unified
CCMP App/Web Server.

To restart the Unified CCMP services:
1. Launch the Integrated Configuration Environment (ICE) tool.
2. In the Database Connection window, provide the database connection details and click OK.

3. From the Tool dropdown, select Service Manager.
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4. Select all the Unified UCCMP Services and click Start Selected.

5. A dialog box appears to state that all the services are started. Click Close.

@ Note: After starting the System Monitoring Service and Application Service on the App/Web Server, you
*/ will need to wait a few minutes before logging in to allow the services to load completely.

Validating the Upgrade

After you have upgraded your installation of Unified CCMP, check that the system is functional following the

upgrade with the following tests.

Check

Success Criteria

Unified CCE Provisioning Tests

Log in to the web application on Side A and create a new Skill Group.
This tests provisioning from the Side A App/Web Server. Run this test
against each configured Unified CCE instance.

The Skill Group should be successfully
created, and visible on Side A, and, if
applicable, Side B.

Log in to the web application on Side A and create a new Agent. This
tests provisioning from the Side A App/Web Server. Run this test
against each configured Unified CCE instance.

Create a new Skill Group on the AW using the Cisco Skill Group
Explorer tool. Wait a few minutes and check that the Skill Group has
been imported into Unified CCMP.

The Agent should be successfully created
and visible on Side A, and, if applicable, Side
B.

The Skill Group should be visible on Side A,
and, if applicable, on Side B.

Log in the application on Side A and create a new Precision Queue.
This tests provisioning from the Side A App/Web Server. Run this test
against each configured Unified CCE instance.

CUCM Provisioning Tests

The Precision Queue should be created
successfully and visible on Side A, and if
applicable on, Side B

Log in to the web application on Side A and create a new IP Phone.
This tests Unified Communications Manager provisioning from the Side
A App/Web Server.

Replication Tests (dual-sided installations only)

The IP Phone should be successfully
created, and be visible on Side A, and, if
applicable, on Side B.

Log in to the web application on Side B and create a new Skill Group.
This tests Unified CCE provisioning from the Side B App/Web Server.
Run this test against each configured Unified CCE instance.

Create a new Skill Group on the AW using the Cisco Skill Group
Explorer tool. Wait a few minutes and check that the Skill Group has
been imported into Unified CCMP.

The Skill Group should be successfully
created, and visible on Side A.

The Skill Group should be visible on Side A
and Side B.

Log in to the web application on Side B and create a new IP Phone.
This tests Unified Communications Manager provisioning from the Side
B App/Web Server.

The IP Phone should be visible on Side A and
Side B.
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Check Success Criteria

CVP Media file upload

Log in to the web application on Side A and create a new Media file. The media file should be uploaded

This test provisioning from the Side A App/Web Server and will test the | successfully and visible in the CVP servers.
working of CVP media upload. Run this test against each configured

Unified CCE instance.
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About a Split-Sided Upgrade

This chapter describes the steps involved to upgrade a dual-sided deployment, where the system is split, and one
side is upgraded at a time. Until the second side is upgraded, you will be running two different versions of
Unified CCMP side by side.

This upgrade process temporarily disconnects the replication and communication channels between the two sides
of the system, so each side can operate independently as a single-sided system.

7 Note: Use this mode of operation with caution. Unified CCE and Unified Communications Manager
@ changes committed to Side B will be imported from the AW onto Side A, but any Unified CCMP specific
configuration items (for example folders, users, security etc.) that are added, changed or deleted on Side
B after the system was split will not be reflected on Side A, even after side B is upgraded and replication
is restored.
Do not make any Unified CCMP specific changes during the upgrade. Limit changes to provisioning and
re-skilling on Unified CCE during the upgrade as the same will be replicated once the upgrade is done.

This process has two parts.

» Part 1: Split the dual-sided system and upgrade Side A (see “Checklist for Split-Sided Upgrades (Side A)”
on page 120).

» Part 2: Upgrade Side B and restore replication (see “Checklist for Split Side Upgrades (Side B)” on
page 130).

The description assumes that you have a two-tier deployment (separate Database and Application/Web servers).

5\ Important: Ensure that you have up-to-date backups of all Unified CCMP databases before you
:Y begin the upgrade. Instructions for doing this are included here.

Note: Before starting the upgrade, please ensure you have the original cryptographic passphrase from
%/ the original Unified CCMP installation as you will need it during the upgrade.

Checklist for Split-Sided Upgrades (Side A)

The first part of the split-side upgrade splits the dual-sided system and upgrades Side A.
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For Upgrades on New Servers

Step Complete

Acquiring and Preparing New Windows 2022 Servers on page 124

(Task to be performed outside the downtime)

“Preparing to Upgrade” on page 122

Updating Folder Names in Resource Manager

Stop the Unified CCMP services for Side A and Side B

Remove database replication

Update Side B to enable provisioning and import

Start the Unified CCMP services for Side B on existing servers

Backup the Unified CCMP Portal Database from Side A Database Server

Backup the Unified CCMP Identity Database from Side A Database Server

Restore the Portal and Identity databases on new Side A Database Server

Configure the SQL Agent user (Side A)

Add network service accounts (Side A)

“Upgrading and Configuring Unified CCMP Components (Side A)” on page 128

Install the Database Components

Upgrade the portal database

Install the App/Web Server

Install the Identity Server

For In-Place Upgrades

Step Complete

“Preparing to Upgrade” on page 122

Updating Folder Names in Resource Manager

Stop the Unified CCMP services for Side A and Side B

Remove database replication

Update Side B to enable provisioning and import

Start the Unified CCMP services for Side B on existing servers

Virtual Machine Snapshot for CCMP servers
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Step Complete

Uninstalling CCMP components of Side A

Upgrade 0S to Windows 2022 and SQL server to 2022 of Side A and B

“Upgrading and Configuring Unified CCMP Components (Side A)” on page 128

Install the Database Components

Upgrade the portal database

Install the App/Web Server

Install the Identity Server

Reconfigure the Unified CCMP servers

Reconfigure the Unified CCE Servers

Configure SSL

Restart the Services

Log in to Unified CCMP

Validate the upgrade

Preparing to Upgrade

Refer to this section about the necessary preparation steps when preparing to upgrade Side A.

Updating Folder Names in Resource Manager

» In Resource Manager, the following characters are not allowed in folder names: Space, Dot (.), tilde (~),
hyphen (-), underscore (_), curly bracket {}, circle bracket (), hash (#), single quote (). You must update the
folder names before upgrading.

Stopping the Unified CCMP Services (For Side A and B)

Before starting the upgrade, you must stop all Unified CCMP services on all servers.

To stop the services on the Database Server:

1. Launch the Integrated Configuration Environment (ICE) tool.

2. In the Database Connection window, provide the database connection details and click OK.
3. From the Tool dropdown, select Service Manager.
4

Select all the Unified CCMP Services of Side A and B and click Stop Selected.
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5.

A dialog box appears to state that all the services are stopped. Click Close.

Removing Database Replication

Before you can upgrade a dual-sided system, database replication must be removed.

To remove database replication:

1.

S

Ensure you are logged in to the Side A Database Server as a domain level user with administrative rights
over both Database Servers.

Launch Integrated Configuration Environment (installed as part of Unified CCMP). In the Database
Connection dialog box, set:

O  Server Name: Enter the name of the primary database server.

o Port: Provide database server SQL non-default Port. By default the value is set as 1433. This field has
been introduced in CCMP 15 ES202603.

O Database Name: Enter the name of the Unified CCMP database that was installed when setting up the
Database Component. If you accepted the default value, this is Portal.

O  Authentication: Select Windows Authentication.

Click OK. The ICE Cluster Configuration tool starts by default.
From the Tool dropdown list, select Replication Manager.
Click the Setup tab to see the replication setup details.

Click Disable to remove replication from the Unified CCMP database. When prompted, click Yes to proceed
with replication removal.

Replication removal may take several minutes. Wait for the 'Replication Removed' message to display
in the Output window and then exit ICE.

Updating Side B to Enable Provisioning and Importing

If the sides of the system are to be run independently for some time, you may need to enable provisioning and
import to run on both Side A and Side B at the same time.

To update Side B to enable provisioning and importing:

4

Follow the steps described in the “Database Server Component Failover” section of the Administration
Guide for Cisco Unified Contact Center Management Portal for the version of Unified CCMP that is
currently running on the Side B Database Server.

Starting the Unified CCMP Services (Side B)

Start the Unified CCMP Services of Side B.

Note: At this point Side B on old servers is available for use.
{ o >
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To start the services on the Database Server:

1. Launch the Integrated Configuration Environment (ICE) tool from Side B database Server.
2. In the Database Connection window, provide the database connection details and click OK.
3. From the Tool dropdown, select Service Manager.

4. Select all the Unified UCCMP Services of Side B and click Start Selected.

5

A dialog box appears to state that all the services are started. Click Close.

Pre-Upgrade Tasks Specific to New Server Upgrades

Acquiring and Preparing New Windows 2022 Servers

Perform steps as mentioned in “Acquiring and Preparing New Windows 2022 Servers” on page 96

Backing up the Portal Database (Side A)

7 Note: Skip this task if you performing in-place upgrade on existing Side A servers.
< [ )

Back up the Portal database and copy the backup to a safe location where it can be accessed once the latest
version of Unified CCMP has been installed on the new servers.

To back up the Portal database:

1. Launch SQL Server Management Studio.

2. Navigate to the Portal database.

3. Right-click Portal and select Tasks > Backup. Save the.bak file to a suitable location.
4

Close SQL Server Management Studio.

Backing up the Identity Database (Side A)

Note: Skip this task if you performing in-place upgrade on existing Side A servers.
< . )

Back up the Identity database and copy the backup to a safe location where it can be accessed once the latest
version of Unified CCMP has been installed on the new servers.

To back up the identity database:
1. Launch SQL Server Management.

2. Navigate to the Identity database.

124 Installation and Configuration Guide for Cisco Unified Contact Center Management Portal



3. Right-click the Identity database (IdSvr3Config) and select Tasks > Backup. Save the .bak file to a
suitable location.

4. Close SQL Server Management Studio.

Restoring the Portal and Identity Databases (Side A)

Restore the Side A portal and Identity database from the Side A backup you made earlier.

Note: Skip this task if you performing in-place upgrade on existing Side A servers. Perform this task on
%/ the new servers prepared for Side A..

To restore the databases:

On the Side A New Database Server:

1. Launch SQL Server Management Studio.

2. Right-click the Databases folder and click Restore Database.

3. In the Restore Database window choose From Device, click Add and add the location of the database back
up file you want to restore from. You may need to copy the backup file to a local file in order to access it.
Click OK.

4. Select the check-box next to the backup set you just added.
5. From the To Database drop-down list, select the Portal database as the restore destination.

6. Select Options and choose Overwrite the existing database. This will restore the database to the same
location as the previous database. If you would like to choose a different location, update the Restore As
path for each file to your preferred data file location.

7. Click OK to start the restore.

Configuring the SQL Agent User (Side A)

The SQL Agent User must be reconfigured on the new server for dual-sided system.

7 Note: Skip this task if you performing in-place upgrade on existing Side A servers. Perform this task on
¥/ the new servers prepared for Side A.

To configure the SQL agent user:
1. Launch SQL Server Management Studio and expand the Security folder. A list of subfolders is displayed.
2. Right-click the Logins folder and select New Login.

3. Ensure the Windows authentication option is selected and enter the SQL Agent User domain and login
name in the form <DOMAIN>\<LOGIN>. This should be the user name that you specified for the SQL agent
user account when you originally installed the portal database. For example, if your user is called
sql_agent_user and belongs to the CISCO domain, enter CISCO\sql_agent_user.

4. In the Select a page pane on the left-hand side, click User Mapping.
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5. In the Users mapped to this login section, select the Portal database. The User column will auto-populate
with the domain user name for the SQL Agent User.

6. In the Database Role Membership section, select the db_owner role.

7. Click OK to apply the changes.

Adding Network Service Accounts (Side A)

You must add the NETWORK SERVICE account for all web servers to the database logins with appropriate
access permissions. Before this can be done, the existing accounts must be deleted from the Portal database
logins.

Note: Skip this task if you performing in-place upgrade on existing Side A servers. Perform this task on
¥/ the new servers prepared for Side A.

To add network service accounts:

1. Launch SQL Server Management Studio and in the Object Explorer, expand the Portal database. A list of
folders is displayed.

2. Expand the Portal > Security > Users folder. A list of database logins is displayed.

3. For each occurrence of the NETWORK SERVICE account for a remote web server in the deployment, right-
click it and select Delete.

Do not delete the entry for the NETWORK SERVICE account for the local machine (NT
AUTHORITY\NETWORK SERVICE).

The NETWORK SERVICE logins for remote web server machines in the deployment are of the form
<DOMAIN>\<WEBSERVER MACHINE NAME>$. For example, if your web server is called WEBSERVERA
and belongs to the UCCMPDOM domain, the NETWORK SERVICE login would be UCCMP\WEBSERVERAS.

4. In the Object Explorer, expand the top-level Security folder. A list of folders is displayed.
5. Right-click the Logins folder and select New Login.

6. Ensure the Windows authentication option is selected and enter the NTAUTHORITY\NETWORK SERVICE
account for the Side A web server in the form <DOMAIN>\<WEBSERVER MACHINE NAME>$.

7. In the Select a page pane on the left-hand side, click User Mapping.

8. In the Users mapped to this login section, select the Portal database.

9. Ensure that the User column correctly contains the Network Service account for the web server.
10. In the Database Role Membership section, select the portalapp role.

11. Click OK.

12. For deployments with multiple web servers, repeat step 5. to step 11. for each additional web server.
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Pre-Upgrade Tasks specific to In-place Upgrades

Virtual Machine Snapshot for CCMP servers (side A)

To revert to the previous versions that existed before you did in-place upgrade of installations to Release 15,
perform one of the following tasks on Side A servers:

1. Take a Virtual Machine Snapshot in the powered off state before the upgrade.
2. Clone the Virtual Machine before the upgrade.

Delete these snapshots or clones after the upgrades are successfully completed. Such deletions will prevent
performance issues

Uninstalling CCMP components

Perform the following steps only if you are doing in-place upgrade,

Uninstalling Identity Component

» Perform steps on existing server as mentioned in “Uninstalling Identity Component” on page 150

Uninstalling Application Server Component

» Perform steps on existing server as mentioned in “Uninstalling Application Server Component” on page 150

Uninstalling Database Server Component

» Perform steps on existing server as mentioned in “Uninstalling the Database Component” on page 150

Uninstalling Common Server Component

» Perform steps on existing server as mentioned in “Uninstalling the Common Component” on page 151

Upgrade Operating System to Windows 2022 and SQL server to 2022

» Perform steps as mentioned in “Upgrading Windows Server 2019 to Windows Server 2022 for Existing
Deployments” on page 97

» Perform steps as mentioned in “Upgrading SQL Server 2019 to SQL Server 2022 for Existing Deployment”
on page 98
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Upgrading and Configuring Unified CCMP
Components (Side A)

Note: Perform the following steps on existing side A servers in case of in-place upgrade or on the new

¥/ Side A servers if you are using new servers for upgrade.

Installing the Database Components

» Follow all steps in the section “Installing the Database Components” on page 44.

Upgrading the Portal Database

Note: Perform the following steps on existing side A servers in case of in-place upgrade or on the new

%/ Side A servers if you are using new servers for upgrade.

Note that the Identity Database is automatically upgraded along with the Portal Database.

To upgrade the portal database:

1. If you selected the Launch Database Management Utility check box when you installed the database
components, the Database Installer starts automatically after the installation. Otherwise, launch Unified
CCMP Database Installer. The Database Installer is a wizard which guides you through the steps to upgrade
the database.

2. Click Next to begin the upgrade process.

3. In the Select An action to Perform window choose Upgrade an Existing Database. Click Next to
continue.

4. In the SQL Server Connection Details window, take provide the following:

o

Server Name: Select the Microsoft SQL Server where the Unified CCMP database is located. In this
case this is the machine running the application, and so it must be left as the default (local).

Port: Provide database server SQL non-default Port. By default the value is set as 1433. This field has
been introduced in CCMP 15 ES202603.

Database Name: Enter or select the name of the database catalog that was originally used for the
Unified CCMP database.

Connect Using: Select the login credentials you want to use:
e The Windows account information I use to logon to my computer

e The Microsoft SQL Server login information assigned by the system administrator: Only
select this option if you are using a database catalog on a different domain. For this option you
must enter your Login Name and Password in the fields provided.

Test Connection: Click to make sure the connection to the Microsoft SQL Server is established. If you
see the message Connection succeeded but database does not exist, then you must rectify this
problem before continuing. Check that the database catalog name and security credentials are correct.
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When the database connection details have been tested and the connection is successful, click Next. A

warning message may appear notifying about unpartitioned old audit data. Click Yes to clear the data now,
or click No to continue the database upgrade as normal.

5. Click Next to perform the upgrade. The upgrade may take several minutes.

6. When the Portal database upgrade is complete, click Close to close the Database Installer.

Installing the Application/Web Server
Perform this task on the Side A App/Web Server.

» Follow all steps in the section “Installing the Application and Web Server” on page 48.

Installing the Identity Server
Perform this task on the Side A App/Web Server.

» Follow all steps in the section “Installing the Identity Server” on page 49.

Tasks specific to In-Place Upgrades

Reconfigure the Unified CCMP servers on Side A

» Perform this task on Side A server if you are performing in-place upgrade.

» Follow all the steps in the section “Upgrading and Configuring Unified CCMP Components (Side B)” on
page 136

Reconfigure the Unified CCE Servers on Side A

» Perform this task on Side A server if you are performing in-place upgrade.

» Follow all the steps in the section “Reconfiguring the Unified CCE Servers” on page 138

Configure SSL on Side A

» Perform this task on Side A server if you are performing in-place upgrade.

» Follow all the steps in the section “Configure SSL on Side A” on page 129

Restart the Services of Side A

» Perform this task on Side A server if you are performing in-place upgrade.

» Follow all the steps in the section “Restart the Services of Side A” on page 129
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Log in to Unified CCMP on Side A

»  Perform this task on Side A server if you are performing in-place upgrade.

» Follow all the steps in the section “Log in to Unified CCMP on Side A” on page 130

Validate the upgrade (Side A)

» Perform this task on Side A server if you are performing in-place upgrade.

» Follow all the steps in the section “Validating the Upgrade (Side A and Side B)” on page 143

Checklist for Split Side Upgrades (Side B)

The second part of the split side upgrade applies the upgrade to Side B and restores replication. Many of the
steps used in upgrading Side A apply to Side B. Unless otherwise noted, refer to the preparation steps for Side A
for each of the sections that follow.

For Upgrades on New Servers

Step Complete

“Pre-Upgrade Tasks Specific to New Server Upgrades” on page 132

Backup the Unified CCMP Portal Database

Backup the Unified CCMP Identity Database

Restore the Upgraded Side A Portal and Identity Databases

Configure the SQL Agent user

Add network service accounts

“Upgrading and Configuring Unified CCMP Components (Side B)” on page 136

Install the Database Components

Install the App/Web Server

Install the identity server

Reconfigure the Unified CCMP servers

Reconfigure Unified CCE to Use the New Servers

“Restoring Replication” on page 140

Configure Replication

Monitor the replication snapshot
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Step Complete

“Post-Upgrade Tasks” on page 142

Bind Server Ports to IPv6 Addresses

Configure SSL

Restart the system

Log in to Unified CCMP

Verify the Installation

Restart the Unified CCMP Services

Validate the upgrade

Stop the Unified CCMP Services on old Side B servers

For In-Place Upgrades

Step Complete

“Pre-Upgrade Tasks specific to In-place Upgrades” on page 134

Switch application users to Side A before starting Side B upgrade.

Backup the Unified CCMP Portal Database

Backup the Unified CCMP Identity Database

Stopping the Unified CCMP Services

Virtual Machine Snapshot for CCMP servers

Uninstalling CCMP components of Side B

Upgrade 0S to Windows 2022 and SQL server to 2022 for Side A and B

Restore the Upgraded Side A Portal and Identity Databases

“Upgrading and Configuring Unified CCMP Components (Side B)” on page 136

Install the Database Components

Install the App/Web Server

Install the identity server

Reconfigure the Unified CCMP servers

Reconfigure the Unified CCE Servers

“Restoring Replication” on page 140

Configure Replication
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Step Complete

Monitor the replication snapshot

“Post-Upgrade Tasks” on page 142

Bind Server Ports to IPv6 Addresses

Configure SSL

Restart the system

Log in to Unified CCMP

Verify the Installation

Restart the Unified CCMP Services

Validate the upgrade

Stop the Unified CCMP Services on old Side B servers

Preparing to Upgrade (Side B)

Pre-Upgrade Tasks Specific to New Server Upgrades

Backing up the Upgraded Side A Portal Database
Back up the upgraded Side A Portal database and copy the backup to a safe location where it can be accessed

once the latest version of Unified CCMP has been installed on the new servers.

To back up the portal database on the selected database server:

» Follow the steps outlined in “Backing up the Portal Database (Side A)” on page 124. You must back up the
upgraded Side A database.

Backing up the Upgraded Side A Identity Database

Back up the upgraded Side A Portal database and copy the backup to a safe location where it can be accessed
once the latest version of Unified CCMP has been installed on the new servers.

» Follow the steps outlined in “Backing up the Identity Database (Side A)” on page 124.
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Restoring the Upgraded Side A Portal and Identity Databases (Side B)

8: Note: Perform this task on existing Side B server if you are doing in-place upgrade or on new side B
*—/ server if you installing on new servers.

Restore the upgraded Side A portal (page 134) and Identity (page 134) database from the Side A back-up you
made earlier.

To restore the databases:

On the Side B New Database Server:

1.
2.
3.

Launch SQL Server Management Studio.
Right-click the Databases folder and click Restore Database.

In the Restore Database window choose From Device, click Add and add the location of the database back
up file you want to restore from. You may need to copy the backup file to a local file in order to access it.
Click OK.

Select the check-box next to the backup set you just added.
From the To Database drop-down list, select the Portal database as the restore destination.

Select Options and choose Overwrite the existing database. This will restore the database to the same
location as the previous database. If you would like to choose a different location, update the Restore As
path for each file to your preferred data file location.

Click OK to start the restore.

Configuring the SQL Agent User (Side B)

To configure the SQL agent user:

On the Side B Database Server, follow the steps outlined in “Configuring the SQL Agent User (Side A)” on
page 125. Perform this task on the new servers prepared for Side B.

Adding Network Service Accounts (Side B)

4

Follow the steps outlined in “Adding Network Service Accounts (Side A)” on page 126. Perform this task on
the new servers prepared for Side B.
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Pre-Upgrade Tasks specific to In-place Upgrades

Switch application users to Side A before starting Side B upgrade

After Side A upgrade is successful and validation is completed, move the application user terrific to Upgraded
side A before starting Side B Upgrade.

Backing up the Upgraded Side A Portal Database

Back up the upgraded Side A Portal database and copy the backup to a safe location where it can be accessed
once the latest version of Unified CCMP has been installed on the new servers.

To back up the portal database on the selected database server:

» Follow the steps outlined in “Backing up the Portal Database (Side A)” on page 124. You must back up the
upgraded Side A database.

Backing up the Upgraded Side A Identity Database

Back up the upgraded Side A Portal database and copy the backup to a safe location where it can be accessed
once the latest version of Unified CCMP has been installed on the new servers.

» Follow the steps outlined in “Backing up the Identity Database (Side A)” on page 124.

Stopping the Unified CCMP Services

Before starting the upgrade, perform the following steps on the Side A database servers to stop all Unified
CCMP services running on both sides.

To stop the Unified CCMP Database Server services:

1. Launch the Integrated Configuration Environment (ICE) tool.

2. In the Database Connection window, provide the database connection details and click OK.
3. From the Tool dropdown, select Service Manager.

4. Select all the Unified CCMP Services and click Stop Selected.

5

A dialog box appears to state that all the services are stopped. Click Close.

Virtual Machine Snapshot for CCMP servers

To revert to the previous versions that existed before you did in-place upgrade of installations to Release 15,
perform one of the following tasks:

1. Take a Virtual Machine Snapshot in the powered off state before the upgrade.

2. Clone the Virtual Machine before the upgrade.
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Uninstalling CCMP components of Side B

Perform the following steps only if you are doing in-place upgrade,

Uninstalling Identity Component

» Perform steps on existing server as mentioned in “Uninstalling Identity Component” on page 150

Uninstalling Application Server Component

» Perform steps on existing server as mentioned in “Uninstalling Application Server Component” on page 150

Uninstalling Database Server Component

» Perform steps on existing server as mentioned in“Uninstalling the Database Component” on page 150

Uninstalling Common Server Component

» Perform steps on existing server as mentioned in“Uninstalling the Common Component” on page 151

Upgrade Operating System to Windows 2022 and SQL server to 2022

» Perform steps as mentioned in “Upgrading Windows Server 2019 to Windows Server 2022 for Existing
Deployments” on page 97

» Perform steps as mentioned in “Upgrading SQL Server 2019 to SQL Server 2022 for Existing Deployment™
on page 98

Restoring the Upgraded Side A Portal and Identity Databases (Side B)

7 Note: Perform this task on existing Side B server if you are doing in-place upgrade or on new side B
@'ﬁ server if you installing on new servers.

Restore the upgraded Side A portal (page 134) and Identity (page 134) database from the Side A back-up you
made earlier.

To restore the databases:

On the Side B New Database Server:

1. Launch SQL Server Management Studio.

2. Right-click the Databases folder and click Restore Database.

3. In the Restore Database window choose From Device, click Add and add the location of the database back
up file you want to restore from. You may need to copy the backup file to a local file in order to access it.
Click OK.

4. Select the check-box next to the backup set you just added.
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5. From the To Database drop-down list, select the Portal database as the restore destination.

6. Select Options and choose Overwrite the existing database. This restores the database to the same
location as the previous database. If you would like to choose a different location, update the Restore As

path for each file to your preferred data file location.

7. Click OK to start the restore.

Upgrading and Configuring Unified CCMP
Components (Side B)

Installing the Database Components (Side B)

To install the database components on the Side B Database Server:

Perform this task on the Side B database server.

» On the Side B Database Server, follow the steps outlined in “Installing the Database Components” on

page 128.

Installing the Application/Web Server (Side B)

To install the Application/Web Server:
Perform this task on the Side B App/Web Server.

» Follow the steps outlined in “Installing the Application and Web Server” on page 48.

Installing the Identity Server (Side B)
Perform this task on the Side B App/Web Server.

» Follow all steps in the section “Installing the Identity Server” on page 49.

Reconfiguring the Unified CCMP Servers

8 : Note: This step is only required if you have reinstalled Unified CCMP on new servers with different
%/ names. This step is not required if you have upgraded your existing servers, or have replaced your
existing servers with new servers with the same names.

If the Unified CCMP server names have changed, the Unified CCMP cluster configuration must be updated to

reference the new server names.

This only needs to be done on the Side A Database Server. These steps do not need to be repeated on the Side B

Database Server as the necessary changes are applied when replication is reinstated.
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To update the cluster configuration:

1.

10.

Launch Integrated Configuration Environment (installed as part of Unified CCMP). In the Database
Connection dialog box, set:

O Server Name: Enter the name of the primary database server.

O Port: Provide database server SQL non-default Port. By default the value is set as 1433. This field has
been introduced in CCMP 15 ES202603.

O Database Name: Enter the name of the Unified CCMP database that was installed when setting up the
Database Component. If you accepted the default value, this is Portal.

o Authentication: Select Windows Authentication.

Click OK. The ICE Cluster Configuration tool starts by default.

Note: If the Unified CCMP server names have changed, several errors may be reported when ICE starts
%/ for the first time after an upgrade. The steps in this section will fix the errors.

Select the Setup tab and click Setup UCCMP Servers to start the wizard. Click Next to go through each
window in turn.

On the various Configure Servers pages, change the existing server name for each of the Unified CCMP
servers to the new server name. The number of pages and servers to specify will depend on your deployment
type. On each page, enter the following, then click Next:

o Primary Server:
e Server Name: This is the non-domain qualified machine name.

e Server Address: This defaults to Server Name. This can be changed to an IP Address or a domain
qualified name of the server.

e Port: Provide database server SQL non-default Port. By default the value is set as 1433. This field
has been introduced in CCMP 15 ES202603.

O  Secondary Server: If you chose a dual-sided setup, provide the corresponding details for the Side B
server.

Click Next and enter the relevant server information for each Unified CCMP server until you reach one of
the following pages: Primary Database Administrator Login, Secondary Database Administrator Login or
Configure Relational Database Connection.

Click Next to go through the remaining windows in turn, without changing anything.

When you see the confirmation message indicating that the wizard has completed successfully, click Exit to
close the wizard.

To save and action your changes, either click the Save icon in the tool bar or select File > Save from the
menu.

In ICE, select the Servers tab. The list of servers will show both the old servers and the new servers. Right-
click each of the old servers and select Remove Server.

To save and action your changes, either click the Save icon in the tool bar or select File > Save from the
menu. Exit ICE.
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Reconfiguring the Unified CCE Servers

138

Note: This step is only required if you have upgraded Unified CCE at the same time as upgrading Unified
¥/ CCMP. This step is not required if you have not upgraded Unified CCE.

If you have upgraded Unified CCE at the same time as upgrading Unified CCMP, the Unified CCMP cluster
must be updated to ensure that Unified CCMP can communicate with Unified CCE. It may also be necessary to
configure the Unified CCE Config Web Service, which wasn't present in some earlier versions of Unified CCE.

To reconfigure the Unified CCE servers after Unified CCE has been upgraded:

1. Launch Integrated Configuration Environment (installed as part of Unified CCMP). In the Database
Connection dialog box, set:

O Server Name: Enter the name of the primary database server.

O Port: Provide database server SQL non-default Port. By default the value is set as 1433. This field has
been introduced in CCMP 15 ES202603.

O Database Name: Enter the name of the Unified CCMP database that was installed when setting up the
Database Component. If you accepted the default value, this is Portal.

O Authentication: Select Windows Authentication.
2. Click OK. The ICE Cluster Configuration tool starts by default.
3. Select the Setup tab and click Configure Cisco Unified CCE Servers to start the wizard.

4. On the Select Task page, select Modify an existing instance. Select the Unified CCE instance that has been
updated, and click Next to go through each page in turn.

5. If you see the Configure Primary Unified Config Web Service page, enter or confirm the following
details:
O URL: This is the auto-generated URL of the primary Unified Config Web Service on the Unified CCE.

O User Name: This is a user name with appropriate access to the Unified CCE that the web service is
running on. This user must be in the domain security group <Server>_<UCCE-Instance>_Config,
where <Server> is the name of the server running Unified CCE and <UCCE-Instance> is the name
of the Unified CCE Instance on this server.

o Password: This is the password for the user.

6. If you see the Configure Primary ConAPI RMI Ports page, enter or confirm the following ConAPI details:

O Local Registry Port: This is the port on the Unified CCE for the Unified CCMP Provisioning service
to connect to. This will usually be 2099.

O Remote Registry Port: This is the port on the Unified CCMP Database Server for the Unified CCE to
connect to. This will usually be 2099.

O Local Port: This is selected as the designated port for live provisioning traffic between the Unified
CCE and Unified CCMP servers. It must be uniquely assigned for each Unified CCE and any firewalls
between the Unified CCE and Unified CCMP server must be configured to allow both-way traffic on
this port.

7. If you see the Configure ConAPI Application Instance page enter the following details:

O Application Name: The name of the application to be used for provisioning Unified CCE from Unified
CCMP. Specify the name of the application you configured in “Setting Up ConAPI” on page 74.
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10.

11.

12.

13.

14.

O  Application Key: Use the password for the application you specified above.

On the Multi Media Support page, select Yes to provide support for non-voice interactions. The default
value is No.

On the Purge On Delete page, if you want to purge items from Unified CCE automatically when they are
deleted from Unified CCMP, select Yes. The default is Yes.

On the Configure Active Directory Global Catalog Connections page, provide the details of active
directory global catalog and configure the security settings to connect.
The Summary dialog box summarizes the details of the Unified CCE being configured and the settings you

have chosen. Check the details, and if you are satisfied, click Next.

A confirmation message is displayed to indicate that the wizard has completed successfully. Click Exit to
close the wizard.

For each remaining Unified CCE Server that has been upgraded, click Configure Cisco Unified CCE
Servers, and repeat the steps above.

To save and action your changes, either click the Save icon in the toolbar or select File > Save from the
menu.

Reconfigure Unified CCE to Use the New Servers

Note: This step is only required if you have reinstalled Unified CCMP on new servers with different
@'ﬁ names. This step is not required if you have upgraded your existing servers, or have replaced your
existing servers with new servers with the same names.

If you have reinstalled Unified CCMP on new servers with different names, Unified CCE must be updated to
reference the new Unified CCMP servers.

To reconfigure Unified CCE to use new servers:

Do this task on each Unified CCE instance in your Side A deployment.

1.
2.
3.

Launch CMS Control. This opens the CMS control console.
On the Application tab, select the Unified CCMP database server and click Edit.

In the Application connection details tab, change the existing server name to the new server name. There are
three places where this needs to be done:

O Administration & Data Server Link: The name of the new Unified CCMP Database Server, in upper
case, with Server appended. For example, if your Database Server is PRODUCTDB, enter
PRODUCTDBServer.

O Application link: The name of the new Unified CCMP Database Server, in upper case, with Client
appended. For example, if your Database Server is PRODUCTDB, enter PRODUCTDBCLlient.

O  Application host name: The name of the new Unified CCMP Database Server, in capital letters, for
example, PRODUCTDB.

Click OK, then OK again to save the changes and exit the CMS Control console.
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Stopping the Unified CCMP Services (For Side A and B)

» Stop Side A and Side B service to enable replication.

Restoring Replication

Note: Before you start restoring replication, ensure that all the Unified CCMP services are in stopped
@’* state.

Configuring Replication

Replication between the databases is set up and monitored using the Replication Manager application which is
available in the Unified CCMP Integrated Configuration Environment (ICE) tool.

Note: The user running Replication Manager must have administrator permissions in both Windows and
¥/ SQL Server, for both the publisher and the subscriber Database Servers.

Usually, the publisher will be the Side A Database Server, but occasionally, it may be necessary to configure the
Side B Database Server as the publisher.

To configure replication:

1. Launch Integrated Configuration Environment (installed as part of Unified CCMP). In the Database
Connection dialog box, set:

O  Server Name: Enter the name of the primary database server.

o Port: Provide database server SQL non-default Port. By default the value is set as 1433. This field has
been introduced in CCMP 15 ES202603.

O Database Name: Enter the name of the Unified CCMP database that was installed when setting up the
Database Component. If you accepted the default value, this is Portal.

O Authentication: Select Windows Authentication.
2. Click OK. The ICE Cluster Configuration tool starts by default.

3. From the Tool dropdown list, select Replication Manager. The Replication Manager opens in the Setup
tab. The Setup tab has the following sections:

O Unified CCMP Database Server Properties contains the publisher and subscriber Unified CCMP
database details.

o Distributor Properties contains the SQL Server Replication distributor properties.

The default values shown in the Setup tab are derived from the values initially configured in the Cluster
Configuration tool and will be suitable in most cases.

4. If required, modify the Unified CCMP Database Server Properties.

O  Server Name (publisher and subscriber): This is the value specified in ICE Cluster Configuration and
cannot be changed in Replication Manager.
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O Catalog Name (publisher and subscriber): This is the value specified in ICE Cluster Configuration. It
may be changed, but if so, a valid database with the new name must already exist on the corresponding
server.

5. To replicate the Identity Server Database, select the Identity Database Replication Enabled checkbox.
This option is selected by default.

6. If required, modify the distributor properties.

O  Server Name: The name of the subscriber server hosting the Unified CCMP database. This is the value
specified in ICE Cluster Configuration and cannot be changed in Replication Manager.

O Catalog Name: The name to be assigned to the distribution database. The value should be
distribution_portal.

O Data Folder: The folder path on the distributor server where the data file for the distribution database
will be created.

Note: If you are setting up replication after performing an upgrade, be particularly careful with the Data
¥/ Folder path, as it may be different from the value used in previous versions of Unified CCMP. Make sure
you use the path that was specified when the database was set up. This does not apply for in-place

upgrades.

O Log Folder: The folder path on the distributor server where the transaction log file for the distribution
database is created.

O Distribution Share: The distribution share folder where replication snapshot files are generated.

O Override Distributor Admin Password: Select to override the auto-generated replication password
which is used to establish connectivity. The auto-generated password is 14 characters long, and contains
alpha-numeric characters (both upper and lower case) and a special character. If this does not meet the
complexity requirements of the server then select this option and specify a password of your choice.

7.  When you have set the required replication properties, click Configure to configure replication.

8. You may be prompted to save pending changes to the database before continuing. If so, click Yes to save
pending changes and continue.

9. It may take several minutes to configure replication. Once replication has been configured, the Replication
Manager automatically switches to the Monitor tab, which enables you to monitor the progress of the
replication snapshot.

Monitoring the Replication Snapshot

Note: The subscriber Database Server is not available for use until the replication snapshot has
@'ﬁ completed and all the data has been copied from the publisher to the subscriber.

The time taken for the replication snapshot to complete depends on the volume of data in the publisher database
and the bandwidth between the servers. For a large database, this may take several hours.

To monitor the progress of the replication snapshot:

1. In the ICE Replication Manager, select the Monitor tab. The Monitor tab has the following panes:
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O Publications (top left) lists the publisher servers and the publications on each publisher that need to be
shared with the subscribers.

O Subscriptions and Agents (top right) shows the subscriptions to a publication and the replication
agents associated with a publication. This pane has two tabs, Subscriptions and Agents.

O Subscriptions shows the subscriptions to the selected publication. You can right-click on a subscription
to start or stop the subscription.

O Agents shows the replication agents associated with the selected publication. You can right-click on a
replication agent to start or stop the agent.

O Sessions (bottom left) shows all sessions for the selected publication and replication agent in the last 24
hours.

O Actions (bottom right) shows the activity for the selected session.

2. In the top left-hand pane, select the first Unified CCMP database publication from the list of publications. If
you have used the default database name, this will start with [Portal].

3. Wait for the replication snapshot for this publication to complete.

To check the replication status for a Unified CCMP database publication, in the bottom right hand pane of
the Monitor tab, inspect the messages in the Action Message list. Once the replication snapshot is complete
and replication is operational for a publication, you will see the following two messages:

“Delivered snapshot from ”
“No replicated transactions are available”.

After this, the second message is replaced with messages showing new replicated transactions as they are
sent through the system, for example:

“4 transaction(s) with 14 command(s) were delivered”.
4. Repeat the two steps above for each of the remaining Unified CCMP database publications.
5. When replication is complete for all portal database publications, close the ICE tool.

The subscriber database can now be used to service requests. For more information about the Replication
Manager see the Integrated Configuration Environment (ICE) for Cisco Unified Contact Center Management
Portal.

Post-Upgrade Tasks

142

After you have upgraded Unified CCMP, complete the following post-installation steps on both Side A and Side
B servers:

» Configure HTTPS as described in “Configuring SSL” on page 82.
» Bind server ports to IPv6 addresses as described in “Binding Server Ports to IPv6 Addresses” on page 84

» Complete the final post-installation actions described in “Final Post-Installation Actions” on page 87.

@ Note: If your installation uses single sign-on, the configuration is restored when the database is
*—/ restored, so you do not need to reconfigure single sign-on as described in “Configuring Windows” on
page 33.
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Restarting the Unified CCMP Services

Following an upgrade, you should restart all Unified CCMP services.

Perform the following steps on the Side A database servers to restart all Unified CCMP services running on both
side.

To restart the Unified CCMP services:

1. Launch the Integrated Configuration Environment (ICE) tool.

2. In the Database Connection window, provide the database connection details and click OK.
3. From the Tool dropdown, select Service Manager.

4. Select all the Unified CCMP Services and click Start Selected.

5

A dialog box appears to state that all the services are started. Click Close.

Validating the Upgrade (Side A and Side B)

After you have upgraded your installation of Unified CCMP, check that the system is functional following the
upgrade with the following tests.

This step need to be perform from both sides to validate that application is working fine from Side A and B.

Check

Unified CCE Provisioning Tests

Success Criteria

Log in to the web application on Side A and create a new Skill Group.
This tests provisioning from the Side A App/Web Server. Run this test
against each configured Unified CCE instance.

Log in to the web application on Side A and create a new Agent This
tests provisioning from the Side A App/Web Server. Run this test
against each configured Unified CCE instance.

The Skill Group should be successfully created,
and visible on Side A, and, if applicable, Side B.

The Agent should be successfully created and
visible on Side A, and, if applicable, Side B.

Create a new Skill Group on the AW using the Cisco Skill Group
Explorer tool. Wait a few minutes and check that the Skill Group has
been imported into Unified CCMP.

Log in the application on Side A and create a new Precision Queue.
This tests provisioning from the Side A App/Web Server. Run this test
against each configured Unified CCE instance.

The Skill Group should be visible on Side A,
and, if applicable, on Side B.

The Precision Queue should be created
successfully and visible on Side A, and if
applicable on, Side B

CUCM Provisioning Tests

Log in to the web application on Side A and create a new IP Phone.
This tests Unified Communications Manager provisioning from the Side
A App/Web Server.

The IP Phone should be successfully created,
and be visible on Side A, and, if applicable, on
Side B.

Replication Tests (dual-sided installations only)

Split-Side Upgrades 143



Check Success Criteria

Log in to the web application on Side B and create a new Skill Group. | The Skill Group should be successfully created,
This tests Unified CCE provisioning from the Side B App/Web Server. and visible on Side A.
Run this test against each configured Unified CCE instance.

Create a new Skill Group on the AW using the Cisco Skill Group The Skill Group should be visible on Side A and
Explorer tool. Wait a few minutes and check that the Skill Group has Side B.
been imported into Unified CCMP.

Log in to the web application on Side B and create a new IP Phone. The IP Phone should be visible on Side A and
This tests Unified Communications Manager provisioning from the Side | Side B.
B App/Web Server.

CVP Media file upload

Log in to the web application on Side A and create a new Media file. The media file should be uploaded successfully
This test provisioning from the Side A App/Web Server and will test the | and visible in the CVP servers.

working of CVP media upload. Run this test against each configured

Unified CCE instance.

Stopping the Unified CCMP Services

After side A and B servers are ready for use. Stop the services of old servers if you have used new servers for
upgrade, these servers can decommission.

To stop the Unified CCMP Database Server services on Side B:

1. Launch the Integrated Configuration Environment (ICE) tool.

2. In the Database Connection window, provide the database connection details and click OK.
3. From the Tool dropdown, select Service Manager.

4, Select all the Unified CCMP Services and click Stop Selected.

5

A dialog box appears to state that all the services are stopped. Click Close.
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Update SQL Server
Port

» Introduction
» Updating SQL Server Port Using Connection Updater

» Updating SQL Server Port for CCMP Database



Introduction

Starting from ES202603, a Port field is introduced in the Connection Updater tool. This enhancement allows
configuration of a non-default SQL Server port directly within the application, enabling support for SQL
instances running on ports other than the default (1433).

Updating SQL Server Port Using Connection Updater

Prerequisites

4

4

4

Ensure the CCMP application is on ES202603 or above, where non-default SQL port support is available.
Stop all UCCMP services.

Take snapshots of the Database Server, Application Server, and Web Server.

Change the SQL Server 2022 port from the default port (1433) to the required non-default port.

Verify that the database is accessible through SQL Server Management Studio (SSMS) using the new port
number.

Updating the Port in Connection Updater

After confirming SQL connectivity, update the port details using the Connection Updater tool on both the
Database Server and Application Server.

To update the port on database and app server:

1.
2.
3.

Open the Connection Updater tool.

Under the Services section, select the required UCCMP services.

Under Connection Settings:

a. Server Name: Enter the SQL Server name (e.g., localhost or actual DB server name).
b. Port: Enter the new non-default port.

c. Catalog: Ensure the correct database (for example, Portal) is selected.

d. Authentication: Select the appropriate authentication method.
e Windows Authentication: Select this option to use the currently logged in Windows domain user.

e SQL Authentication: Select this option to use a specific SQL Server user. Either accept the default
sa user (created when the Unified CCMP database was installed, and which does have sufficient
permissions) or enter another SQL Server user, then specify the password.

Click Test to verify connectivity.
Click Update after a successful test.

Restart UCCMP services (if not restarted automatically).
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Updating SQL Server Port for CCMP Database

Perform the following steps only if the CCMP database SQL port was previously set to the default (1433) and
has been changed to a non-default port after applying this ES.

1.
2.

Launch the Integrated Configuration Environment (ICE) tool.

In the ICE Database Connection window, enter the database connection details along with the updated non-
default SQL port, and click OK.

Stop UCCMP services:

a. From the Tool dropdown, select Service Manager.

b. Select all Unified CCMP Services and click Stop Selected.
c. Close the dialog box once all services are stopped.

Update the SQL port in the UCCMP wizard:

a. From the Tool dropdown, select Cluster Configuration.
b. Click Setup, then select Setup UCCMP Servers.

c. Proceed to the Configure Core Servers page.

d. Enter the non-default SQL Port for the Primary database server. For dual-sided setups, update the
Secondary server Port as well.

e. Continue through the remaining steps without making additional changes.

f.  After completion, click Exit and then click the Save icon to apply the changes.
Restart all Unified CCMP Services.

Close the ICE tool.
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Uninstalling Unified
CCMP

Removing Database Replication
Uninstalling Identity Component
Uninstalling Application Server Component
Uninstalling the Database Component
Uninstalling the Common Component

Removing the Database Catalog



This chapter describes how to remove the Unified CCMP components from the platform.

Uninstallation involves the following steps:

»

4

Removing Database Replication on page 149 (dual-sided systems only)

Uninstalling Identity Component on page 150 (Identity component must be uninstalled before the
Application Server component)

Uninstalling Application Server Component on page 150
Uninstalling the Database Component on page 150
Uninstalling the Common Component on page 151

Removing the Database Catalog on page 151 (only if Unified CCMP is being removed permanently)

Removing Database Replication

@ Note: This step is only required if you have a dual-sided system.
[

If you have a dual-sided installation, then you must remove database replication before removing the database
components.

Before removing database replication:

4

4

Ensure that the database is in a consistent state.

Stop all Unified CCMP Services on all servers.

To remove database replication:

1.

S

Ensure you are logged in to the Side A Database Server as a domain level user with administrative rights
over both Database Servers.

Launch Integrated Configuration Environment (installed as part of Unified CCMP). In the Database
Connection dialog box, set:

O  Server Name: Enter the name of the primary database server.

o Port: Provide database server SQL non-default Port. By default the value is set as 1433. This field has
been introduced in CCMP 15 ES202603.

O Database Name: Enter the name of the Unified CCMP database that was installed when setting up the
Database Component. If you accepted the default value, this is Portal.

O  Authentication: Select Windows Authentication.

Click OK. The ICE Cluster Configuration tool starts by default.
From the Tool dropdown list select Replication Manager.

Click the Setup tab to see the replication setup details.

Click Disable to remove replication from the Unified CCMP database. When prompted, click Yes to
proceed with replication removal.
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7.

Replication removal may take several minutes. Wait for the Replication Removed message to display in the
Output Window and then exit ICE.

Uninstalling Identity Component

In a dual-sided deployment, perform the following steps on the Side A Application/Web server and then repeat
the steps on the Side B Application/Web server. The Identity component must be uninstalled before the
Application Server component.

To uninstall the identity server components:

1.

2
3.
4

On the Side A App/Web Server, launch Control Panel and select Programs and Features.
Select Management Portal: Identity Server.
Click Uninstall.

After the uninstallation is complete, delete the installation folder that contains the log files and folders from
the following location: C:\Program Files\Management Portal. Before deleting this folder, make sure there
are no other components installed on the system.

Uninstalling Application Server Component

The Identity component must be uninstalled before the Application Server component.

To uninstall the application server components:

1.

2
3
4,
5

On the Side A App/Web Server, launch Control Panel and select Programs and Features.
Select Management Portal: Application Server Components.

Click Uninstall.

For a dual-sided deployment, repeat step 1. to step 3. on the Side B App/Web Server.

After the uninstallation is complete, delete the installation folder that contains the log files and folders from
the following location: C:\Program Files\Management Portal. Before deleting this folder, make sure there
are no other components installed on the system.

Uninstalling the Database Component

In a dual-sided deployment, perform the following steps on the Side A Database Server and then repeat the steps
on the Side B Database Server.

To uninstall the database components on the Database Server:

1.

Launch Control Panel and select Uninstall a program.
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Select Management Portal: Database Components.
Click Uninstall.

After the uninstallation is complete, delete the installation folder that contains the log files and folders from
the following location: C:\Program Files\Management Portal. Before deleting this folder, make sure there
are no other components installed on the system.

8: Note: Uninstalling the database components does not remove the Unified CCMP database catalog.
B

Uninstalling the Common Component

In a dual-sided deployment, perform the following steps on the Side A Database Server and then repeat the steps
on the Side B Database Server.

To uninstall the database components on the Database Server:

1.
2.
3.

Launch Control Panel and select Uninstall a program.
Select Management Portal: Common Components.

Click Uninstall.

After the uninstallation is complete, delete the installation folder that contains the log files and folders from the
following location: C:\Program Files\Management Portal. Before deleting this folder, make sure there are no
other components installed on the system.

Removing the Database Catalog

This permanently removes the database catalog.

%\ Important: Do not remove the database catalog from your system unless you intend to
*%Y permanently remove Unified CCMP, or you have been instructed to do so by your vendor’s support.

To remove the Unified CCMP database catalog, you will need to use SQL Server Management Studio.

To remove the database catalog for portal database:

1.
2.

Launch SQL Server 2022 Management Studio and connect to the local Database Server.

In the Object Explorer pane, expand the Databases node, navigate to the Portal database (the default name
is Portal), right-click it and select Delete.

The Delete Database window displays.
Select the Close existing connections check box.

Click OK. This permanently removes the database catalog.
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To remove the database catalog for identity server database:
1. Launch SQL Server 2022 Management Studio and connect to the local Database Server.

2. In the Object Explorer pane, expand the Databases node, navigate to the Identity Server database (name is
IdSvr3Config), right-click it and select Delete.

3. The Delete Database window displays.
4. Select the Close existing connections check box.

5. Click OK. This permanently removes the database catalog.
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About Installer Logs
Changing the SQL Server Installation Language to US English
Portal Login Error Messages

Replication Troubleshooting



About Installer Logs

» Unified CCMP installers are launched with logging enabled. Install logs are located in C:\InstallLogs for
both the Database and Application/Web Server installers.

Changing the SQL Server Installation Language to US
English

If the step to install the portal database fails with the following error, you must change the SQL Server language
to US English before the installation can continue.
Exception in installation: [SQL Server language must be US Englishl

To do this, on the database server, run the following T-SQL scripts in the specified order.

On the database server, run the following T-SQL scripts in the specified order.

SCRIPT 1

USE master;
GO
DECLARE @LANGUAGE AS NVARCHAR(MAX);

SELECT @LANGUAGE = "EXEC sp_configure '+CHAR(39)+'default
language'+CHAR(39)+', '+CAST([langid] AS VARCHAR(2))+";'

FROM sys.syslanguages

WHERE name = 'us_english’;

EXECUTE sp_executesql @LANGUAGE;
GO

SCRIPT 2

RECONFIGURE WITH OVERRIDE;
GO

SCRIPT 3

USE [master];
ALTER LOGIN [ <username>] WITH DEFAULT_LANGUAGE=[us_english];
GO

In Script 3, <username> is the Windows domain user or the SQL Server user you will specify for the Connect
Using option during the installation of the Portal Database (in the SQL Server Connection Details window

(page 45)).
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For example:

»

If you will connect using the option The Windows account information I use to logon to my computer,
and have a user name userl on Unified CCMPDOM, you would enter Unified CCMPDOM\user1 for

<username>.

If you will connect using the option The SQL Server login information assigned by the system
administrator, and will use the sa user, you would enter sa for <usernames.

Portal Login Error Messages

Symptom: Error Message Appears Upon Logging into Portal Webpage

An error is displayed upon logging on to the Portal Webpage and the Identify Server logs show the following:

Cause

Date-Time INFO [14 1 Logging.TraceSourceSink User is not authenticated.
Redirecting to Llogin.

Date-Time INFO [14 1 Logging.TraceSourceSink End authorize request

Date-Time INFO [14 1 Logging.TraceSourceSink Redirecting to login page
Date-Time INFO [11 1 Logging.TraceSourceSink Login page requested

Date-Time INFO [14 1 Logging.TraceSourceSink rendering login page

Date-Time INFO [11 1 Logging.TraceSourceSink Login page submitted

Date-Time ERROR [9 1 Logging.TraceSourceSink Unhandled exception accessing:
/Identity/login

System.Data.SqlClient.SqlException (0x80131904): The EXECUTE permission was

denied on the object 'ap_admO1_create_new_session', database 'Portal', schema

'dbo'.

The portalapp role was not added to the Web server Network Service account for the Portal database during the

installation. For more information, see “Adding Network Service Accounts” on page 106 and “Adding Network

Service Accounts (Side A)” on page 126.

Recommended Actions

1.
2.
3.
4,

Launch SQL Server Management Studio.
In the Object Explorer, expand the Portal database. A list of folders is displayed.
Expand the Portal > Security > Users folder. A list of database logins is displayed.

Open the DOMAIN\ WEBSERVER MACHINE NAMES account.
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o ® 2

10.

In the Select a page pane, click User Mapping.

In the Users mapped to this login section, select the Portal database.

Ensure that the User column correctly contains the Network Service account for the Web server.
In the Database Role Membership section, select the portalapp role.

Click OK.

For deployments with multiple web servers, repeat for each additional Web server.

Replication Troubleshooting

Symptom: Snapshot Fails During CCMP 15 Database Replication Setup

When setting up CCMP 15 Database Replication, the initial snapshot may fail to complete. During this process,
replication hangs between 38% and 40% progress and displays the message: The process is running and
is waiting for a response from the server.

Recommended Actions

et

® N 0 s

10.
11.

Launch SQL Server Management Studio (SSMS) and connect to the Side A CCMP server.
In Object Explorer, right-click the Replication node and select Launch Replication Monitor.

If needed, add the Side A server to Replication Monitor. Then expand My Publishers /<SERVERNAME> and
select the publication—[Portal]: BaseSubWin.

Select the Agents tab and locate the job labeled Snapshot Agent.

Right-click the Snapshot Agent and select Stop Agent. Then right-click again and choose Properties.
In the Properties window, select the Steps page.

Select Step 2: Run Agent, then click Edit.

In the Command field, scroll to the end of the existing command and add the following parameter (make
sure there is a space before it):-prefetchtables 0
Example before modification:

-Publisher [CCLAB12CCMPDBA] -PublisherDB [Portall -Distributor [CCLAB12CCMPDBB]
-Publication [BaseSubWinl -DistributorSecurityMode 1

Example after modification:

-Publisher [CCLAB12CCMPDBA] -PublisherDB [Portall -Distributor CCCLAB12CCMPDBB]
-Publication [BaseSubWinl -DistributorSecurityMode 1 -prefetchtables 0

Click OK twice, and select Yes when prompted with a warning pop-up.
Right-click the Snapshot Agent and choose Start Agent.

Monitor the publication in Replication Monitor to confirm that the Snapshot Agent runs successfully and
completes the snapshot.
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